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Введение
В начальном курсе объясняются отдельные шаги, требуемые при
создании проекта "color_gs". Вы найдете здесь наиболее важную
дополнительную информацию, которая требуется для понимания
концепции шагов (steps), и подробные инструкции по работе с ними.

Кроме того, Вы получите в виде файла законченный проект "color_gs" в
качестве образца. Он устанавливается вместе с системной
документацией PCS 7. Вы можете открыть данный проект в
существующей системе проектирования (engineering system - ES) для
просмотра данных конфигурации и сравнения их с Вашими собственными
данными конфигурации. Вы можете активировать проект на рабочей
станции (operator station - OS) для управления процессом и его
мониторинга.

Примечание

Чтобы протестировать проект в "режиме процесса" (process mode), может
быть Вам придется привести конфигурацию оборудования, заложенную в
проект, в соответствие с конфигурацией фактически используемого
оборудования; другими словами, Вам потребуется заменить компоненты
оборудования проекта-образца фактически используемыми компонентами
оборудования.

Для получения более подробной информации по вопросу открытия проекта-
образца обратитесь к теме "Запуск и настройка образца".

Примечания к начальному курсу
В начальном курсе все инструкции объясняются на основе использования
команд полного меню. Вы также можете применять большинство функций
с помощью контекстного меню или посредством двойного щелчка кнопкой
манипулятора "мышь" на выбранном объекте.

Во многих ситуациях в PCS 7 Вы можете использовать стандартные
функции Windows:

• выбор группы объектов с помощью комбинации клавиш "CTRL" и
"Shift";

• сортировка содержимого столбца, инициализируемая щелчком на его
заголовке;

• использование метода "Drag & Drop", вместо функций копирования
(Copy) и вставки (Paste).

Если Вы откроете HTML-версию начального курса (Getting Started), Вы
сможете активизировать видео. Этот видеоряд показывает шаги, которым
Вы можете следовать перед самостоятельной работой. Функция видео
отображается как::

 Video

Щелкните кнопкой манипулятора "мышь" на слове "Video" для запуска
функции. При использовании видео Вы можете включить паузу,
остановить воспроизведение или запустить его с начала. Для этого
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используются кнопки, аналогичные кнопкам плейера Windows Media
Player.

Один учебный фрагмент следует за другим, и Вы, таким образом,
самостоятельно создаете шаг за шагом завершенный проект PCS 7. Это
позволяет организовать корректную работу на проектом.

Дополнительная информация
Вы можете найти более подробную информацию, а также информацию по
более широкому кругу вопросов в руководствах по проектированию
"Process Control System PCS 7, Engineering System" ["Система управления
процессом PCS 7, система проектирования"] и "Process Control System
PCS 7, Operator Station" ["Система управления процессом PCS 7, рабочая
станция"]. Эти источники будут полезны Вам как справочная литература.

Указанные руководства можно найти:

• на компакт-диске "SIMATIC Process Control System PCS 7 V 6.0,
Electronic Manuals[0]".

• в SIMATIC Manager[0] в папке PCS 7 Software. Вы можете открыть
документы с помощью опций: Start -> SIMATIC -> Documentation ->
[required language] (Пуск -> SIMATIC -> Документация -> [требуемый
язык]).

Здесь Вы также найдете другие руководства по отдельным темам,
например, по SFC, CFC.

Дальнейшая поддержка
Если у Вас есть вопросы по использованию наших продуктов, описанных в
данном руководстве, и Вы не можете найти в руководстве ответов на эти
вопросы, то обратитесь в местное представительство Siemens.

http://www.siemens.com/automation/partner

Учебный центр
Для того, чтобы помочь Вам познакомиться с работой с S7 PLC, мы
организовали ряд учебных курсов. Обратитесь в наш региональный
учебный центр или в центральный учебный центр в Нюрнберге D 90327.
Тлф:  +49 (911) 895-3200.

Интернет: http://www.sitrain.com
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Техническая поддержка A&D (A&D Technical Support)

Круглосуточно, по всему миру:

Всемирная (Нюрнберг)

техническая поддержка

Мест. вр. : 0:00 - 24:00 / 365 дней

Тлф: +49 (0) 180 5050-222

Факс: +49 (0) 180 5050-223

E-mail: adsupport@
siemens.com

GMT: +1:00

Европа / Африка (Нюрнберг)
Авторизация

Мест. вр. : Пнд.-Птн. 8:00 - 17:00

Тлф: +49 (0) 180 5050-222

Факс: +49 (0) 180 5050-223

E-mail: adautorisierung@
siemens.com

GMT: +1:00

США (Джонсон-Сити)
Техническая поддержка и
авторизация
Мест. вр. : Пнд.-Птн. 8:00 - 17:00

Тлф: +1 (0) 423 262 2522

Факс: +1 (0) 423 262 2289

E-mail: simatic.hotline@

sea.siemens.com

GMT: -5:00

Азия / Австралия (Пекин)
Техническая поддержка и
авторизация
Мест. вр. : Пнд.-Птн. 8:30 - 17:30

Тлф: +86 10 64 75 75 75

Факс: +86 10 64 74 74 74

E-mail: adsupport.asia@

siemens.com

GMT: +8:00

Язык общения для технической поддержки и авторизации: английский или немецкий.

Peking 

Nürnberg

Johnson City Джонсон-Сити

Нюрнберг

Пекин
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Обслуживание и поддержка с помощью Интернета
В дополнение к документации, Вы можете также получить нашу
поддержку с помощью Интернета.
http://www.siemens.com/automation/service&support

Здесь Вы найдете:

• Новую информацию, которая постоянно обновляется, с последними
данными по продуктам, которые Вы используете.

• Правовую документацию, необходимую Вам для поиска в службе
обслуживания и поддержки с помощью Интернета (Service & Support).

• Форум для обмена информацией и опытом между специалистами и
пользователями.

• Контактные реквизиты для ответов на вопросы по автоматизации и
приводам (Automation & Drives) в нашей базе данных.

• Информацию по местным отделениям обслуживания, по ремонту и
запчастям. А также многое другое под заголовком "Services"
("Обслуживание").
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Назначение руководства

Руководство "PCS 7 Начальный курс" предлагает Вам начальный общий
обзор системы управления процессом PCS 7 и предоставляет помощь при
самостоятельном создании простого проекта. Вы можете сами
сконфигурировать проект на существующей станции SIMATIC.

Начальный курс – Часть 1 предназначен для ознакомления с работой
системы PCS 7 в следующих областях:

• Конфигурирование

• Наладка и обслуживание

Требования к уровню подготовки слушателей

Слушатели курса должны иметь опыт работы:

• с операционной системой Microsoft Windows 2000

• с функциями и конфигурацией SIMATIC S7 (S7-400, STEP 7)

• с функциями и конфигурацией SIMATIC NET (компоненты сети, среда
обмена данными)

Область применения руководства

Начальный курс предназначен для работы с ПО "PCS 7 Engineering
Toolset V 6.0" (Средства разработки PCS 7 версии 6.0).
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1 Необходимые условия для работы с
начальным курсом

1.1 Выполнение требований для работы с начальным
курсом

Для того, чтобы работать с курсом "Система управления процессом PCS
7. Начальный курс" необходимо обеспечить выполнение определенных
требований:

• к аппаратному обеспечению

• к программному обеспечению

1.1.1 Требования к оборудованию для работы с начальным
курсом

Представленный ниже список содержит компоненты оборудования,
которые необходимы для работы с начальным курсом PCS 7 и которые
используются в примерах к данному курсу. В некоторых случаях Вам
потребуются особые версии отдельных типов оборудования, которым при
использовании в данном курсе не может быть замены.

Оборудование Версия, используемая в начальном
курсе PCS 7

Возможность
использования
других версий

ПК или PG со стандартным
сетевым адаптером 3Com EtherLink III IS Да

Стойка UR2 Да

Источник питания PS 407 10A Да

CPU CPU 417-4,  V 3.1 или выше Нет

CP 443-1
6GK7 443-1 EX11-0XE0,  V 2.0
или выше с фиксированным MAC
адресом

Нет

Модуль памяти

Соединительный кабель Нет
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Внимание

CPU и CP являются абсолютно необходимыми компонентами для создания
конфигурации, описанной в курсе "Система управления процессом PCS 7.
Начальный курс".

Необходимо помнить, что при использовании компонентов оборудования,
отличных от тех, что используются в начальном курсе, Вы должны ввести
данные об этом оборудовании в определенный момент при
конфигурировании, например, с помощью утилиты конфигурирования
оборудования HW Config. Мы рекомендуем использовать в точности то
оборудование, которое рассматривается в данном курсе, если это
возможно.

Если у Вас нет каких-либо компонентов оборудования, то Вы можете
использовать также программное обеспечение PLC Sim, которое также
присутствует на компакт-диске "PCS 7 Toolset CD". Вам потребуется
получить специальную лицензию для использования этого ПО. При
использовании этого ПО Вы сможете использовать в точности такие же
компоненты оборудования, какие указаны в курсе "Система управления
процессом PCS 7. Начальный курс".

1.1.2 Требования к программному обеспечению для работы с
начальным курсом

На Вашем ПК/PG должно быть установлено следующее программное
обеспечение:

• Windows 2000 Professional

• Internet Explorer 6.0

• Message queuing service (служба запроса сообщений)

• SQL Server

• Прикладной пакет программ из PCS 7: "PCS 7 Engineering"

Данное программное обеспечение присутствует на компакт-диске "PCS 7
Toolset V 6.0". Если у Вас есть вопросы по установке PCS 7 Toolset, то
прочитайте прилагаемый файл Readme на данном CD или воспользуйтесь
службой поддержки пользователей.
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2 Общий обзор PCS 7

2.1 Краткий общий обзор PCS 7

PCS 7 - это система управления процессом, которая при создании проекта
обеспечивает пользователя большим числом функций автоматики для
быстрого и удобного создания проектов. Вы познакомитесь с некоторыми из
этих функций автоматики (automatic functions), работая с начальным курсом
PCS 7.

Когда Вы приобретете достаточный опыт, Вы найдете, что PCS 7
обеспечивает разнообразие вариантов (опций), которые позволяют создавать
отдельные специфические решения, отвечающие Вашим особым
требованиям. Эти особые индивидуальные решения, конечно, не являются
предметом данного начального курса.

Для получения более подробной информации по данному вопросу Вы можете
обратиться к руководствам по проектированию, как только Вы познакомитесь
с основными функциональными возможностями системы.

Что такое PCS 7-проект ?

Прежде всего PCS 7-проект содержит следующие объекты:

• Конфигурацию оборудования (Hardware configuration)

• Блоки (Blocks)

• CFC-схемы и SFC-схемы (CFC-charts и SFC-charts)

Эти объекты всегда существуют независимо от количества операторских
станций (operator stations - OS), модулей и организации сети.
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2.2 Что относится к PCS 7?

Проект создается в среде (в системе) проектирования - "Engineering System",
для названия которой обычно применяется сокращение ES. ES состоит из
различных приложений. Все приложения предоставляют пользователю
графический пользовательский интерфейс для обеспечения простого
управления и понятного отображения данных Вашего проекта. При работе с
начальным курсом Вы познакомитесь со следующими приложениями:

• SIMATIC Manager – это центральное приложение, предоставляющее Вам
возможность обращаться ко всем другим приложениям, которые Вы
можете использовать при создании PCS 7-проекта. Запуск утилиты
SIMATIC Manager является отправной точкой при создании проекта.

• HW Config – это утилита конфигурирования аппаратного обеспечения
системы в целом, например CPU, источника питания, коммуникационных
процессоров.

• CFC-редактор / SFC-редактор – редакторы для создания CFC-схем
(charts) и последовательного управления (sequential controls).

• PCS 7 OS с разными редакторами (PCS 7 OS with various editors) – для
создания конфигурации операторских станций (OS).

2.3 Введение в SIMATIC Manager

Что такое SIMATIC Manager?

SIMATIC Manager – это центральное приложение и некоторыми образом
"ядро" ("core") системы PCS 7. Это отправная точка, начиная с которой Вы
можете открывать все другие приложения, в которых Вы можете задавать
Ваши установки для Вашего PCS 7-проекта.

Утилита SIMATIC Manager и все другие приложения связаны друг с другом.
Когда Вы открываете SIMATIC Manager, Вы можете видеть, например, все
блоки, которые Вы вставили в CFC-схему (CFC chart) с помощью CFC-
редактора. Кроме того, значительный выигрыш от такой связи приложений
становится очевидным, когда Вы конфигурируете операторскую станцию
(OS). Вы можете обратиться к любым данным, которые Вы создали
посредством SIMATIC Manager и других приложений, например, Вы можете
просто и быстро визуализировать переменную процесса (process tag) из CFC-
схемы (chart) во время конфигурирования операторскей станции (OS).

Благодаря центральной функции утилиты SIMATIC Manager в системе PCS 7,
она стоит времени, затраченного на ознакомление с ее структурой и
функциями.
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2.4 Что такое базовая структура (Basic Structure) утилиты
SIMATIC Manager?

Графический интерфейс пользователя утилиты SIMATIC Manager
представляет собой окно, состоящее из двух панелей, аналогичное окну
"Проводника" (Explorer) в ОС Windows:

• Левая панель содержит структуру "дерево" (tree structure), содержание
которой зависит от выбранного представления (view).

• Правая панель окна раскрывает содержание объекта, выбранного в левой
панели окна в иерархической структуре "дерево".

2.5 Что означает понятие "представление" (View) в
SIMATIC Manager?

Утилита SIMATIC Manager представляет Вам для использования три
различных представления (view). Эти три представления обладают одной
важной особенностью, которая состоит в том, что объекты, которые они
содержат, в реальности существующие в единственном экземпляре, могут
быть отображены и подвергнуты обработке в трех разных представлениях
(views). Все эти представления в основном имеют одинаковую структуру: в
левой панели Вы можете видеть структуру вида "дерево" (tree structure), а в
правой панели - отображение содержимого объекта, выбранного в
иерархической структуре левой панели. Каждое представление дает свои
собственные преимущества, в зависимости от имеющейся задачи.

• "Представление компонентов" - "Component view" – это вид в SIMATIC
Manager, представляющий физическое расположение в памяти
отдельных объектов, например, схем (charts) и блоков (blocks). В
представлении компонентов можно сразу увидеть, какие блоки и какие
схемы принадлежат тому или иному PLC.

• "Представление установки" - "Plant view" – это вид в SIMATIC Manager,
представляющий иерархическую структуру Вашей установки. Вы можете
разделить Вашу установку на части или блоки и, используя данное
представление, можете видеть, какие схемы (charts) и какие диаграммы
процесса (process pictures) принадлежат тому или иному блоку установки.

• "Представление объектов процесса" - "Process object view" – это вид в
SIMATIC Manager, представляющий детали отдельных объектов другого
вида - представления установки (plant view). Данное представление, в
частности, полезно при необходимости назначить одинаковые значения
параметров большому числу объектов, добавить к ним комментарии или
установить между ними связь.

Выполняя разбитые на шаги инструкции в данном курсе, Вы всегда будете
знать, с каким из представлений Вы должны работать.

Все, что Вы делаете в SIMATIC Manager автоматически сохраняется
системой PCS 7.
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2.5.1 Запуск утилиты SIMATIC Manager

Существуют два способа запуска утилиты SIMATIC Manager:

 Вариант  Процедура

 1 Выполните двойной щелчок левой кнопкой манипулятора
"мышь" на значке STEP 7, расположенном на рабочем столе
Вашего ПК:

 2 Запустите SIMATIC Manager из панели задач Windows,
используя следующие опции меню:

Start -> SIMATIC -> SIMATIC Manager

(Пуск -> SIMATIC -> SIMATIC Manager).

При запуске утилиты SIMATIC Manager автоматически открывается тот
проект, который открывался в последний раз.
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3 Первые шаги в работе с проектом

3.1 Введение

3.1.1 Проект "color_gs"

После теоретического введения в PCS 7 обратимся теперь к практике и
создадим проект "color_gs". Вы, конечно же, будете получать подробные
поэтапные инструкции. Для лучшего понимания эти поэтапные инструкции
необходимо сопровождать определенными порциями теории, и мы
обеспечим Вас наиболее важной основополагающей информацией по
всем темам.

Мы сконфигурируем только небольшую часть целой полностью
автоматизированной промышленной установки, так как конфигурирование
установки в целом выходит за рамки данного начального учебного
проекта. Тем не менее, Вы узнаете, как указанная малая часть установки
встраивается в полностью оснащенную установку; так Вы будете иметь
более полную картину. В связи с этим, ниже представлено краткое
объяснение отдельных фаз целого производственного процесса.

Фаза I – Транспортировка сырья
Жидкое сырье, требуемое для производства, хранится в двух
резервуарах, из которых оно может перекачиваться в реакторы. Твердые
(сыпучие) сырьевые материалы хранятся в трех силосах. Три питающих
шнека подают сыпучие материалы в взвешивающий бункер, где
материалы взвешиваются. Как только достигается требуемая
консистентность смеси, другой питающий шнек и пневмотранспорт подают
сырье в один из двух смешивающих контейнеров.

Фаза II – Производство продукта
Требуемое количество жидкого сырья подается или в реактор 1, или в
реактор 2 через вентили. Сыпучие материалы из смешивающих
контейнеров транспортируются в эти реакторы с помощью шнеков, где
смешиваются мешалкой. Продукт производится в реакторах в процессе
перемешивания, нагревания и охлаждения с добавлением специальных
добавок. Температурой в реакторах управляют с помощью вентилей и
приводов (actuators). При необходимости, в реакторы может быть подана
вода с регулированием подачи из блока фильтра.
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Фаза III – Фаза выдержки

Затем готовый продукт перекачивается в резервуар выдержки. Здесь
продукт медленно перемешивается и выдерживается при постоянной
температуре.

Фаза IV – Розлив

После фазы выдержки продукт короткое время хранится в резервуаре
розлива, откуда он может быть подан для заполнения в транспортные
цистерны или в небольшие емкости.

Фаза V – Очистка

Реакторы, трубопроводы, вентили, приводы, резервуары выдержки и
розлива затем могут быть очищены с помощью системы очистки (cleaning
system - CIP). Затем продукты очистки собираются в отдельный резервуар
отходов для обезвреживания.

3.1.2 Задача для начального курса

Ваша задача проектирования …

Вы будете проектировать часть установки, касающуюся фазы 1 - "Фаза I –
Транспортировка сырья" ("Phase I – Raw Materials"), с такими функциями,
как:

Хранение жидких сырьевых материалов в двух резервуарах и управление
насосами для перекачки сырья в два реактора.

Структурная схема системы трубопроводов и контрольно-
измерительных приборов (КИП)

Структурная схема системы трубопроводов и контрольно-измерительных
приборов показывает точную последовательность выполнения проектных
задач и показывает все необходимые точки измерения (тэги - tags).

См. ниже схему.
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Расшифровка обозначений в схеме системы трубопроводов и
контрольно-измерительных приборов

• LI111 (индикатор уровня) – измерение текущего значения уровня в
резервуаре сыпучих сырьевых материалов.

• NK111 и NK112 (заданные пользователем обозначения вентилей) –
вентили запирающие, которые всегда открыты при подаче сырья.

• NP111 (заданное пользователем обозначение мотора) – насос,
который транспортирует сырье в реакторы.

• NK113 и NK114 (заданные пользователем обозначения вентилей) –
вентили, из которых одновременно может быть открыт только один
при подаче сырья в Реактор 1 или в Реактор 2.

• FC111 (обозначение устройства для управления
производительностью трубопровода) – привод для управления
объемом поступающего сырья.

Состояния вентилей NK111…NK114 должно отображаться на
операторскей станции (OS) и может отслеживаться. Также возможно
управление объемом поступающего сырья посредством привода FC111.

3.1.3 Структура установки проекта "color_gs"

Проект "color_gs" реализуется на базе небольшой части целой установки с
использованием одного программируемого контроллера и объединенной

Reactor 1 Reactor 2

Li

Nk

Nk

Fc

Nk

111

111

111

112

114

Raw material 
    tank 1

Сыпучие
сырьевые
материалы
Резервуар 1

Реактор 1 Реактор 2
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системы проектирования (engineering system ES) и станции оператора
(operator station OS). Операторская станция конструктивно представляет
собой систему на основе одиночной рабочей станции (workstation system).

На следующем рисунке показана структура установки.

Engineering Station (ES)/
Operator Station (OS)

Direct link via 
crossover cable

Programmable controller
SIMATIC S7 400

with CP 443-1

Single workstation system

Система проектирования (ES) /
Операторская станция (OS)

Одиночная рабочая
станция

Прямая связь посредством
соединительного кабеля

Программируемый контроллер
SIMATIC S7 400

c CP 443-1
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В данном начальном курсе Вы создадите систему управления,
содержащую следующие компоненты:

• Программируемый контроллер, имеющий обозначение "PLC".
Отдельные компоненты описаны в разделе "1 Необходимые условия
для работы с начальным курсом"

• Программа, с помощью которой осуществляется управление проектом
"color_gs". Вы можете создать эту программу в среде (системе)
проектирования, обозначаемой "ES", и загрузить программу в CPU.
Данный CPU обрабатывает загруженную программу и возвращает Вам
значения переменных процесса (process values). Загрузка программы
осуществляется посредством коммуникационного процессора CP 443-
1.

• Операторская станция, обозначаемая "OS", с помощью которой
оператор установки может управлять и наблюдать за работой
установки, в "режиме процесса" (process mode). Вы сами создадите
графическое отображение процесса (process picture), которое
оператор будет наблюдать с помощью OS. Контроллер PLC и
операторская станция OS связаны между собой посредством CP.

Примечание

Необходимо помнить, что установка и комплекс задаваемых параметров для
оборудования разработаны в соответствии с требованиями проекта для
данного начального курса. При создании реального проекта Вы, конечно,
будете использовать больше контроллеров и использовать системы
проектирования и операторские станции на других компьютерах. В
результате установки оборудования будут значительно более сложными и,
конечно, не будут такими же, как в данном начальном курсе.

3.1.4 Общий обзор этапов конфигурирования

Для конфигурирования данной части установки, Вам потребуется
выполнить следующие действия:

• Задать установки оборудования

• Запустить SIMATIC Manager и создать PCS 7-проект

• Создать CFC-схемы (charts)

• Создать SFC-схемы (charts)

• Загрузить и протестировать проект

• Сконфигурировать и скомпилировать операторскую станцию
PCS 7 OS

• Создать графическое отображение процесса (process pictures)

• Перейти в "режим процесса" (process mode) с моделированием
переменных процесса (simulated process values)
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3.2 Установки оборудования

3.2.1 Установки оборудования без SIMATIC Manager

Перед тем, как Вы начнете создавать проект "color_gs", Вы должны
проверить установки оборудования (hardware settings), установить
интерфейс PG/ПК и протестировать соединение Вашего ПК с системой ES
и контроллера PLC. Это гарантирует, что Вы сможете без проблем
загрузить данные конфигурации и переключить Ваш проект в "режим
процесса" (process mode), как только Вы закончите конфигурировать
данные.

Примечание

Упомянутые установки выполняются сразу после инсталляции PCS 7 с
помощью инструмента "Мастер отладки" (Commissioning Wizard). Если
систему PCS 7 устанавливали не Вы сами, то необходимо вновь проверить
данные установки и выполнить необходимые настройки.

3.2.1.1 Как проверить установки оборудования (Hardware
Settings)

Требования
Проверьте:

• что все требуемые компоненты оборудования установлены в стойку и
подключены;

• что соединительный кабель "с перекруткой" (crossover) включен между
сетевым адаптером 3Com Вашего компьютера с ES и
коммуникационным процессором CP 443-1.

Следуйте плану действий, указанному ниже...
1. Откройте консоль для конфигурирования (Configuration Console),

используя пункты меню Windows: Start -> Simatic -> SIMATIC NET ->
Settings -> Configuration Console (Пуск -> Simatic -> SIMATIC NET ->
Установки -> Консоль для конфигурирования). Консоль открывается и
все компоненты оборудования, относящиеся к Вашему ПК,
отображаются под папкой "Modules" (модули) в структуре "дерево".

Внимание
Если консоль для конфигурирования не открывается, а вместо нее
запускается "мастер отладки" (Commissioning Wizard), щелкните на кнопке
"Cancel" ("Отменить"). При этом программа "мастер отладки" будет закрыта и
откроется консоль для конфигурирования.
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2. В данной структуре выберите пункт: "SIMATIC NET Configuration/Modules/
[имя адаптера сети, например: "3Com EtherLink III IS..."]/General". После
этого в правом окне отобразится основная информация об этом модуле.

Примечание

Если Вы используете другой сетевой адаптер в своем ПК, здесь должно
быть отображено имя Вашего адаптера. В таком случае Вы должны выбрать
имя Вашего адаптера.

3. В правом окне Вы увидите окно со списком (drop-down list box): "Mode of
the module" ("Режим модуля") , в котором Вы должны выбрать пункт
"Configured mode" (Сконфигурированный режим). При этом будет
активирован указанный сетевой адаптер.

4. Щелкните кнопкой манипулятора "мышь" на кнопке "Apply" ("Применить").
Это подтвердит Ваш выбор установок.
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5. Если у Вас есть другие сетевые адаптеры, например, CP 5611 MPI
или другой 3Com-адаптер в Вашем ПК, Вы должны деактивировать
его, так как он не требуется в соответствии с требованиями
начального курса.

Выполните следующие шаги:

- Выберите требуемый пункт в иерархической структуре "дерево",
например, "SIMATIC NET Configuration /Modules /[Наименование
адаптера, например, "CP5611"]/ General". Общая информация по
модулю после этого будет отображена в правом окне.

- В этом правом окне Вы увидите окно со списком (drop-down list
box) "Mode of the module" ("Режим модуля"), в котором Вы
должны выбрать пункт "Not yet specified" (Пока не определен).

- Щелкните кнопкой манипулятора "мышь" на кнопке "Apply"
("Применить").
Это задействует сделанные Вами установки.

6. Повторить пункт 5 для остальных сетевых адаптеров Вашего ПК,
которые не потребуются для связи базового для ES/OS компьютера и
CPU.

7. Закройте консоль для конфигурирования (Configuration Console).

3.2.1.2 Как установить PG/ПК-интерфейс

1. Выберите следующие опции меню из панели задач Windows: Start ->
Simatic -> STEP 7 -> NCM S7 Industrial Ethernet -> Diagnostics (Пуск ->
Simatic -> STEP 7 -> NCM S7 Industrial Ethernet -> Средства
диагностики). При этом откроется утилита NCM S7.

2. Выберите следующие опции меню: Diagnostics -> Open Online
Connection…( Средства диагностики -> Открыть интерактивное
соединение…). При этом откроется окно: "NCM S7 Diagnostics: Online
Path" ("Утилита NCM S7: путь онлайнового соединения").

3. С помощью манипулятора "мышь" щелкните на кнопке "Set PG/PC
Interface" (Установка PG/ПК-интерфейса). При этом откроется
диалоговое окно "Set PG/PC Interface" ("Установка PG/ПК-
интерфейса"):
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4. В диалоговом окне "Set PG/PC Interface" ("Установка PG/ПК-
интерфейса") выберите пункт: "ISO Ind. Ethernet --> 3Com EtherLink III
ISA..."

5. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
Ваших установок.

6. В области, относящейся к станции назначения "Destination Station",
выберите пункт "Industrial Ethernet" в окне со списком "Destination
station attachment" ("Присоединение к станции назначения").

7. Введите MAC-адрес, определенный для Вашего CP в окне "Node
address" ("Адрес узла").
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8. В окне со списком "Rack / slot", задайте значения "0 / 5".
Коммуникационный процессор CP находится в стойке в слоте Slot 5,
если Вы вставили источник питания и CPU.

9. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для того,
чтобы сделать действительными Ваши установки.
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Если соединение, которое Вы установили функционирует нормально,
то в окне "NCM S7 Diagnostics - CP 443-1" будут отображены данные
CP (см. след. рисунок).

10. Закройте утилиту диагностики NCM S7.
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3.3 Создание проекта

3.3.1 Использование программы-помощника "New Project"

Когда Вы запускаете SIMATIC Manager, автоматически запускается (в
соответствии с установками по умолчанию) "программа-мастер создания
проектов" PCS 7 "New Project". Вы можете включить или выключить эту
опцию в этой программе "New Project".

"Программа-мастер создания проектов" PCS 7 "New Project" помогает Вам
в пошаговом режиме создавать новый проект и использует при этом
установки, принятые по умолчанию. В зависимости от того, какие
установки Вы оставите нетронутыми, а какие измените, программа-мастер
может создать различные варианты проекта.

Для проекта "color_gs" являются необходимыми следующие объекты:

• объекты оборудования: SIMATIC-станции, например, SIMATIC 400 для
PLC, SIMATIC PC станция для OS;

• иерархическая структура папок, представляющая различные уровни
иерархической структуры установки. Многие папки иерархической
структуры создаются в соответствии с установками. которые Вы
задаете при работе с программой-мастером создания проекта (wizard);

• одна CFC-схема (CFC chart);

• одна SFC-схема (SFC chart);

• одно графическое представление на каждую папку иерархической
структуры установки;

• одна библиотека основных данных (Master data library).

3.3.2 Основная информация о программе-мастере (Wizard) для
создания PCS 7-проектов

 Что происходит при создании нового проекта?
Следующие два раздела предоставляют Вам теоретическое основы
программы-мастера для создания проектов "PCS 7 "New Project" (Wizard).
Эти разделы познакомят Вас также с двумя новыми терминами и
объяснят их значение:

• Мультипроект (Multiproject)

• Библиотека с данными объектов  - библиотека основных данных
(Master data library)
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Какую роль играет мультипроект?

При создании нового проекта с помощью программы-мастера (wizard)
PCS 7 автоматически создается "мультипроект" (multiproject).
Мультипроект состоит из нескольких простых проектов. Рассматриваемый
в контексте конкретного проекта, мультипроект может быть реализован
следующим образом: Мультипроект охватывает установку в целом, а все
"простые" проекты внутри мультипроекта, например, охватывают
отдельные фазы процесса.

Так как Вы должны создать лишь небольшую часть большой установки, то
Ваш мультипроект фактически содержит только один проект.

Вот главное преимущество использования мультипроектов: Вы можете
раздать отдельные проекты разным разработчикам, которые могут их
редактировать. Как только разработка отдельных проектов завершается,
эти проекты могут быть объединены в единый проект целой установки.

В данном начальном курсе, несмотря на то, что Вы будете иметь дело с
мультипроектом, тем не менее, Вы не будете использовать широкий
спектр функций, которые заложены в концепцию мультипроекта.

Более подробную информацию по данной теме Вы можете найти в
руководстве по проектированию "Process Control System PCS 7,
Engineering System" ("Системы управления процессом PCS 7, Система
разработки").

Что такое библиотека основных данных (master data library)?
При создании нового проекта с помощью программы-мастера (wizard)
PCS 7 автоматически создается библиотека основных данных (master data
library). Вы сохраняете все блоки, требуемые для проекта, в данной
библиотеке. Перед тем, как Вы создадите, например, CFC-схему (CFC
chart), Вы помещаете все стандартные блоки, которые Вы хотите
использовать в этой CFC-схеме, в Вашу библиотеку основных данных.
Использование библиотеки основных данных имеет следующие
преимущества: при архивировании проекта автоматически архивируется
библиотека основных данных вместе с проектом. Вы можете также
сделать изменения в блоках и затем продолжить повторное
использование этих блоков.

В контексте мультипроекта библиотека основных данных имеет важное
значение еще и потому, что она позволяет обеспечить всех
разработчиков, подключенных к процессу проектирования, набором
блоков определенных версий; таким образом, Вы можете быть
уверенными, что блоки именно допустимых версий будут использованы во
всех частях проекта.

3.3.2.1 Как создать проект "color_gs"

При создании проекта "color_gs", Вам будет помогать программа-мастер
(wizard) для создания проектов.

Выполняйте действия, указанные ниже:
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1. Запустите (откройте) утилиту SIMATIC Manager

2. Если программа-мастер (wizard) не запускается автоматически, то
выберите следующие опции меню:

File -> 'New Project' Wizard... (Файл -> Программа-мастер для создания
проектов 'New Project'...).

Программа-мастер PCS 7 "New Project" (Wizard) должна запуститься на
выполнение.

3. В пункте 1(4) "Introduction" ("Введение"), активируйте опцию
"Multiproject with project and master data library" ("Мультипроект для
проекта и библиотека основных данных") – данная опция активируется
как установка по умолчанию.

4. Щелкните кнопкой манипулятора "мышь" на кнопке "Continue"
("Далее").

5. В пункте  2(4) "Which PLC will you use in your project?" ("Какой PLC Вы
будете использовать в Вашем проекте?") выберите тип CPU, который
Вы намерены использовать в проекте, например, CPU 417-4. 

В нижнем окне Вы можете видеть текст с подробной
информацией, касающейся выбранного CPU. 

После того, как Вы сделаете в этом окне свой выбор, Вы
можете сравнить типовой номер (type number) и порядковый номер
(order number), указанные на передней панели Вашего CPU с
соответствующими номерами в информационных данных открытого
окна утилиты.
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6. Щелкните кнопкой манипулятора "мышь" на кнопке "Continue"
("Далее").

7. В пункте  3(4) "Which objects will be used in the project ?" ("Какие
объекты будут использованы в проекте ?"), сделайте следующие
установки:

- В окне со списком "Number of levels" ("Число уровней") задайте "4".

- В группе "OS objects" включите опцию "PCS 7 OS" (check box).
Опция "Single-user system" ("однопользовательская система")
включится автоматически.

8. Щелкните кнопкой манипулятора "мышь" на кнопке "Continue"
("Далее").
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9. В пункте  4(4) введите имя проекта "color_gs" в окне "Directory name"
("Имя раздела") и подтвердите место расположения проекта.

10. Щелкните кнопкой манипулятора "мышь" на кнопке "Preview <<" для
предварительного просмотра текущего этапа проектирования.
Предварительный просмотр покажет в SIMATIC Manager, что
появился новый проект.

11. Щелкните кнопкой манипулятора "мышь" на кнопке "Finish"
("Закончить").
Когда проект создается, дважды открывается диалоговое окно:
"Message Number Assignment Selection" ("Назначение номера для
сообщений").
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12. Примите установки по умолчанию:

- "Unique message number assignment for the CPU" ("Назначение
уникального номера сообщения для CPU") - опция активирована

- "Always prompt for settings" ("Всегда выдавать подсказку для
установок") - опция активирована

13. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
Теперь проект создан с заданными установками параметров.

Примечание
• Если проект не открывается автоматически, то выполняйте пункты, как в

разделах: "Первые шаги при работе с проектом – Создание проекта – Как
открывать и закрывать проект "color_gs".

• Для активации различных видов (представлений) выполняйте пункты, как
описано в разделах: "Первые шаги при работе с проектом – Создание
проекта  – Как работать различными представлениями".
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После этого проект появится в окне SIMATIC Manager в "представлении
установки":

3.3.2.2 Как открывать и закрывать проект "color_gs"

Закрытие проекта
1. Если в SIMATIC Manager есть другие открытые проекты, то закройте

их для упрощения отображения.

Выберите опции меню: Window -> [Name of the Project] (Окно -> [имя
проекта]) и задайте имена закрываемых проектов. В SIMATIC
Manager эти проекты будут выделены.

2. Выберите опции меню:  File -> Close (Файл -> Закрыть).
Указанные проекты будут закрыты.

Открытие проекта
1. Откройте SIMATIC Manager.

2. Если проект "color_gs" не открылся автоматически, то используйте
опции меню: File -> Open (Файл -> Открыть). После этого появится
окно "Open Project" ("Открыть проект") с активной вкладкой "User
Projects" ("Проекты пользователя").

3. Откройте вкладку "Multiprojects" (Мультипроекты) и выберите
"color_gs_MP".

4. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
Проект и соответствующая библиотека основных данных будут
открыты.
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3.3.2.3 Как работать с различными представлениями

Как только Ваш проект будет открыт в SIMATIC Manager, Вы сможете
использовать различные представления.

Для выбора нужного представления:

• Выберите опции меню:
View -> [Name of the required view]

(Вид -> [имя требуемого представления])
в SIMATIC Manager:

- "Представление компонентов" (Component view)

- "Представление установки" (Plant view)

- "Представление объектов процесса" (Process object view)

• Если у Вас уже открыто несколько проектов, выберите опции меню:
 Window -> [Name of the project (name of the view)]"
 (Окно -> [имя проекта (наименование
представления)]")
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3.4 Конфигурирование оборудования

3.4.1 Конфигурирование оборудования

Отдельные компоненты системы управления, такие как CPU,
операторская станция, система (среда) разработки, должны обладать
возможностью соединения друг с другом. Для реализации такой
возможности необходимо произвести вставку (insert) и конфигурирование
компонентов оборудования. При использовании программы-помощника по
созданию проекта (wizard) некоторые компоненты оборудования, такие как
стойка (rack), CPU и коммуникации (connection) вставляются в проект
автоматически. Кроме этого Вы должны вставить коммуникационные
процессоры CP, которые Вам необходимы, после чего установить
требуемые соединения.

Основные пункты при конфигурировании проекта "color_gs":

• Конфигурирование программируемого контроллера,
конфигурирование соединений (connection) – коммуникации CPU с
системой ES обеспечиваются посредством соединений.

• Загрузка конфигурации в CPU

• Конфигурирование OS, конфигурирование соединений (connection) –
коммуникации OS с PLC обеспечиваются посредством соединений.

3.4.1.1 Как конфигурировать оборудование - PLC

Готовы начинать?
• Проект "color_gs" должен быть открыт в SIMATIC Manager

• Должен быть активирован вид "представление компонентов"

Следуйте плану действий, указанному ниже...
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1. В иерархической структуре проекта выберите папку "color_gs_MP/
color_gs_Prj/ SIMATIC 400(1)".

2. Выберите объект "Hardware" (Оборудование) в правом окне, после
чего выберите опции меню: Edit -> Open Object (Правка -> Открыть
объект).
При этом открывается утилита HW Config и отображается структура
оборудования Вашей системы.

Примечание
Если каталог оборудования не отображается, то используйте опции меню:
View -> Catalog (Вид -> Каталог).

При этом открывается каталог оборудования и профиль "PCS7_V60"
активизируется.

3. Выберите из каталога следующий CP:
"SIMATIC 400/ CP-400/Industrial Ethernet/ CP 443-1/ 6GK7 443-1EX11-
0XE0/ V2.0".
Перетащите его на слот 5 стойки.
После этого откроется диалоговое окно: "Properties - Ethernet Interface"
("Свойства - интерфейс Ethernet") (см. далее).
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4. Активируйте опцию: "Set MAC address/use ISO protocol" (Установить
MAC-адрес/использовать ISО-протокол).

5. В окне "MAC address" задайте MAC-адрес, который Вы можете найти
на передней панели CP.

6. Включите опцию "IP protocol is used" (Используется IP-протокол).
Это активирует все окна ввода.

7. Щелкните кнопкой манипулятора "мышь" на кнопке "New" ("Новый").
Теперь откроется диалоговое окно "Properties - new subnet Industrial
Ethernet" ("Свойства - новая подсеть Industrial Ethernet").
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8. Выполните нужные установки и завершите ввод щелчком кнопки
манипулятора "мышь" на кнопке "OK".   
В окне списка "Subnet" ("Подсеть") появится новая запись -
"Ethernet(1)"; эта запись в окне выделена.

9. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для
подтверждения сделанных Вами установок.
Диалоговое окно закроется.

10. Выберите опции меню: 
Station -> Save and Compile (Станция -> Сохранить и
компилировать).
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3.4.1.2 Как загрузить конфигурацию оборудования (Hardware
Configuration)

Как только Вы создадите конфигурацию для CPU, Вам необходимо будет
передать информацию об этой конфигурации в CPU. Это выполняется с
помощью операции загрузки.

Требование
Переведите Ваш CPU в режим RUN-P с помощью переключателя
режимов. Это позволит выполнить автоматическую остановку CPU с
последующим перезапуском в утилите HW Config.

Готовы начать?
• Утилита конфигурирования HW Config открыта для проекта "color_gs".

Следуйте плану действий, указанному ниже...

1. Выберите опции: PLC -> Download to Module (PLC -> Загрузить в
модуль).
При этом откроется диалоговое окно "Select Target Module" ("Выберите
модуль назначения", в котором представлен и выделен CPU 417-4.
Этот CPU Вы должны вставить в Ваш проект.

2. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
При этом откроется диалоговое окно "Select Node Address" ("Выберите
адрес узла".



3  Первые шаги в работе с проектом

Process Control System PCS 7
Getting Started - Part 1
A5E00164244-01 3-25

3. Щелкните кнопкой манипулятора "мышь" на кнопке "Display".
В окне списка "Accessible Nodes" ("Доступные узлы") Вы можете
видеть CP с MAC-адресом, который Вы ввели при конфигурировании
оборудования.

4. Выберите "CP 443-1" в списке "Accessible Nodes" ("Доступные узлы")  и
щелкните кнопкой манипулятора "мышь" на кнопке "OK".
После этого Вы увидите индикатор загрузки. Наконец, откроется окно
сообщения с квитированием: "Stop Target Modules" (Остановить
работу целевых модулей).

Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для остановки
(stop) CPU. При этом окно сообщения закроется и продолжится процесс
загрузки. После завершения операции загрузки появится окно сообщения:
"Restart CPU" ("Перезагрузить CPU")
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5. Щелкните кнопкой манипулятора "мышь" на кнопке "Yes" ("Да") для
перезагрузки CPU. 
После перезагрузки следующие светодиодные индикаторы должны
светить зеленым цветом, что означает, что процесс загрузки выполнен
успешно:

- На панели CPU: "RUN" ("Работа")

- На панели CP: "LINK" ("Связь") и "RUN" ("Работа")

3.4.1.3 Как конфигурировать оборудование - OS

Готовы начать?
• Проект "color_gs" открыт в SIMATIC Manager

• Включено "представление компонентов"

Следуйте плану действий, указанному ниже...
1. В иерархической структуре ("дерево") выберите папку:

"color_gs_MP/ color_gs_Prj/ SIMATIC PC-Station(1)".

2. Выберите объект "Configuration" ("Конфигурация") в правом окне,
затем выберите опцию меню: Edit -> Open Object (Правка -> Открыть
объект).
При этом открывается окно утилиты конфигурирования оборудования
HW Config с компонентами станции оператора OS. Утилита HW Config
открывается с установками, которые Вы сделали при
конфигурировании PLC:

- Открыт каталог оборудования (hardware catalog).

- Профиль "PCS7_V60" активирован.

3. Выберите из каталога следующий CP:
"SIMATIC PC-Station/CP-Industrial Ethernet/IE General"
и перетащите его на слот 2.
При этом откроется диалоговое окно "Properties - Ethernet Interface"
("Свойства - интерфейс Ethernet").
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4. Откройте пункт "Ethernet" в окне списка "Subnet" ("подсеть").
Это связь, которую Вы сконфигурировали для CP.

5. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
установок.
Диалоговое окно закрывается.
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6. Выберите опции меню: 
Station -> Save and Compile  (Станция -> Сохранить и
компилировать).

7. Закройте утилиту конфигурирования оборудования HW Config.
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3.5 Работа с иерархией установки (Plant Hierarchy - PH)

3.5.1 Установки для иерархии установки (Plant Hierarchy)

Снова немного теории:

Иерархия установки (Plant Hierarchy), которая обычно обозначается
сокращением PH, отражает иерархическую структуру Вашей установки:
Установка (Plant), блок (unit), функция (function) и т.д. Для иерархии
установки PH Вы можете задавать множество различных установок и
наиболее важные из них описаны ниже.

• Число уровней иерархии PH:
Структура Вашей установки определяет число уровней иерархии. В
общем случае, чем более сложна структура Вашей установки, тем
большее число уровней иерархии Вам потребуется для отображения
этой структуры. При использовании программы-мастера (wizard) для
создания проекта создаются папки с именами, принимаемыми по
умолчанию.

• Выбор уровня (уровней) иерархии, который (которые) добавляются в
обозначение установки (plant designation) (также известное как - higher
level designation - "высший уровень обозначения"):
"Высший уровень обозначения", обозначаемый также сокращением
"HID", используется во многих случаях в PCS 7-проекте, например, в
сообщениях, приходящих во время работы в режиме "процесса"
(process mode), а также в тэгах (tags), которые содержат этот HID. Это
упрощает определение части установки, к которой сообщение или тэг
относится. Практически, чем больше уровней иерархии используется
для определения HID и чем длиннее каждое составляющее
обозначение, тем длиннее становится обозначение HID в целом, и тем
сложнее распознать часть установки, которую он обозначает.

• Базирование иерархии графических отображений процесса (picture
hierarchy) на иерархии установки PH:
Графические отображения процесса (process pictures) организованы в
определенную иерархическую систему: Это позволяет Вам
переключаться от отображения общего вида процесса к виду более
низкого уровня, показывающему только часть общего вида, но в
значительно более детализированном представлении. Вы можете при
создании своей иерархии графических отображений процесса
опираться на иерархическую структуру установки (plant hierarchy),
обеспечивая соответствие этих структур.
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3.5.1.1 Как задать установки для PH

Готовы начать?
• Проект "color_gs_MP" открыт в SIMATIC Manager

• Включено "представление установки"

Следуйте плану действий, указанному ниже...

1. В иерархической структуре ("дерево") выберите уровень иерархии:
"color_gs_MP/color_gs_Prj".

2. Выберите опции меню: 
Options -> Plant hierarchy -> Settings 
(Опции  -> Иерархия установки  -> Установки).
При этом открывается диалоговое окно "Customize Plant Hierarchy"
("Иерархия установки пользователя"), в котором Вы можете задать
все опции для иерархии установки.

3. Введите значение "4" в окно "Number of hierarchy levels" (Число
уровней иерархии).
Это означает, что максимально допускается 4 уровня иерархии.

4. Введите значение "10" в окно "Max. number of characters"
(Максимальное число символов).
Это означает, что максимально допускается 10 символов на каждый
уровень иерархии в обозначении установки.

5. Активируйте опцию (элемент управления "check box") "Included in
designation" ("Включить в обозначение") для уровней  1 и 2.

6. Активируйте опцию (элемент управления "radio button") "OS area"
("Область OS") для уровня 2.

7. Активируйте опцию (элемент управления "check box") "Derive picture
hierarchy from the plant hierarchy" ("Формировать иерархию
графических представлений процесса на основе иерархической
системы установки").
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8. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для
подтверждения Ваших установок.
После этого должно появиться сообщение: 
"You have changed the include in designation property. Do you also want
the changes to apply to existing hierarchy folders?" ("Вы изменили
структуру в свойствах обозначений. Хотите ли Вы также применить
эти изменения к существующим папкам иерархической системы?").

Щелкните кнопкой манипулятора "мышь" на кнопке "Yes" ("Да") в
диалоговом окне. При этом будут активированы сделанные Вами
установки.
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3.5.2 Структурирование в "представлении установки" (Plant View)

Вы уже определили четыре уровня иерархии при работе с программой-
мастером для создания проектов "New Project". В результате, Вы можете
найти теперь следующие папки в иерархической структуре Вашего
проекта:

• Plant – уровень 1 (plant - установка)

• Unit – уровень 2 (unit - блок)

• Function – уровень 3 (function - функция)

• Device – уровень 4 (device - прибор, устройство)

Такие имена папок иерархической системы являются именами,
принимаемыми по умолчанию, и назначаются автоматически системой
PCS 7, когда Вы создаете проект.

В Вашем проекте "color_gs_MP" Вы можете, конечно, привести их в
соответствие с Вашими требованиями для проекта "color_gs", другими
словами, Вы можете изменить эти имена и добавить новые папки
иерархической системы. Это позволяет Вам создать понятную структуру
для более легкого ориентирования в проекте. Вы можете также управлять
всеми объектами и отдельными блоками.

Для разных частей установки мы приняли следующие имена для папок
иерархической системы:

 Имя по
умолчанию

 Hierarchy Folder
 (Папка

иерархической
системы)

 Техническое (технологическое)
назначение

Plant Plant1 Установка в целом

Unit RMT1 Резервуар 1 для хранения сырья

Function FC111 Управление расходом сырья (дозатор)

Function LI111 Индикатор уровня сырья в резервуаре 1

Function NP111 Управление насосом

Function NK111 Вентиль

Function NK112 Вентиль

Function NK113 Вентиль

Function NK114 Вентиль

Device ADDIT Вспомогательная схема выбора уставок
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3.5.2.1 Как изменить имена, принятые по умолчанию

Готовы начать?
• Проект "color_gs" открыт в SIMATIC Manager

• Включено "представление установки"

Переименование папки "Plant"
1. Выберите папку иерархической системы:

"color_gs_MP/color_gs_Prj/Plant(1)".

2. Выберите опции: Edit -> Object Properties (Правка -> Свойства
объекта).
При этом откроется диалоговое окно "Properties – Hierarchy Folder"
("Свойства - Папка иерархической системы") с активной вкладкой
"General" ("Общие").

3. Введите имя "Plant1" в окне "Name" ("Имя").

4. Щелкните кнопкой манипулятора "мышь" на кнопке "OK", чтобы
активировать сделанные Вами установки.
Диалоговое окно закроется, и имя папки изменится на "Plant1".
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Переименование папки "Unit"
1. Выберите папку "Unit(1)" в иерархической системе папок.

2. Выберите опции: Edit -> Object Properties (Правка -> Свойства
объекта).
При этом откроется диалоговое окно "Properties – Hierarchy Folder"
("Свойства - Папка иерархической системы") с активной вкладкой
"General" ("Общие").

3. Введите имя "RMT1" в окне "Name" ("Имя").

4. Переключитесь на вкладку "Control and Monitoring Attributes"
(Параметры управления и мониторинга).

5. Убедитесь, что отключена опция (check box) "No modification when
renaming the hierarchy folder" ("Нет изменений при переименовании
папки иерархической системы".
Это обеспечит изменение текста идентификатора "OS area" в
соответствии с именем папки иерархической системы.

6. Щелкните кнопкой манипулятора "мышь" на кнопке "OK", чтобы
активировать сделанные Вами установки.
Диалоговое окно закроется, и имя папки иерархической системы
изменится на "RMT1".
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Переименование других папок
1. Выберите папку иерархической системы: 

"color_gs_MP/ color_gs_Prj/Plant1/RMT1/ Function(1)" 
и сделайте следующие установки:

- Замените имя "Function(1)" на "FC111".

- Выключите опцию (check box) "No modification when renaming the
hierarchy folder"  ("Нет изменений при переименовании папки
иерархической системы".

Примечание
Дальше - выполняйте такую же процедуру, как при переименовании папки
"Plant".

2. Выберите папку иерархической системы:
"color_gs_MP/ color_gs_Prj/Plant1/RMT1/ Function(1)/ Device(1)" folder 
и сделайте следующие установки:

- Замените имя "Device(1)" на "ADDIT"

- Выключите опцию (check box) "No modification when renaming the
hierarchy folder"  ("Нет изменений при переименовании папки
иерархической системы".

Примечание
Дальше - выполняйте такую же процедуру, как при переименовании папки
"Plant".

3.5.2.2  Как выполнять вставку других папок в иерархическую
систему проекта

Готовы начать?
• Проект "color_gs" открыт в SIMATIC Manager

• Включено "представление установки"

Следуйте плану действий, указанному ниже...
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1. Выберите папку иерархической системы: "RMT1".

2. Выберите опции меню: Insert -> Technological Objects -> Hierarchy
Folder (Вставка -> Технологические объекты -> Папка иерархической
системы)
При этом будет создана новая папка иерархической системы "Function
[следующий по порядку номер]"

3. Замените имя на "LI111" и выключите опцию (check box) "No
modification when renaming the hierarchy folder"  ("Нет изменений при
переименовании папки иерархической системы" на вкладке "Control
and Monitoring Attributes" (Параметры управления и мониторинга)
диалогового окна "Properties – Hierarchy Folder" ("Свойства - Папка
иерархической системы").

4. Нажмите кнопку Enter.

5. Повторите шаги 1...4, чтобы создать следующие папки:
- NP111 – motor control (управление двигателем)
- NK111 – valve control (управление вентилем)
- NK112 – valve control (управление вентилем)
- NK113 – valve control (управление вентилем)
- NK114 – valve control (управление вентилем)

Иерархическая структура Вашей установки теперь имеет следующий вид:
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2.5.3 Обмен информацией между PLC и OS

Отдельные части установки могут быть назначены отдельным
программируемым контроллерам и/или отдельным станциям оператора
(operator stations). Каждая папка иерархической системы содержит такую
информацию о назначении объектов. Это, конечно, играет важную роль
только тогда, когда в Вашей системе имеется более одного
программируемого контроллера или более одной станции оператора.

В учебном проекте "color_gs" у Вас в наличии только один программируемый
контроллер и одна операторская станция. Поэтому все папки иерархической
системы автоматически назначены системой.

Вы можете проверить все выполненные в проекте назначения следующим
образом:

1. Выберите папку иерархической системы: "Plant1". 
Затем выберите опции меню: 

Edit -> Object Properties  (Правка -> Свойства объекта).
При этом откроется диалоговое окно "Properties – Hierarchy Folder"
("Свойства - Папка иерархической системы") с активной вкладкой
"General" ("Общие").

2. Переключитесь на вкладку "PLC and OS Assignment" ("Назначения для
PLC и OS").
На данной вкладке Вы можете увидеть следующие назначения:

- Для PLC в элементе "Assigned PLC (chart folder)" ["Назначения PLC
(папка схем)"] Вы увидите программируемый контроллер, который
обрабатывает данные.

- Для OS в окне списка "Assigned OS" ("Назначения OS") Вы увидите
операторскую станцию (operator station), на дисплее которой будут
отображаться данные.

3. Закройте диалоговое окно.
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3.6 Текущее состояние Вашего проекта...

К текущему моменту времени Вы выполнили перечисленные ниже действия
по конфигурированию Вашего проекта:

• с помощью утилиты SIMATIC Manager Вы создали проект начального
курса "color_gs";

• с помощью утилиты для конфигурирования оборудования HW Config Вы
создали конфигурацию оборудования для Вашего проекта;

• с помощью утилиты HW Config Вы загрузили конфигурацию оборудования
проекта в CPU;

• Вы задали установки (параметры) для иерархии Вашей установки (plant
hierarchy);

• Вы создали структуру установки для проекта "color_gs" в иерархии
установки (plant hierarchy).
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4 Создание CFC-схем (CFC-chart)

4.1 Общий обзор CFC-схем и CFC-редактора

Теория: 
что такое CFC-схемы (charts), что такое CFC-редактор (CFC-Editor)?

Работа установки в целом характеризуется непрерывными процессами и
программируется для системы управления процессом. Программирование
заключается в создании CFC-схем (charts) в среде CFC-редактора (CFC-
Editor) PCS 7. При формировании CFC-схем (charts) Вы вставляете блоки,
размещенные в библиотеке "PCS 7 Library V6.0", в объекты "CFC-схемы"
(charts). Среди этих блоков есть одиночные блоки, такие как блоки для
управления процессом или для мониторинга измеряемых значений.
Входы (inputs - входные параметры) и выходы (outputs - выходные
параметры) этих блоков непосредственно связываются в CFC-редакторе
и обеспечивают обмен значениями параметров. В процессе
конфигурирования блоков пользователь использует дружественный
графический интерфейс CFC-редактора PCS 7.

В стандартной библиотеке PCS 7 пользователю доступны также "типы
тэгов (переменных) процесса" (process tag types), которые базируются на
полных CFC-схемах (charts) для различных тэгов процесса (process tags),
таких как моторы и вентили.

Вы также найдете CFC-схемы (charts) в иерархии установки (plant
hierarchy). Для того, чтобы структура установки оставалась понятной,
CFC-схемы всегда располагаются в папках иерархической системы
(hierarchy folders) в соответствии с технологическим назначением.

Идентификация CFC-схем

CFC-схемы (charts) могут быть идентифицированы по следующим
символам, указанным перед их именами:
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4.2 Работа с библиотеками

4.2.1 CFC-схемы (charts) и библиотека основных данных (master
data library)

Краткое теоретическое введение к понятию "библиотека основных
данных" (master data library)…

При создании CFC-схем (charts) Вы будете работать с библиотеками
основных данных (master data libraries). Вы уже познакомились с понятием
библиотеки основных данных в теоретической части, в которой
рассматривалось также понятие мультипроекта (multiproject) при создании
Вашего проекта. Все блоки (blocks) и типы тэгов процесса (process tag
types), требуемые в CFC-схемах (charts) Вашего проекта, никогда не
берутся непосредственно из стандартной библиотеки (standard library)
PCS 7. Сначала Вы должны сохранить требуемые блоки (blocks) и типы
тэгов процесса (process tag types) в библиотеке основных данных (master
data library) и только от туда производить вставку этих объектов в CFC-
схемы (charts).

Какие преимущества дает применение библиотеки основных данных
(master data library)?

Поначалу, работа с использованием библиотеки основных данных (master
data library) может показаться несколько излишне долгой: сначала Вы
сохраняете блоки (blocks) и типы тэгов процесса (process tag types) в
библиотеке основных данных (master data library), затем опять выбираете
от туда эти объекты для того, чтобы вставить их в CFC-схему (chart). Для
чего такие сложности? Использование библиотеки основных данных
(master data library) гарантирует, что во всем проекте будут использованы
блоки одной и той же версии и не будет смеси из блоков разных версий.
Это важно, в частности, когда над проектом работает несколько
разработчиков, что всегда характерно при разработке больших проектов в
рамках мультипроекта. Использование библиотеки основных данных
(master data library) также предоставляет Вам в PCS 7 функцию сокрытия
библиотек. Эта функция заключается в том, что Вы скрываете все
библиотеки, кроме одной - библиотеки основных данных (master data
library), что позволяет избежать ошибок в проекте и отсутствия
консистентности в данных. Ошибки в конфигурации и отсутствие
консистентности в данных могут явиться причиной значительных
сложностей как при отладке проекта, так и собственно в его работе. Еще
одно преимущество от применения библиотек основных данных (master
data librarys) заключается в том, что они автоматически архивируются
вместе с проектом при архивации мультипроекта.
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4.2.2 Хранение объектов в библиотеке основных данных (master
data library)

Изменения в блоках (Blocks)
В данном разделе мы совершим несколько иной теоретический экскурс.
Данный раздел выходит за рамки материала основного курса, но он
познакомит Вас с некоторыми опциями, которыми обеспечивает Вас
система PCS 7:

В библиотеке основных данных (master data library) Вы можете изменить
свойства блока, например, изменить текст сообщений в соответствии с
требованиями Вашего конкретного проекта. Каждый экземпляр блока
(block instance), который создается, когда Вы вставляете блок в CFC-
схему (chart) уже имеет автоматически измененные свойства. Это значит,
что Вам нужно сделать изменения только в блоке в библиотеке основных
данных (master data library), и Вам не нужно больше делать изменений в
каждом экземпляре блока (block instance). Изменения в блоке, которые
являются специфическими для CFC-схемы (chart), могут быть затем
сделаны непосредственно в экземпляре блока (block instance) собственно
в CFC-схеме (chart). Это касается, например, входных и выходных
параметров таких, как значения уставок (setpoints) или граничные
значения (limit values).

Библиотека основных данных (master data library) и типы тэгов процесса
(process tag types)

Вы можете, конечно, также хранить типы тэгов процесса (process tag
types), которые предоставляет Вам система PCS 7 в Вашей библиотеке
основных данных (master data library). В фоновом режиме все блоки,
включающие в себя этот тип тэгов процесса (process tag type),
автоматически вводятся в папку блоков (block folder) Вашей библиотеки
основных данных (master data library).

Общая процедура
• Откройте библиотеку.

• Поместите все блоки в Вашу библиотеку основных данных (master
data library) – библиотека основных данных была создана
автоматически программой-мастером (Wizard) PCS 7, когда Вы
создавали проект.

• Введите типы тэгов процесса (process tag types) в Вашу библиотеку
основных данных (master data library)
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4.2.3 Работа с библиотекой основных данных (master data library)

Блоки в библиотеке основных данных (master data library)
Создание библиотеки основных данных (master data library) для больших
проектов, конечно, предполагает тщательное планирование CFC-схем
(charts), которые должны быть созданы. В начальном курсе мы, конечно
же, обеспечим Вас всеми блоками, необходимыми для проекта "color_gs".
Эти блоки представлены в приложенном ниже списке.

Дополнительная информация:

• Object name (имя объекта) – это короткий алфавитно-цифровой
идентификатор для блока, который отображается в PCS 7;

• Symbolic name (символьное имя) – это короткое понятное имя для
блока;

• Meaning (значение) – это краткая информация по использованию
блока;

• Type of block (тип блока) – это категория, к которой блок относится;

• Relevant CFC chart (соответствующая CFC-схема) – здесь Вы найдете
все CFC-схемы (charts), в которых используется данный блок.

 Имя
объекта

 Символьное
имя  Значение  Тип блока

 Соответ-
ствующая
CFC-схема

FB40 INT_P Формирование интегрированного по
времени входного сигнала

Technological block
(Технологический блок)

CFC_LI111
CFC_FC111

FB46 OP_A_LIM Управление аналоговыми сигналами
Operator control block
(Блок операторного
управления)

CFC_FC111

FB48 OP_D Управление дискретными сигналами
Operator control block
(Блок операторного
управления)

CFC_FC111

FB61 CTRL_PID ПИД-регулятор непрерывного
управления

Technological block
(Технологический блок)

CFC_FC111

FB63 DOSE Блок дозирования компонентов
Technological block
(Технологический блок)

CFC_FC111

FB65 MEAS_MON Мониторинг измеренных аналоговых
сигналов

Technological block
(Технологический блок)

CFC_LI111

FC63 MUL_R Перемножение входных сигналов с
передачей результата на выход

Function
(Функция)

CFC_FC111

FC275 CH_AI Обработка аналоговых входных
сигналов

Driver block
(Блок управления)

CFC_LI111
CFC_FC111

FC276 CH_AO Обработка аналоговых выходных
сигналов

Driver block
(Блок управления) CFC_FC111
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Типы тэгов процесса (process tag types) в библиотеке основных данных
(master data library)

Введите типы тэгов процесса (process tag types) в Вашу библиотеку
основных данных (master data library) точно таким же путем как блоки. Вам
потребуются следующие типы тэгов процесса (process tag types) для
проекта "color_gs":

 Имя объекта  Значение  Соответствующая
CFC-схема

MOTOR CFC-схема (chart) для мотора CFC_NP111

VALVE CFC-схема (chart) для вентиля CFC_NK111

4.2.3.1 Как открывать библиотеки

Готовы начать ?

Утилита SIMATIC Manager запущена

Открытие библиотек

1. Выберите опции меню:  
File -> Open (Файл -> Открыть).
Открывается диалоговое окно "Open Project" ("Открыть проект").

2. Выберите вкладку "Libraries" ("Библиотеки").

3. Выберите библиотеки "PCS 7 Library V60" и "color_gs_Lib" из 
представленного списка.
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4. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
Обе библиотеки открыты теперь в "представлении компонентов"
(component view).

4.2.3.2 Как вставлять блоки в библиотеку

Готовы начать ?
• Утилита SIMATIC Manager открыта

• Библиотека "PCS 7 Library V60" открыта в режиме "представления
компонентов" (component view).

• Библиотека основных данных (master data library) "color_gs_Lib"
открыта в режиме "представления компонентов" (component view).

Вставка блоков в библиотеку основных данных (master data library)
1. Выберите опции меню:  Window -> PCS 7 Library V60 (component view)

(Окно -> PCS 7 Library V60 ("представление компонентов")).
При этом откроется стандартная библиотека PCS 7.
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2. Выберите следующие пункты в иерархической структуре
"PCS 7 Library V60/ Blocks + Templates/ Blocks".
Все блоки, которые предоставляются по умолчанию системой PCS 7,
отображаются в правом окне.

3. Выберите опции меню:  View  -> Details (Вид  -> Подробно).
Теперь отображаются имена объектов, т.е. короткие идентификаторы
блоков и их символьные имена.

4. В окне справа выберите требуемые блоки в соответствии со списком:

- FB40 – INT_P

- FB46 – OP_A_LIM

- FB48 – OP_D

- FB61 – CTRL_PID

- FB63 – DOSE

- FB65 – MEAS_MON

- FC63 – MUL_R

- FC275 – CH_AI

- FC276 – CH_AO

5. Выберите опции меню:  Edit -> Copy (Правка -> Копировать).
6. Выберите опции меню: Window -> color_gs_Lib  (component view)

(Окно -> color_gs_Lib  ("представление компонентов")).
            При этом откроется библиотека основных данных (master data
library).

7. Выберите следующие пункты в иерархической структуре
"In <color_gs_MP->/ color_gs_Lib/ S7-Program(1)/ Blocks".

8. Выберите опции меню:  Edit -> Paste (Правка -> Вставить).
Теперь все выбранные блоки вставлены.
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4.2.3.3 Как вставить типы тэгов процесса (process tag types) в
библиотеку

Готовы начать ?
• Утилита SIMATIC Manager открыта

• Библиотека "PCS 7 Library V60" открыта и "представление
компонентов" (component view) активизировано.

• Библиотека основных данных (master data library) "color_gs" открыта и
"представление компонентов" (component view) активизировано.

Вставка типа тэгов процесса (process tag type) в библиотеку основных
данных (master data library)

1. Выберите опции меню:  Window -> PCS 7 Library V60 (component view)
(Окно -> PCS 7 Library V60 ("представление компонентов")).
Переключитесь в режим "представления компонентов" (component
view) в стандартной библиотеке PCS 7.

2. Выберите следующие пункты в иерархической структуре "PCS 7
Library V60/ Blocks +  Templates/Templates".
Все схемы (charts), которые предоставляет система PCS 7 по
умолчанию, отображаются в виде шаблонов (templates) в правом окне.



Создание CFC-схем

Process Control System PCS 7
Getting Started - Part 1
A5E00164244-01 4-9

3. Выберите следующие схемы в этом окне:

- "MOTOR"

- "VALVE"

4. Выберите опции меню:  Edit -> Copy (Правка -> Копировать).

5. Выберите опции меню:  Window -> color_gs_Lib  (component view)
(Окно -> color_gs_Lib  ("представление компонентов"). 

При этом откроется библиотека основных данных (master data library).

6. Выберите следующие пункты в иерархической структуре
"In <color_gs_MP->/ color_gs_Lib/ S7-Program(1)/ Charts".

7. Выберите опции меню:  Edit -> Paste (Правка -> Вставить).
Все выбранные типы тэгов процесса (process tag types) теперь
вставлены.

Примечание

Как только Вы вставите тип тэгов процесса (process tag type) в библиотеку
основных данных (master data library), все отдельные блоки (blocks),
содержащие этот тип тэгов процесса (process tag type), будут вставлены
автоматически в папку блоков ("Blocks" folder).

Если Вы выберете "In <color_gs_MP->/ color_gs_Lib/ S7-Program(1)/ Blocks",
все блоки (blocks) будут отражены в правом окне: блоки, которые Вы
вставили сами, вместе с блоками, которые были вставлены автоматически
при копировании типов тэгов процесса (process tag types).

8. Теперь закройте библиотеки "PCS 7 Library V60" и "color_gs_lib".
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4.2.4 Показ (Show) и скрытие (Hide) библиотек

У пользователя есть возможность скрыть те библиотеки, которые
необходимо. Данная опция используется при работе с каталогом в CFC-
редакторе и позволяет сделать его отображение более понятным, что
уменьшает вероятность совершения ошибки. Так как Вы уже вставили все
необходимые блоки и типы тэгов процесса (process tag types) в Вашу
библиотеку основных данных (master data library), Вам нужно будет только
поработать с библиотекой основных данных (master data library) для того,
чтобы создать проект "color_gs".

Вы сможете, тем не менее, отобразить библиотеки при необходимости.

4.2.4.1 Как скрыть (Hide) и как показать (Show) библиотеки

Внимание
Убедитесь, что Вы действительно внесли все блоки (blocks) и схемы (charts)
в Вашу библиотеку основных данных (master data library).

Готовы начать ?

• Утилита SIMATIC Manager открыта

Скрытие библиотек

1. Выберите опции меню:  File -> Manage (Файл -> Настройка).
Диалоговое окно "Manage" ("Настройка") теперь открыто.

2. Выберите вкладку "Libraries" ("Библиотеки").

3. Выберите все библиотеки в списке, кроме следующих библиотек:

- Библиотека основных данных (master data library) "color_gs_Lib"

- PCS 7 Library V60

- SFC Library
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4. Щелкните кнопкой манипулятора "мышь" на кнопке  "Hide" ("Скрыть").
Все библиотеки, которые Вы выбрали, теперь удалены из списка.

5. Щелкните кнопкой манипулятора "мышь" на кнопке "Close" ("Закрыть").
Теперь все библиотеки, которые не нужны для использования, стали
невидимыми. Теперь они не будут отображаться в каталоге CFC-
редактора.

Как вновь сделать библиотеки видимыми
1. Выберите опции меню:  File -> Manage (Файл -> Настройка).

Диалоговое окно "Manage" ("Настройка") теперь открыто.

2. Щелкните кнопкой манипулятора "мышь" на кнопке "Display"
("Показать"). Открывается диалоговое окно "Browse" ("Поиск").

3. Выберите папку ".../SIEMENS/ STEP7/ S7LIBS в иерархической
структуре.

4. Выберите требуемую библиотеку.
Она отобразится на соседней вкладке "Libraries" ("Библиотеки").

5. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
Нужная библиотека теперь выделяется в списке библиотек в
диалоговом окне "Manage" ("Настройка").

6. Если Вы хотите отобразить другие библиотеки, повторите шаги с 2
по 5.

7. Щелкните кнопкой манипулятора "мышь" на кнопке "Close" ("Закрыть").
Диалоговое окно закроется.
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4.3 CFC-схемы (charts) в иерархической системе
установки

4.3.1 Работа с CFC-схемами (charts)

Как только Вы выполнили все необходимые подготовительные операции
для CFC-схемы (chart), а именно заполнили Вашу библиотеку основных
данных (master data library), Вы можете начать фактическое создание
CFC-схемы (chart).

Основные этапы при создании CFC-схемы (chart)
В принципе есть три основных этапа при создании CFC-схемы:

• создание "пустой" CFC-схемы в иерархической системе установки
(plant hierarchy)

• вставка отдельных блоков в CFC-схему

• подключение входов (inputs) и выходов (outputs) блоков и назначение
им значений (параметров)

CFC-схемы (charts) в иерархической системе установки
Программа-мастер (wizard) "New Project" уже создала CFC-схему (chart) в
иерархической системе Вашей установки (plant hierarchy). Она хранится в
папке "ADDIT". Данная схема пока не содержит никаких блоков – Вы
вставите их с помощью CFC-редактора.

Для проекта "color_gs" Вам потребуются и другие схемы (charts), которые
Вы вставите в иерархическую систему установки и затем отредактируете
в CFC-редакторе.

Важно, чтобы Вы назначили понятные (говорящие сами за себя) имена
всем схемам (charts) проекта "color_gs", чтобы структура проекта была
ясной и понятной.

4.3.2 Схемы (charts), необходимые для проекта 'color_gs'

 Схемы (charts), необходимые для проекта 'color_gs':

• CFC_SETP – присвоение заданных значений;

• CFC_FC111 – управление дозировкой материалов и скоростью;

• CFC_LI111 – управление и моделирование уровней сигналов;

• CFC_NP111 – управление мотором;

• CFC_NK111 ... CFC_NK114 – управление вентилями.

Каждая схема имеет техническое назначение. Для полного понимания
функционирования разрабатываемой в начальном курсе установки Вам
необходимо разобраться в назначении отдельных схем (charts) и мы
сейчас дадим краткое пояснение к каждой схеме (chart).
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Несколько деталей по созданию CFC-схемы (chart)
Вы будете создавать схемы CFC_SETP, CFC_FC111 и CFC_LI111
самостоятельно. В PCS 7 Вам будут предоставлены схемы CFC_NP111 и
CFC_NK11x в форме типов тэгов процесса (process tag type). Это покажет
Вам огромное преимущество использования типов тэгов процесса
(process tag types), которые раньше Вы просто вставили в Вашу
библиотеку основных данных (master data library).

Примечание

В проекте "color_gs" имена схем (charts) назначаются в соответствии с
наименованием соответствующих папок иерархической системы и,
следовательно, одновременно в соответствии с наименованием
соответствующих тэгов процесса (process tag). В результате, обеспечивается
уникальная идентификация объектов.

4.3.3 Техническое назначение схемы 'CFC_SETP'

Схема предназначена для контроля оператора за процессом дозировки
материалов с операторской станции OS. Необходимы следующие
установки:

• Блок PARA_DOS_RM1_QTY определяет скорость (dosing speed).

• Блок PARA_DOS_RM1_VOL определяет объем порции (dosing
volume).

• Блок PARA_DOS_RM1_SEL определяет реактор назначения.

4.3.4 Техническое назначение схемы 'CFC_FC111'

Схема предназначена для управления оператора процессом дозировки и
скоростью материалов:
• Блок "CH_AI" обеспечивает текущее значение объема (dosed volume)

на выходе "V" и передает это измеренное значение на вход "PV_IN"
(process value - переменная процесса) блока "DOSE block".

• Блок "INT_P" используется для моделирования значения объема
порции (dosed volume).

• Скорость компонента (dosing speed) определяется скоростью потока с
помощью блока "CTRL_PID".

• Блок "CTRL_PID" получает значение уставки (setpoints) посредством
системы пошагового управления (step control) блока
"PARA_DOS_RM1_VOL".

• Управляющая переменная для вентиля (valve) - выходной сигнал на
выходе "LMN" и подается непосредственно на блок "CTRL_PID" на
вход "LMNR_IN" при отсутствии обратной связи с процессом.

• Блок "CH_AO" выдает управляющую переменную на вентиль.
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4.3.5 Техническое назначение схемы 'CFC_LI111'

 Схема предназначена для контроля и моделирования уровня
заполнения:

• С помощью блока "CH_AI" считывается уровень заполнения
резервуара сырьевыми материалами и выдается текущее значение на
выход "V".

• В установках по умолчанию данный выход подсоединен ко входу "U"
блока "MEAS_MON".

• Блок "INT_P" используется для моделирования уровня заполнения
резервуара.

4.3.6 Техническое назначение схемы 'CFC_NP111'

 Схема "CFC_NP111" предназначена для управления насосом:

• Блок "CH_DI" выдает сигнал о состоянии насоса (Включен [on] или
выключен [off]) на выход "Q".

• Данный сигнал подается на вход "FB_ON" (Обратная связь включена:
ON) блока MOTOR, в котором сигнал проверяется.

• Оператор или контролер более высокого ранга контролирует блок
"MOTOR".

• Блок "CH_DO" получает команду управления с выхода "QSTART"
блока "MOTOR" и выдает ее на насос.

4.3.7 Техническое назначение схемы 'CFC_NK11x'

 Схемы предназначены для управления вентилями:

• Блок "CH_DI" выдает сигнал обратной связи в зависимости от
состояния вентиля (открыт или закрыт) в блок "VALVE".

• Блок "VALVE" управляет вентилем в соответствии с установками,
получаемыми от внешнего контроллера или от оператора. Команда
управления проходит от выхода "QCONTROL" посредством выходного
привода (блок "CH_DO") к вентилю.

• Блок "VALVE" может направлять сообщения об отказе на
операторскую станцию.

4.3.7.1 Переименование CFC-схем (charts) в PH

Готовы начать ?
• Проект "color_gs" открыт в утилите SIMATIC Manager

• Активирован вид "представление установки" (Plant view)



Создание CFC-схем

Process Control System PCS 7
Getting Started - Part 1
A5E00164244-01 4-15

Выполните действия, указанные ниже ...
Папка ADDIT уже содержит CFC-схему (chart), созданную автоматически
программой-мастером для создания проектов (wizard). Эту схему
необходимо переименовать.

1. Выберите следующую папку в иерархической системе ("дерево
каталогов"): "color_gs_MP/color_gs_Prj/Plant1/RMT1/FC111/ADDIT".

2. Выберите объект "CFC(1)" в правом окне.

3. Выберите опции меню:  
Edit -> Object Properties (Правка -> Свойства объекта).
Откроется диалоговое окно "Properties CFC chart" ("Свойства CFC-
схемы").

4. Введите имя "CFC_SETP" в окне "Name" (Имя).
В реальных проектах имя схемы (chart) в данном случае уже должно
соответствовать системе обозначений, принимаемой пользователем
для тэгов процесса (process tags).

5. Щелкните кнопкой манипулятора "мышь" на кнопке  "OK" для ввода
Ваших установок.
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4.3.7.2 Как вставлять новые CFC-схемы (charts) в PH

Вам необходимо самостоятельно вставить следующие пустые схемы
(charts):

• "CFC_FC111"

• "CFC_LI111"

Готовы начать ?

• Проект "color_gs" открыт с помощью утилиты SIMATIC Manager

• Активирован вид "представление установки" (Plant view)

Выполните действия, указанные ниже ...

1. Выберите следующую папку в иерархической системе ("дерево
каталогов"):
"color_gs_MP/color_gs_Prj/Plant1/RMT1/FC111".

2. Выберите опции меню:  
Insert -> Technological Objects -> 2 CFC (Вставка -> Технические
объекты -> 2 CFC). (Вставка -> Технические объекты -> 2 CFC).
CFC-схема (chart) с именем "CFC(1)" CFC-схема (chart) будет
вставлена. При вставке новых схем PCS 7 назначает имена по
умолчанию в виде символьного имени "CFC" с последующим
порядковым номером и активирует режим ввода для следующего
нового имени.

3. Введите имя: "CFC_FC111".

4. Выберите следующую папку в иерархической системе ("дерево
каталогов"):   "color_gs_MP/ color_gs_Prj/ Plant1/ RMT1/ LI111".

5. Выберите опции меню:  
Insert -> Technological Objects -> 2 CFC (Вставка -> Технические
объекты -> 2 CFC).
CFC-схема (chart) "CFC(1)" будет вставлена.

6. Введите имя: "CFC_LI111"
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4.3.7.3 Как вставить тип тэгов процесса 'MOTOR' (Process Tag
Type)

Вы уже вставили тип тэгов процесса (process tag type) "MOTOR" в Вашу
библиотеку основных данных (master data library). Теперь Вам необходимо
только вставить этот тип тэгов процесса (process tag type) в Ваш проект
"color_gs" в иерархической системе установки.

Готовы начать ?

• Мультипроект "color_gs" открыт посредством утилиты SIMATIC
Manager

• Активирован вид "представление установки" (Plant view)

Выполните действия, указанные ниже ...

1. Выберите следующий пункт в иерархической структуре:
"color_gs_MP/ color_gs_Lib/Templates/MOTORS".
В правом окне отображены типы тэгов процесса (process tag types),
которые Вы вставили в Вашу библиотеку основных данных (master
data library).

2. Выберите схему (chart) "MOTOR" и затем опции меню: 
Edit -> Copy (Правка -> Копировать).

3. Выберите следующую папку в иерархической системе ("дерево
каталогов"): 
"color_gs_MP/ color_gs_Prj/Plant1/RMT1/NP111" 
и затем выберите опции меню:   
Edit -> Paste (Правка -> Вставить).
Теперь схема (chart) "MOTOR" вставлена в папку иерархической
структуры и выделена как выбранный объект.

4. Выберите опции меню:  
Edit -> Object Properties (Правка -> Свойства объекта).
Теперь диалоговое окно "Properties CFC-схема (chart)" открыто.

5. Замените имя, принятое по умолчанию "MOTOR", на "CFC_NP111" в
окне в окне "Name" ("Имя").

6. Щелкните кнопкой манипулятора "мышь" на кнопке  "OK" для ввода
Ваших установок.
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4.4 Текущее состояние Вашего проекта...

Для того, чтобы создать свои CFC-схемы (charts), Вы выполнили
следующие задачи:

• Вставили все необходимые блоки и типы тэгов процесса (process tag
types) в библиотеку основных данных (master data library).

• Библиотеки, которые Вам не потребуются для проекта "color_gs",
скрыты, так что видимой является только библиотека основных
данных (master data library) "color_gs_Lib".

• Переименованы и вставлены в иерархическую систему установки (HP)
новые CFC-схемы (charts).

• Тип тэгов процесса (process tag type) "MOTOR" также вставлен в
иерархическую систему установки (HP).
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4.5 Работа с CFC-редактором

4.5.1 Введение в CFC-редактор

Работа по редактированию CFC-схемы (charts), такая как вставка блоков
(blocks) и задание значений для параметров блоков, выполняется в CFC-
редакторе. Как только Вы открываете какую-либо CFC-схему (chart),
открывается CFC-редактор. При этом CFC-редактор всегда открывается в
том виде (представлении), в котором он был закрыт после того, как Вы
поработали с ним в последнем сеансе.

При обычных (normal) установках CFC-редактора его интерфейс выглядит
следующим образом:

• Слева в окне редактора Вы видите отображение схемы (chart). Если
Вы открываете пустую CFC-схему (chart), то здесь Вы увидите просто
пустое поле. В это поле Вы можете вставлять блоки (blocks) в
соответствии с требованиями описанного процесса. В заключение в
работе с редактором производится задание значений параметров и
подключение блоков.

• С правой стороны в окне редактора Вы увидите каталог блоков,
библиотек и схем (charts).

Результаты всех работ, которые Вы выполняли в CFC-редакторе,
сохраняются автоматически системой PCS 7.

За более подробной информацией по CFC-редактору обращайтесь к
контекстной справочной системе: Help on CFC (Справка по CFC) и к
руководству SIMATIC CFC for S7, Continuous Function Chart (SIMATIC CFC
для S7, последовательные функциональные схемы).

4.5.2 Схема (Chart) в CFC-редакторе

Каждая CFC-схема (chart) может содержать до 26 разделов (partitions)
схемы. При первом открытии (при создании) схемы (chart) она содержит
только один раздел (partition) схемы. Для проекта "color_gs" требуется
только один раздел схемы (chart). Каждый раздел (partition) схемы
собственно состоит из 6 листов (sheets).

Вы можете выбрать различное представление, используя кнопки в панели
инструментов:

•      Одиночный лист (sheet)

•      Общий вид с 6 листами (sheets)

На панели инструментов видно, какой лист, какой раздел схемы (chart) в
настоящее время отображается редактором.



Создание CFC-схем

Process Control System PCS 7
Getting Started - Part 1

4-20 A5E00164244-01

Переключение из режима "Общий вид" в режим "Одиночный лист"
Вы можете переключаться из режима "Общий вид" в режим "Одиночный
лист" двойным щелчком на требуемом листе.

Назначение отдельных листов в режиме "Общий вид" производится так:

1

2

3

5

4

6

За подробной информацией обращайтесь к контекстной справочной
системе: Help on CFC (Справка по CFC) и SIMATIC CFC for S7, Continuous
Function Chart (SIMATIC CFC для S7, последовательные функциональные
схемы).

4.5.3 Каталог (Catalog) в CFC-редакторе

Если каталог еще не открыт, используйте опции меню: View -> Catalog
(Вид -> Каталог).  В каталоге Вы увидите четыре вкладки:
• Blocks  (Блоки): здесь Вы найдете блоки, отсортированные по

семействам. Для проекта "color_gs" эта вкладка не потребуется.
• Charts (Схемы): здесь Вы найдете все схемы, которые Вы создали в

иерархической системе установки, например, CFC_FC111, CFC_LI111.
Схема (chart), которая в текущий момент открыта и отображается в
CFC-редакторе, индицируется значком открытой папки.

• Libraries (Библиотеки): здесь Вы обычно можете найти все библиотеки
из PCS 7 вместе с Вашей библиотекой основных данных (master data
library).
В проекте "color_gs" Вы уже сделали неиспользуемые библиотеки
невидимыми с помощью функции "Hide" ("Скрыть"). Это значит, что Вы
увидите только библиотеку "color_gs_Lib".

• Unplaced blocks (Неразмещенные блоки): здесь Вы найдете блоки,
которые не отображаются в CFC-схеме (chart). При работе с проектом
"color_gs" данная вкладка не отображается, так как в Вашем проекте
нет неразмещенных блоков (unplaced blocks).

За подробной информацией обращайтесь к контекстной справочной
системе: Help on CFC (Справка по CFC) и SIMATIC CFC for S7, Continuous
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Function Chart (SIMATIC CFC для S7, последовательные функциональные
схемы).

4.5.4 Общий обзор этапов при конфигурировании CFC-схем
(charts)

Когда Вы создаете CFC-схемы (charts), следуйте представленным ниже
шагам, точно придерживаясь указанного порядка:

• Откройте схему (chart).

• Вставьте блоки (blocks) в требуемой последовательности выполнения.

Внимание
Порядок, в котором вставляются блоки в CFC-схему (chart), точно
соответствует порядку, в котором эти блоки будут обрабатываться в
программе. В данном курсе о требуемом порядке следования блоков Вам
будет сообщено. В реальном проекте Вы должны сами определить порядок
обработки блоков, исходя из процесса, и вставлять блоки в CFC-схему в
точном соответствии с этим порядком.

• Задайте параметры блока

- Переименуйте блоки

- Установите значения входных/выходных параметров

• Подключите блоки

Примечание
Для получения справки о блоке, например, о функциях входов (inputs) блока,
выберите соответствующий блок в библиотеке и затем нажмите клавишу F1.

Шаг "вставка блоков", конечно, пропускается для типов тэгов процесса
(process tag types). Для этих объектов Вам необходимо только назначить
значения параметров и подключить их.

4.5.4.1 Как открыть CFC-схему (chart) 'CFC_SETP'

Для того, чтобы поместить блоки в Вашу CFC-схему, Вы должны ее
открыть.

Готовы начать ?
• Мультипроект "color_gs" открыт посредством утилиты SIMATIC

Manager

• Активирован вид "представление установки" (Plant view)
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Выполните действия, указанные ниже ...

1. Выберите следующую папку в иерархической системе ("дерево
каталогов"): 
"color_gs_MP/color_gs_Prj/Plant1/RMT1/FC111/ADDIT".

2. Выберите объект "CFC_SETP" в правом окне и затем выберите опции
меню:  
Edit -> Open Object (Правка -> Открыть объект).
CFC-редактор открыт.

Теперь Вы можете редактировать открытую схему.

4.5.5 Задание значений параметров для блоков CFC-схемы
(charts)

Каждый блок имеет множество параметров (I/Os), которые отображаются
в таблице в диалоговом окне свойств (Properties). Для быстрого
нахождения входных/выходных параметров (I/O) в этом диалоговом окне,
Вы можете щелкнуть кнопкой манипулятора "мышь" на заголовке столбца
таблицы и отсортировать его содержимое в возрастающем или
убывающем порядке.

Входные/выходные параметры (I/O) блока могут быть как видимыми, так и
невидимыми: Вы можете увидеть "невидимые параметры" (invisible
parameters) в окне свойств (properties) блока, но не в отображении CFC-
схемы (chart). Вы можете определять, какие входные/выходные
параметры (I/O) в CFC-схеме (chart) будут видимы (visible), а какие -
невидимы (invisible). Вы можете определять это в окне свойств (properties)
блока в столбце "Not Displayed" ("Не отображается"), используя элемент
управления "check box" для соответствующего I/O-параметра в CFC-схеме
(chart). Данная функция помогает сделать CFC-схему (chart) более легко
читаемой. В проекте "color_gs" мы будем использовать установки по
умолчанию.

4.5.5.1 Как вставить блоки в схему 'CFC_SETP'

Готовы начать ?

• CFC-схема (chart) "CFC_SETP" открыта в CFC-редакторе.
Путь доступа: "color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111/ ADDIT"

• Каталог открыт
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Выполните действия, указанные ниже ...

1. Переключитесь на вкладку "Libraries" ("Библиотеки") в каталоге.
Здесь Вы увидите библиотеку "color_gs_Lib".

2. Откройте следующую папку в иерархической системе ("дерево
каталогов"):    "color_gs_Lib/S7 Program(1)\Blocks".

3. Перетащите блок "OP_A_LIM – FB46" из каталога в Вашу CFC-схему
(chart).
Этот блок используется для задания объема (порции) сырья (dosing
volume).

4. При вставке нижеуказанных блоков в CFC-схему (chart) используйте
такую же процедуру, как для блока "OP_A_LIM – FB46".

- OP_A_LIM – FB46: задание скорости сырьевых материалов (dosing
speed).

- OP_D – FB48: указание на реактор, в который должно
перекачиваться сырье.

5. Разместить блоки в CFC-схеме (chart) как указано ниже:

OP_D

OP_A_LIM

OP_A_LIM

Примечание
Если блок после вставки отображается голубым или светло-серым, и если не
отображаются входные/выходные параметры (I/O), это означает, что блок
перекрывается с нижележащим блоком или выходит за край листа (sheet). В
этом случае Вы должны переместить блок с помощью манипулятора "мышь"
так, чтобы установить блок на свободное место в листе (sheet).
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4.5.5.2 Как задать значения параметров для блоков схемы
'CFC_SETP'

Готовы начать ?
• CFC-схема (chart) "CFC_SETP" открыта в CFC-редакторе. Путь

доступа:  "color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111/ ADDIT".

• Все блоки вставлены.

Выполните действия, указанные ниже ...
1. Выберите блок "OP_A_LIM" и выберите опции меню:  

Edit -> Object Properties  (Правка -> Свойства объекта).
Диалоговое окно "Properties – Block" и  вкладка "General" ("Общие")
активизирована.

2. Введите имя: "PARA_DOS_RM1_QTY" в окне "Name" ("Имя").
Опция "Operator C and M possible.. ("Оператор С и М допустим ..") в
элементе управления "check box" по умолчанию активна.

3. Выберите вкладку "Inputs/Outputs" ("Входы/Выходы"). Здесь Вы
можете назначить значения для всех входных/выходных параметров
(I/O) блока. В столбце "Name" ("Имя") указаны имена всех параметров.
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4. Поместите указатель манипулятора "мышь" в столбце "Value"
("Значение") в строке с полем "U" и замените значение, указанное по
умолчанию, значением "50".

5. Щелкните кнопкой манипулятора "мышь" на кнопке  "OK" для ввода
Ваших установок. Имя "PARA_DOS_RM1_QTY" отображается в
заголовке блока в CFC-схеме (chart). Когда Вы будете создавать
графические представления процесса (process pictures), Вы будете
соединять входные/выходные параметры блоков CFC-схемы (charts) с
объектами графического представления процесса (process pictures).
Имена тэгов (tags) формируются из иерархической системы установки,
имени CFC-схемы (chart) и имени блока. Вы найдете имя
"PARA_DOS_RM1_QTY" в составе имени тэга (tag). 

Значения входных/выходных параметров (I/O) теперь
введены.
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6. Теперь измените имена и параметры для других блоков в
соответствии с таблицей (см. ниже). Следуйте процедуре пунктов с
п. 1 по п. 5.
Некоторые из входных/выходных параметров (I/O) не видны в
отображении CFC-схемы (chart).

 Блок  Имя в проекте  I/O-
параметр  Описание  Значение

OP_A_LIM PARA_DOS_RM1_VOL U* Заданная величина объема
(порции - dosing) сырья

1000

U_HL Граничное значение, заданное
для параметра U

10000

OP_D PARA_DOS_RM1_SEL IO* Сырье подается в реактор 1 OFF

   * невидимы (invisible) в CFC-редакторе.

4.5.5.3 Как вставить блоки в схему 'CFC_FC111'

Готовы начать ?

• CFC-схема (chart) "CFC_FC111" открыта в CFC-редакторе. Путь
доступа:  "color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111".

• Каталог открыт, показана вкладка "Libraries" ("Библиотеки").

Выполните действия, указанные ниже ...

1. Вставьте следующие блоки методом перетаскивания:

- CH_AI – FC275:   обработка сигнала от аналогового входа

- INT_P – FB40: моделирование дозированного объема сырья (порции -
dosing volume)

- DOSE – FB63:   дозированный объем сырья (порция)

- MUL_R – FC63: перемножение входных значений и передача на выход

- CTRL_PID – FB61: уровень заполнения для визуализации в режиме
"процесса"

- CH_AO – FC276:   обработка сигнала аналогового выхода
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2. Расположите блоки в CFC-схеме (chart), как показано ниже:

CTRL_PID

MUL_R

CH_AI

INT_P DOSE

CH_AO

4.5.5.4 Как задать значения параметров для блоков схемы
'CFC_FC111'

Готовы начать ?
• CFC-схема (chart) "CFC_FC111" открыта в CFC-редакторе. Путь

доступа:  "color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111"

• Все блоки вставлены

Выполните действия, указанные ниже ...
1. Откройте диалоговое окно "Object Properties" ("Свойства объекта") на

вкладке "Inputs/Outputs" ("Входы/Выходы") для каждого блока.

2. Введите параметры для всех блоков в соответствии со следующей
таблицей:

Примечание
Обязательно используйте точку в качестве десятичного разделителя.

В некоторых полях система PCS 7 представляет значения по умолчанию в
полях с открывающимся списком; значение Вы можете выбрать из списка.
Такие поля активизируются автоматически при помещении на них указателя
манипулятора "мышь".
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 Блок  Имя в проекте  I/O-параметр  Описание  Значение

CH_AI INPUT_U SIM_ON* Смоделированное значение
активизировано

 1

MODE Диапазон измерения 4 ... 20 мA  16#0203

VHRANGE Верхний диапазон измерения  100 **

SUBS_ON Подстановка значения: вкл.  1

INT_P INT_P V_HL Верхний предел суммарного
количества 10000 литров

 10000

DOSE DOSE SP_HLM* Верхний предел для заданного
значения объема порции

 10000

MO_PVHR* Верхний предел для переменной
процесса объема порции

 10000

SPEXON_L Активация подключения для
внутр./внешн. переключателя

 1

SPEXT_ON Значение по умолчанию для
внутр./внешн. переключателя

 1

MUL_R MUL_R IN2 Параметры для выборочной
настройки скорости потока

 1 **

CTRL_PID CTRL_PID LIOP_MAN_SEL Активация переключателя
режима: автоматический/ручной

 1

LIOP_INT_SEL Активация подключения для
внутр./внешн. переключателя

 1

SPEXON_L Подключение контроллера к
внешнему заданному значению
(external setpoint)

 1

GAIN Установка усиления контроллера
на значение 0.5

 0.5

CH_AO OUTPUT_LMN не
используется

— —

  * невидимы (invisible) в CFC-редакторе.

  ** значение, принимаемое по умолчанию

3. После того, как Вы задали значения для всех входных/выходных
параметров (I/O), щелкните на кнопке "OK" для ввода Ваших
установок.
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4.5.5.5 Как вставить блоки в схему 'CFC_LI111'

Теперь Вам необходимо поработать со схемой "CFC_LI111". Здесь
процедура в точности такая же, как и для "CFC_FC111".

Готовы начать ?

• CFC-схема (chart) "CFC_LI111" открыта в CFC-редакторе. Путь
доступа: "color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ LI111"

• Каталог открыт

Выполните действия, указанные ниже ...

Вставьте следующие блоки методом перетаскивания с помощью
манипулятора "мышь", расположите блоки в CFC-схеме (chart), как
показано ниже на рисунке:

• CH_AI – FC275: - данная функция считывает переменную процесса
(process value) из входного модуля и преобразует ее для дальнейшей
обработки

• INT_P – FB40: - данный блок используется для моделирования уровня
сырья в резервуаре 1

• MEAS_MON – FB65: - уровень заполнения для визуализации в режиме
"процесса"

MEAS_MON

INT_P

CH_AI
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4.5.5.6 Как задать значения параметров для блоков схемы
'CFC_LI111'

Готовы начать ?
• CFC-схема (chart) "CFC_LI111" открыта в CFC-редакторе. Путь

доступа:  "color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ LI111"

• Все блоки вставлены

Выполните действия, указанные ниже ...
1. Откройте диалоговое окно "Object Properties" ("Свойства объекта"), на

вкладке "Inputs/Outputs" ("Входы/Выходы") для каждого блока.

2. Введите параметры для всех блоков в соответствии со следующей
таблицей:

 Блок  Имя в проекте  I/O-параметр  Описание  Значение

CH_AI INPUT_U MODE Диапазон измерения 4 ... 20 мA  16#0203

VHRANGE Верхний диапазон измерения  100 **

SIM_ON Смоделированное значение
активизировано

 1

SIM_V Уровень сырья в резервуаре 78%  78

SUBS_ON Подстановка значения: вкл.  1

SUBS_V Значение подстановки для SIM_V  78

INT_P INT_P U
Подстановка смоделированного
значения для уровня сырья в
резервуаре

 -0.4

MEAS_MON LIA U_WH Верхний предел для включения
сигнала предупреждения = 90 m3  90

U_WL Нижний предел для включения
сигнала предупреждения = 7 m3  7

U_AH Верхний предел для включения
сигнала тревоги = 98 m3  98

U_AL Нижний предел для включения
сигнала тревоги = 5 m3  5

MO_PVHR* Верхний предел для переменной
процесса (process value) в
контейнере = 100 m3

 100

 *    невидимы (invisible) в CFC-редакторе.

 **  значение, принимаемое по умолчанию
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3. После того, как Вы задали значения для всех входных/выходных
параметров (I/O), щелкните на кнопке "OK" для ввода Ваших
установок.

4.5.5.7 Как задать значения параметров для блоков схемы
'CFC_NP111'

Вы уже вставили схему (chart) CFC_NP111 как тип тэгов процесса (process
tag type). В этой схеме Вам необходимо настроить значения параметров,
принимаемые по умолчанию для Вашего проекта "color_gs".

Примечание
Вам не нужно изменять (настраивать) имена отдельных блоков при
использовании типов тэгов процесса (process tag types).

1. Откройте диалоговое окно "Object Properties" ("Свойства объекта") на
вкладке "Inputs/Outputs" ("Входы/Выходы") для каждого блока.

2. Введите параметры для всех блоков в соответствии со следующей
таблицей:

 Блок  Имя в проекте  I/O-параметр  Описание  Значение

CH_DI FB_RUN SIM_ON Смоделированное значение
активизировано

 1

SUBS_ON Подстановка значения: вкл.  1

MOTOR MOTOR MONITOR Выключение режима
мониторинга

Monitoring =Off

AUT_ON_OP* Активация автоматического
режима

Mode = AUTO

   * невидимы (invisible) в CFC-редакторе.

3. Щелкните кнопкой манипулятора "мышь" на кнопке  "OK" для ввода
Ваших установок.

4.5.6 Подключение блоков в CFC-схеме (charts)

Теперь необходимо выполнить необходимые подключения в схеме
(charts) между входами и выходами (outputs/inputs). Вы можете выполнить
соединение блоков с помощью манипулятора "мышь" в окне CFC-
редактора. Щелкните кнопкой манипулятора "мышь" на выходе (output)
блока, а затем - на входе (input), к которому Вы хотите подключить данный
выход. После щелчка на входе (input) соединение отображается как
линия. CFC-редактор трассирует линии связи автоматически, выбирая
оптимальные пути. Положение линий не оказывает никакого влияния на
функции соединений.
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Внимание
Всегда соединяйте выход (output) блока со входом (input) другого блока – и
никогда не делайте наоборот.

Примечание
Если Вы сделали неправильное соединение, то:

Щелкните на линии неправильного соединения и выберите опции меню:
Edit -> Delete (Правка -> Удалить).

Особые свойства схем "CFC_SETP", "CFC_NP111" и "CFC_NK11x"
Схема CFC_SETP не требует никаких подключений, так как эта схема
(chart) используется только для задания значений (уставок - setpoints) и
для хранения команд оператора.

В схемах CFC_NP111 и CFC_NK11x не нужно выполнять соединений, так
как  для этих схем Вы использовали типы тэгов процесса (process tag
types) и все соединения уже выполнены.

4.5.6.1 Подключение блоков в схеме 'CFC_FC111'

Готовы начать ?
• Схема "CFC_FC111" открыта в CFC-редакторе.

• Все блоки вставлены.

Теперь выполните подключения…
1. Щелкните на выходе (output) "V" блока "INPUT_U".

2. Теперь щелкните на входе (input) "U" блока "INT_P".
CFC-редактор автоматически создаст линии связи, соответствующие
соединению.

3. Выполняйте такую же процедуру для всех остальных блоков в
соответствии с таблицей, представленной ниже:
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 Block (Блок)  Output (Выход)  Block (Блок)  Input (Вход)

erl.: INPUT_U V INT_P U

INT_P V DOSE PV_IN

MUL_R OUT CTRL_PID PV_IN

CTRL_PID LMN OUTPUT_LMN U

CTRL_PID LMN MUL_R IN1

CTRL_PID LMN CTRL_PID LMNR_IN

При этом появляется схема (chart), как показано ниже:
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4.5.6.2 Подключение блоков в схеме 'CFC_LI111'

Готовы начать ?
• Схема "CFC_LI111" открыта в CFC-редакторе.

• Все блоки вставлены

Теперь выполните подключения…
Выполняйте процедуру подключения для блоков в соответствии с
таблицей:

 Block (Блок)  Output (Выход)  Block (Блок)  Input (Вход)

INPUT_U V INT_P VTRACK

INT_P V LIA U

При этом появляется схема (chart), как показано ниже:

Закройте CFC-редактор.



Создание CFC-схем

Process Control System PCS 7
Getting Started - Part 1
A5E00164244-01 4-35

4.6 CFC-схемы (charts) в "представлении объектов
процесса" (Process Object View)

4.6.1 Использование "представления объектов процесса" для
управления вентилями

Вы можете спросить, почему мы до сих пор не работали со схемами
(charts) CFC_NK111 ... CFC_NK114. Вы просто вставили тип тэгов
процесса (process tag type) "VALVE" в Вашу библиотеку основных данных
(master data library) и создали четыре папки в иерархической системе
установки.

Теперь мы познакомим Вас с чрезвычайно удобной функцией для
управления почти одинаковыми схемами (charts) в PCS 7: "представление
объектов процесса" (process object view). Это значит, что Вам не нужно
будет открывать каждую отдельную схему (chart) в CFC-редакторе и
назначать значения параметров, вместо этого Вы сможете быстро
изменить значения в таблице.

Необходимо выполнить следующие приготовления:

• Определите входные/выходные параметры (I/O) в типе тэгов процесса
(process tag type) в "представлении объектов процесса" (process object
view): чтобы не загромождать схему, некоторые входные/выходные
параметры (I/O) не отображены в этом представлении. Для этого Вы
должны сначала определить, какие входные/выходные параметры
(I/O) Вы хотите сделать видимыми. Вы определяете это один раз в
типе тэгов процесса (process tag type) в библиотеке основных данных
(master data library).

• Вставьте тип тэгов процесса (process tag type) в отдельные папки
иерархической системы (hierarchy folders) и переименуйте их – Вы
скопируете тип тэгов процесса (process tag type) из библиотеки
основных данных (master data library) во все папки иерархической
системы (hierarchy folders), в которых требуется управление
вентилями (valve control).

• Задайте значения параметров в "представлении объектов процесса"
(process object view) – Вы теперь познакомитесь с огромным
преимуществом, которое дает использование вида "представление
объектов процесса" (process object view): Вы можете быстро
отредактировать параметры посредством таблицы.

4.6.1.1 Определение входных/выходных параметров (I/O) в
"представлении объектов процесса" (process object view)

Готовы начать ?
• Проект "color_gs" открыт посредством утилиты SIMATIC Manager

• Активирован вид "представление установки" (Plant view)



Создание CFC-схем

Process Control System PCS 7
Getting Started - Part 1

4-36 A5E00164244-01

Выполните действия, указанные ниже ...

1. Выберите следующую папку в иерархической системе ("дерево
каталогов"): "color_gs_Lib/Templates/Valves".

2. Выберите CFC-схему (chart) "VALVE" в правом окне.

3. Выберите опции меню:  
Options -> Process Objects -> Select I/Os  (Опции -> Объекты
процесса -> Выбрать входные/выходные параметры (I/Os)).
Теперь открыто диалоговое окно "Select I/Os" ("Выбор
входных/выходных параметров").

4. Щелкните кнопкой манипулятора "мышь" на заголовке столбца
"Parameter" ("Параметр").
Все активированные входные/выходные параметры (I/O) теперь
отображены в верхних строках столбца "Parameter" ("Параметр").

5. Деактивируйте опции посредством элемента управления "check boxes"
для этих входных/выходных параметров (I/O).

6. Активируйте опции посредством элемента управления "check boxes"
для следующих входных/выходных параметров (I/O):

 Block (Блок)
 I/O

(входной/выходной
параметр)

VALVE START_SS

VALVE MONITOR

VALVE AUT_ON_OP

Примечание

Щелкните кнопкой манипулятора "мышь" на заголовке столбца "Input/Output"
("Входные/выход") для того, чтобы отсортировать входные/выходные
параметры (I/O) по возрастанию или по убыванию и тем самым облегчить
нахождение требуемых параметров.
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7. Щелкните кнопкой манипулятора "мышь" на кнопке  "Apply"
("Применить") для ввода Ваших установок.

8. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
Диалоговое окно "Select I/Os" ("Выбор входных/выходных
параметров") закрывается.

4.6.1.2 Вставка "типа тэгов процесса" (Process Tag Type) 'VALVE'

Готовы начать ?
• Мультипроект "color_gs" открыт посредством утилиты SIMATIC

Manager

• Активирован вид "представление установки" (Plant view)
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Выполните действия, указанные ниже ...

Выполняйте в точности такую же процедуру, как для типа тэгов процесса
(process tag type) "MOTOR":

1. Выберите тип тэгов процесса (process tag type) "VALVE" в папке:
"color_gs_MP/ color_gs_Lib/Templates/VALVES".

2. Вставьте тип тэгов процесса (process tag type) "VALVE" в следующие
папки, используя опции меню:
Edit -> Copy (Правка -> Копировать) и Edit -> Paste (Правка ->
Вставить):

- color_gs_MP/color_gs_Prj/Plant1/RMT1/NK111

- color_gs_MP/color_gs_Prj/Plant1/RMT1/NK112

- color_gs_MP/color_gs_Prj/Plant1/RMT1/NK113

- color_gs_MP/color_gs_Prj/Plant1/RMT1/NK114

3. В окне сообщения "The object 'valve' already exists. Do you want to
overwrite it?" ("Объект 'valve' уже существует. Вы хотите переписать
его?") щелкните кнопкой манипулятора "мышь" на кнопке "No" ("Нет").

4. Переименуйте вставленные типы тэгов процесса (process tag types) в
соответствии со следующей таблицей:

 Папка иерархической
структуры

 (Hierarchy Folder)
 Переименовать в:

../RMT1/NK111 CFC_NK111

../RMT1/NK112 CFC_NK112

../RMT1/NK113 CFC_NK113

../RMT1/NK114 CFC_NK114

Подробную информацию по этому вопросу Вы можете найти в разделах:

"Создание CFC-схем (charts) – CFC-схемы (charts) в PH – Как вставить тип
тэгов процесса (process tag type) "MOTOR".
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4.6.1.3 Как задать значения параметров для блоков схем
'CFC_NK11x'

Готовы начать ?
• Мультипроект "color_gs" открыт посредством утилиты SIMATIC

Manager.

• Активировано "представление объектов процесса" (process object
view).

Выполните действия, указанные ниже ...
1. Выберите следующую папку в иерархической системе ("дерево

каталогов"):
"color_gs_MP/ color_gs_Prj/ Plant1/RMT1".

2. Выберите вкладку "Parameter" ("Параметр").
Данные обновляются.

3. Выберите пункт "Block" ("Блок") из окна с открывающимся списком
"Filter by column" ("Фильтрация по столбцам").
Это активирует окно "Display" ("Отобразить").

4. Введите имя блока в окно "Display" ("Отобразить"): "VALVE".
Таблица обновится, и Вы увидите блок "Valve" ("Вентиль") для всех
четырех CFC-схем (charts). Для каждой схемы (chart) Вы можете
видеть три входных/выходных параметра (I/O), которые были
специально сделаны видимыми для "представления объектов
процесса" (process object view).

Примечание
Если имя CFC-схемы (chart) не полностью отображено в столбце, то
поставьте курсор между столбцами "Chart" ("Схема") и "Comment"
("Комментарий") и дважды щелкните кнопкой манипулятора "мышь". Это
приведет к автоматическому изменению ширины столбцов по длине
содержащихся в них пунктов.

5. В столбце "Block Comment" ("Комментарий блока") для схемы
"CFC_NK111" введите имя: "Stop_valve1" и нажмите кнопку "Enter".
При этом обновится комментарий блока для всех входных/выходных
параметров схемы.

6. Выполните те же действия для комментариев блоков в других CFC-
схемах (charts):

 CFC-схема (chart)  Block comment  (Комментарий блока)

CFC_NK112 stop_valve2

CFC_NK113 stop_valve3

CFC_NK114 stop_valve4
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7. Перейдите на столбец "Value" ("Значение") и введите данные в
соответствии с таблицей, указанной ниже:

Примечание
В зависимости от размера Вашего монитора Вам, может быть, не удается
при работе с таблицей все время видеть столбец "Chart" ("Схема"), что
делает затруднительным назначение отдельных входных/выходных
параметров (I/O) для схем (chart).

В "представлении объектов процесса" (process object view) Вы можете
использовать следующие опции:

1. Установите курсор на маленький прямоугольник слева в начале
горизонтальной линии прокрутки и щелкните кнопкой манипулятора
"мышь".
Это действие сделает видимым вертикальный маркер в таблице.

2. Удерживая нажатой кнопку "мыши", перетащите этот вертикальный
маркер в положение между столбцами "Hierarchy" ("Иерархия") и "I/O"
("I/O-параметры").

3. Отпустите кнопку "мыши". Это действие позволит разделить окно таблицы
надвое, и Вы сможете перемещаться в правой половине таблицы с
помощью горизонтальной линии прокрутки, в то время, как в левой части
таблицы будут отображены имена схем (chart).
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- Поставьте указатель манипулятора "мышь" в требуемом поле.
Это превратит его в поле с открывшимся списком.

- Выберите требуемый пункт из этого списка.

 CFC-схема
(chart)

 I/O-
 параметр  Описание  Значение

CFC_NK111 START_SS Выберите состояние вентиля, принятое по
умолчанию (open-открыт/closed-закрыт)

 0

MONITOR Блокировка (Disable) мониторинга обратной
связи с процессом для примера.

Monitoring=off
(мониторинг=выкл. )

AUT_ON_OP Переключение вентиля в автоматический
режим

Mode=Auto
(режим=автоматич.)

CFC_NK112 START_SS Выберите состояние вентиля, принятое по
умолчанию (open-открыт/closed-закрыт)  0

MONITOR Блокировка (Disable) мониторинга обратной
связи с процессом для примера.

Monitoring=off
(мониторинг=выкл. )

AUT_ON_OP Переключение вентиля в автоматический
режим

Mode=Auto
(режим=автоматич.)

CFC_NK113 START_SS Выберите состояние вентиля, принятое по
умолчанию (open-открыт/closed-закрыт)  1

MONITOR Блокировка (Disable) мониторинга обратной
связи с процессом для примера.

Monitoring=off
(мониторинг=выкл. )

AUT_ON_OP Переключение вентиля в автоматический
режим

Mode=Auto
(режим=автоматич.)

CFC_NK114 START_SS Выберите состояние вентиля, принятое по
умолчанию (open-открыт/closed-закрыт)  1

MONITOR Блокировка (Disable) мониторинга обратной
связи с процессом для примера.

Monitoring=off
(мониторинг=выкл. )

AUT_ON_OP Переключение вентиля в автоматический
режим

Mode=Auto
(режим=автоматич.)
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4.6.1.4 Создание значка (Icon) типа блока (Type of Block)

Теперь Вы должны провести подготовку для создания графического
представления процесса (process pictures). Благодаря определенным
автоматическим функциям Вы уже на данном этапе можете сделать свои
установки.

Готовы начать ?

• Мультипроект "color_gs" открыт посредством утилиты SIMATIC
Manager

• Активировано "представление объектов процесса" (process object
view)

Выполните действия, указанные ниже ...

1. Выберите следующую папку в иерархической системе ("дерево
каталогов"):
"color_gs_MP/ color_gs_Prj/ Plant1/RMT1".

2. Выберите вкладку "Picture Objects" ("Графические объекты").
Данные обновляются. Первоначально это обновление может занимать
несколько минут.

3. Выберите пункт "Block" ("Блок") из окна с открывающимся списком
"Filter by column" ("Фильтрация по столбцам").
Это активирует окно "Display" ("Отобразить").

4. Введите имя блока в окно "Display" ("Отобразить"): "VALVE".
Таблица обновится, и Вы увидите блок "Valve" ("Вентиль") для всех
четырех CFC-схем (charts).

5. Введите значение "2" в столбец "Block Icon" ("Значок блока") для
следующих схем:

- "CFC_NK113"

- "CFC_NK114"

6. Нажмите клавишу "Enter".
Это определит то, что значки блоков (icon) будут выравниваться
горизонтально при использовании в графическом представлении
процесса (process picture).
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7. Закройте вид "представление объектов процесса" (process object
view).
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4.7 Текущее состояние Вашего проекта...

Во время конфигурирования CFC-схем Вы выполнили следующие задачи:

• Вы вставили блоки (blocks) с помощью CFC-редактора, назначили
значения параметров блоков и подключили входы/выходы блоков.

• Вы использовали "представление объектов процесса" (process object
view) для назначения значений параметров блоков одинаковым типам
тэгов процесса (process tag types)...
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5  Создание SFC-схем (SFC-chart)

5.1 Общий обзор SFC-схем (SFC charts)

Что такое SFC?
SFC (Sequential Function Chart - последовательная функциональная
схема) - это система последовательного управления (sequential control
system), состоящая из фрагментов, для обеспечения пошагового
выполнения программы с передачей управления от одного состояния к
другому в зависимости от выполнения определенных условий. При
использовании системы последовательного управления (sequential control
system) базовые функции автоматизации (basic automation functions),
например, CFC-схемы (CFC charts) выполняются на основе изменений
состояния и могут обрабатываться выборочно. Вы можете создавать SFC-
схемы (SFC charts) с помощью SFC-редактора (SFC Editor).
Когда Вы создаете проект "color_gs" с использованием программы-
помощника (wizard), система PCS 7 автоматически создает SFC-схему
(chart). Эта схема первоначально, конечно, является пустой, и Вы должны
сконфигурировать схему (chart) с помощью SFC-редактора (SFC Editor)
для проекта "color_gs".

5.2 Работа с SFC-редактором (SFC Editor)

5.2.1 Введение в SFC-редактор (SFC Editor)

Как только Вы открываете SFC-схему (SFC chart), открывается SFC-
редактор (SFC Editor). При этом редактор всегда открывается в таком
представлении, в котором он был закрыт при последнем сеансе работы с
ним.
SFC-редактор (SFC Editor), так же как и CFC-редактор (CFC Editor),
обеспечивает пользователя графическим пользовательским
интерфейсом, с помощью которого удобно создавать системы
последовательного управления (sequential control systems).
Система последовательного управления (sequential control system)
первоначально состоит из двух базовых элементов: "шага" ("step") и
"перехода" ("transition").
• Переход (transition) - это условие, управляющее выполнением шага

(step). Переходы в SFC-схеме представляются малыми
прямоугольниками.

• Шаг (step) - это экземпляр управления (control instance) для обработки
заданных действий (actions) в программируемом контроллере. Шаг
выполняется до тех пор, пока условие следующего перехода не будет
удовлетворено. Шаги (steps) в SFC-схеме представляются большими
прямоугольниками.
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Когда Вы откроете новую SFC-схему (SFC chart) в SFC-редакторе (SFC
Editor), Вы увидите два шага (step) и один переход (transition):
• Шаг (step) "START"
• Переход (transition 1)
• Шаг (step) "END"
Система последовательного управления (sequential control system)
выполняется с теми значениями параметров, которые Вы назначите для
блоков (blocks) в CFC-схеме (chart).

5.2.2 Основные функции SFC-редактора (SFC Editor)

В этом разделе мы познакомим Вас с основными функциями SFC-
редактора (SFC Editor), которые Вам потребуются для конфигурирования
SFC-схем (SFC charts) в Вашем проекте "color_gs".

При постройке Вашей системы последовательного управления (sequential
control system) Вы будете использовать панель элементов SFC-редактора
(SFC Editor). Кнопки этой панели имеют следующие значения:

•      "Activate Selection" ("Включить функцию выбора") – если нажата
данная кнопка, Вы можете выбирать отдельные объекты SFC-схемы
(SFC chart), например, шаги (steps) и переходы (transitions).
Выбранный шаг (step) или выбранный переход (transition) выделяется
голубым цветом.

•      "Insert Step + Transition" ("Вставить шаг + переход") – если
нажата данная кнопка, указатель манипулятора "мышь" принимает
вид маленького креста и круга с линиями крест-накрест. Как только Вы
передвините крест в точку на схеме (chart), в которую Вы хотите
ввести шаг (step) или переход (transition), кружок станет значком для
функции "Step with Transition" ("Шаг с переходом"). Одновременно
зеленая линия покажет, где будут вставлены шаг (step) и переход
(transition).

•  "Insert Alternative Sequence" ("Вставить альтернативную
последовательность") – если нажата данная кнопка, Вы можете
вставить альтернативную последовательность. 
Альтернативные последовательности (alternative sequence) - это такие
последовательности, в которых в зависимости от выполнения
определенных условий выполняется та или иная их ветвь.

Никакие другие кнопки в проекте "color_gs" не используются.

Более подробную информацию по SFC-редактору (SFC Editor) Вы можете
получить в контекстной справочной системе Help on SFC (Справка по
SFC) и в руководстве  SIMATIC SFC for S7, Sequential Function Chart
(SIMATIC SFC для S7, Последовательные функциональные схемы).
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5.2.3 Свойства шагов (steps) и переходов (transitions)

Для того, чтобы редактировать имена (names) и значения (values) шагов
(steps) и переходов (transitions), необходимо открыть диалоговое окно
"Properties" ("Свойства"). Вам нет необходимости открывать это
диалоговое окно для каждого шага (step) и каждого перехода (transition),
Вы можете переходить к следующему переходу или к следующему шагу
или к переходам (transitions) и шагам (steps) альтернативной
последовательности (alternative sequence) в этом диалоговом окне.

Для этого используются следующие кнопки - "кнопки навигации":

•     "Стрелка вниз" – с помощью этой кнопки Вы можете
переместиться к следующему переходу (transition) или шагу (step).

•     "Стрелка вверх" – с помощью этой кнопки Вы можете
переместиться к предыдущему переходу (transition) или шагу (step).

•     "Стрелка вправо"  и    "Стрелка влево"  - с помощью этих
кнопок Вы можете переместиться к смежному переходу (transition) или
шагу (step).

Данное диалоговое окно имеет четыре разные вкладки. Эти вкладки будут
кратко рассмотрены ниже.

Вкладки в диалоговом окне "Properties" ("Свойства") для шага (step):
• General (Общие) – на этой вкладке Вы можете задать общие

установки, такие, например, как название шага (step name).

• Initialization (Инициализация) – на этой вкладке Вы можете задать
действия (action), которые Вы определите в качестве однократной
первоначальной процедуры, выполняемой сразу после запуска шага
(step).

• Processing (Обработка) – на этой вкладке Вы можете задать действия
(action), которые Вы определите для циклического выполнения до тех
пор, пока не будет выполнено условие для следующего перехода
(transition).

• Termination (Завершение) – на этой вкладке Вы можете задать
действия (action), которые Вы определите в качестве однократной
процедуры, завершающей выполнение шага (step).

Вкладки в диалоговом окне "Properties" ("Свойства") для перехода
(transition):

• General (Общие) – на этой вкладке Вы можете задать общие
установки, такие, например, как название перехода (transition).  

• Condition (Условия) – на данной вкладке Вы задаете условия, которые
определяют, когда управление будет передано следующему шагу
(step) в системе последовательного управления (sequential control
system).



5  Создание SFC-схем

Process Control System PCS 7
Getting Started - Part 1

5-4 A5E00164244-01

5.2.4 Общий обзор процедуры конфигурирования шагов (steps) в
SFC-схемах (SFC charts)

Для создания SFC-схем (SFC charts) Вы должны выполнить следующие
действия:

• Переместить SFC-схему;

• Переименовать SFC-схему;

• Открыть SFC-схему;

• Определить технологическую структуру системы последовательного
управления (sequential control system);

• Задать имена для шагов (steps);

• Задать имена для переходов (transitions);

• Назначить значения параметров для шагов (steps);

• Назначить значения параметров для переходов (transitions).

5.2.4.1 Перемещение SFC-схем

SFC-схема "SFC(1)", созданная с помощью программы-помощника
(wizard) "New Project" PCS 7 при создании проекта "color_gs", хранится в
папке "ADDIT" иерархической системы. Так как схемы (charts) должны
храниться в соответствии с их назначением в иерархической системе
установки (plant hierarchy), Вам необходимо переместить SFC-схему (SFC
chart), созданную автоматически с помощью программы-помощника
(wizard) в соответствующую папку иерархической системы (hierarchy
folder).

Готовы начать?
• Мультипроект "color_gs" открыт в SIMATIC Manager

• Активирован режим "представление установки" (Plant view)

Выполните следующие действия ...
1. Выберите следующую папку в структуре "дерево каталогов":

"color_gs_MP/color_gs_Prj/Plant1/RMT1/FC111/ADDIT".

2. Выберите объект "SFC(1)" в правом окне.

3. Выберите опции меню: Edit -> Cut  (Правка ->  Вырезать).

4. Выберите следующую папку в структуре "дерево каталогов":
"color_gs_MP/color_gs_Prj/Plant1/RMT1".

5. Выберите опции меню: Edit -> Paste  (Правка ->  Вставить).
SFC-схема (SFC chart) вставлена в выбранную папку.
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5.2.4.2 Переименование SFC-схемы (SFC chart)

Для обеспечения консистентности системы имен, а также для лучшего
понимания и удобочитаемости схем Вам необходимо изменить имена,
принятые по умолчанию.

Готовы начать?
• Мультипроект "color_gs" открыт в SIMATIC Manager

• Активирован режим "представление установки" (Plant view)

Выполните следующие действия ...
1. Выберите следующую папку в структуре "дерево каталогов":

"color_gs_MP/ color_gs_Prj/ Plant1/ RMT1".

2. Выберите объект "SFC(1)" в правом окне.

3. Выберите опции меню: 
Edit -> Object Properties  (Правка -> Свойства объекта).
Теперь открыто диалоговое окно "Properties SFC chart" ("Свойства
SFC-схемы").

4. Замените имя "SFC(1)", принятое по умолчанию, на имя "SFC_RMT1"
в окне "Name" ("Имя").

5. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
Ваших установок.

5.2.4.3 Открытие SFC-схемы "SFC_RMT1"

Готовы начать?
• Мультипроект "color_gs" открыт в SIMATIC Manager

• Активирован режим "представление установки" (Plant view)

Выполните следующие действия ...
1. Выберите следующую папку в структуре "дерево каталогов":

"color_gs_MP/ color_gs_Prj/ Plant1/ RMT1".

2. Выберите объект "SFC_RMT1" в правом окне и затем выберите опции
меню: 
Edit -> Open Object  (Правка -> Открыть объект).
SFC-редактор открыт. В схеме уже присутствуют шаги: начальный -
"Start" и завершающий - "End" и переход (transition 1).

5.2.5 Технологическая структура системы последовательного
управления (sequential control system)

В данном разделе представлен общий обзор технологической
последовательности отдельных шагов и переходов в системе
последовательного управления (sequential control system) проекта
"color_gs".
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 Имя шага (step)  Функция

START Defaults (по умолчанию):

• Переключение дозирующего контроллера (dosing
controller) в "ручной" (manual) режим

• Переключение дозирующего контроллера (dosing
controller) во "внешний" (external) режим

• Перевод блоков в "автоматический" (automatic) режим
• Режим остановки заполнения

DOSE_REA1

DOSE_REA2

Query (запрос):

• Какой из реакторов - Reactor 1 или Reactor 2 - нужно
заполнять?

INIT_LINE1

INIT_LINE2

Controllers (контроллеры):

• Открытие вентилей соответствующей линии
• Включение насоса
• Установление контроллера в режим внешней уставки

("External Setpoint")

INIT_1_OK

INIT_2_OK

Query (запрос):

• Насос включен?
• Контроллер установлен в режим внешней уставки

("External Setpoint")?

INIT_DOSE Controllers (контроллеры):

• Задание уставки скорости заполнения (dosing speed)
• Переключение дозирующего контроллера (dosing

controller) в "автоматический" (automatic) режим
• Задание уставки объема заполнения (dosing volume)
• Запуск процесса заполнения (Start dosing)

INIT_OK Query (запрос):

• Заполнение начато (Dosing started) ?
• Требуемый объем заполнения (Dosing volume)

(фактическое значение уставки) < 500 литров?

SLOW_DOWN Controller (контроллер):

• Уменьшение скорости заполнения (dosing rate) перед
достижением требуемого объема (dosing volume)
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 Имя шага (step)  Функция

END_DOSE Query (запрос):

• Требуемый объем заполнения достигнут (и подача
сырья в связи с этим завершена) (Dosing ended) ?

CLOSE_LINE Controllers (контроллеры):

• Закрытие всех вентилей
• Выключение насоса
• Переключение дозирующего контроллера (dosing

controller) в "ручной" (manual) режим
• Установка скорости заполнения (dosing speed), равной

нулю
• Остановка заполнения (dosing)

CLOSE_OK Query (запрос):

• Насос выключен?

END Reset (сброс)

• Переключение дозирующего контроллера (dosing
controller) во "внутренний" (internal) режим

• Закрытие вентилей
• Выключение мотора

Оператор установки может запускать, управлять и контролировать эту
схему (chart) с операторской станции.
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5.2.5.1 Создание системы последовательного управления
(sequential control system) в SFC-схеме (SFC chart)

Когда Вы вставляете шаги (steps) и переходы (transitions), SFC-редактор
(SFC Editor) назначает для них следующие по порядку номера. В
дальнейшем Вы можете заменить эти номера понятными, логически
связанными с установкой именами.

Готовы начать?
• Схема "SFC_RMT1" открыта в SFC-редакторе (SFC Editor)

• Отображены шаги (steps) "START", "END" и переход (transition) 1

Выполните следующие действия ...
1. Если панель элементов с кнопками для вставки шагов (steps) и

переходов (transitions) не видна, то выберите опции меню: 
View -> Element bar  (Вид -> Панель элементов).

При этом отобразится панель элементов.

2. Щелкните кнопкой манипулятора "мышь" на кнопке 
"Insert Step + Transition" ("Вставка шага + перехода").

Указатель мыши заменится на маленький крест и кружок с
прямоугольником.

3. Поместите указатель мыши под переходом (transition 1), чтобы
появилась зеленая линия, и вставьте объект щелкнув кнопкой
манипулятора "мышь".
Шаг (step) "3" and переход (transition) "2" вставлены в схему (chart).

4. Щелкните кнопкой манипулятора "мышь" на кнопке "Insert Alternative
Sequence" ("Вставка альтернативной последовательности").

5. Поместите указатель мыши под шагом (step) "START", чтобы
появилась зеленая линия, и вставьте объект щелкнув кнопкой
манипулятора "мышь".
Альтернативная последовательность (alternative sequence)
вставляется прямо под шагом "START": переходы (transitions) "3" и "4"
вставляются параллельно друг другу, а ниже их вставляется шаг (step)
"4".

6. Щелкните кнопкой манипулятора "мышь" на кнопке 
"Insert Step + Transition"  ("Вставка шага + перехода")

7. Поместите указатель мыши в следующих позициях и вставьте шаг
(step) + переход (transition):

- Ниже перехода "3":  шаг (step) 5 и переход (transition) 5

- Ниже перехода "4":  шаг (step) 6 и переход (transition) 6

- Ниже перехода "2":  шаг (step) 7 и переход (transition) 7
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Ваша SFC-схема (SFC chart) должна теперь выглядеть так:

 

5.2.5.2 Переименование шагов (steps)

Готовы начать?
• SFC-схема "SFC_RMT1" открыта в SFC-редакторе (SFC Editor)

• Все шаги (steps) и переходы (transitions) вставлены
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Выполните действия, указанные ниже...

1. Щелкните кнопкой манипулятора "мышь" на кнопке "Select"
("Выбрать").

2. Выберите шаг (step) "5".

3. Выберите опции меню: 
Edit -> Object Properties  (Правка -> Свойства объекта).
При этом откроется диалоговое окно "Object Properties" ("Свойства
объекта"), в котором вкладка "General" ("Общие") будет активна.
Значение по умолчанию в окне "Name" ("Имя") указано как "5".

4. Замените значение "5" в окне "Name" ("Имя") на имя "INIT_LINE1".

5. Щелкните кнопкой манипулятора "мышь" на кнопке "Apply"
("Применить").
Новое имя при этом будет сохранено.

6. Щелкните кнопкой манипулятора "мышь" на кнопке "стрелка вниз".
При этом Вы перейдете к шагу (step) "4".
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7. Замените принятое по умолчанию имя "4" в окне "Name" ("Имя") на
имя "INIT_DOSE" и щелкните кнопкой манипулятора "мышь" на кнопке
"Apply" ("Применить").

8. Перейдите к следующим шагам, используя кнопки управления со
стрелками, и замените принятые по умолчанию имена, в соответствии
с назначениями, указанными в ниже представленной таблице. Каждый
раз после ввода нового имени завершайте операцию щелчком на
кнопке "Apply" ("Применить").

 Имя, принятое по
умолчанию  Новое имя

 5 INIT_LINE1

 4 INIT_DOSE

 3 SLOW_DOWN

 7 CLOSE_LINE

 6 INIT_LINE2

9. Щелкните кнопкой манипулятора "мышь" на кнопке "Close" ("Закрыть").
При этом сделанные Вами установки будут сохранены и диалоговое
окно "Object Properties" ("Свойства объекта") будет закрыто. Вновь
назначенные имена шагов (steps) будут отображены в SFC-схеме
(SFC chart) (см. рисунок ниже).
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5.2.5.3 Переименование переходов (transitions)

Таким же способом, каким Вы выполняли переименование шагов (steps),
Вы должны теперь заменить имена, принятые по умолчанию, для всех
переходов (transitions), на имена, понятные и логически связанные с
установкой. Здесь процедура должна быть в точности такая же, какая
применялась для переименования имен шагов (steps).
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Готовы начать?

• SFC-схема "SFC_RMT1"  открыта в SFC-редакторе (SFC Editor)

Выполните следующие действия ...

1. Дважды щелкните кнопкой манипулятора "мышь" на переходе
(transition) "3".  При этом откроется диалоговое окно "Object Properties"
("Свойства объекта"), в котором вкладка "General" ("Общие") будет
активна.

2. Замените имя, принятое по умолчанию, в окне "Name" ("Имя") на имя,
логически связанное с установкой. Также замените и остальные
имена, принятые по умолчанию.
Логически связанные с установкой имена показаны в ниже
представленной таблице.

3. Каждый раз после ввода нового имени завершайте операцию
щелчком на кнопке "Apply" ("Применить").

4. Переходя от одного перехода (transition) к следующему, используйте
кнопки управления со стрелками.

 Имя, принятое по
умолчанию  Новое имя

 3 DOSE_REA1

 5 INIT_1_OK

 1 INIT_OK

 2 END_DOSE

 7 CLOSE_OK

 4 DOSE_REA2

 6 INIT_2_OK

5. Щелкните кнопкой манипулятора "мышь" на кнопке "Close" ("Закрыть").
При этом сделанные Вами установки будут сохранены и диалоговое
окно "Object Properties" ("Свойства объекта") будет закрыто. Вновь
назначенные имена переходов (transitions) будут отображены в SFC-
схеме (SFC chart) (см. рисунок ниже).
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Ваша SFC-схема (SFC chart) должна теперь выглядеть так:
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5.3 Установка параметров

5.3.1 Задание значений для параметров шагов (steps) в SFC-
схемах   (SFC chart)

С помощью SFC-редактора Вы должны задать значения для входных
параметров блоков (block inputs) в CFC-схемах (CFC charts). Для первого
шага (step) "START" Вы задаете установки для последовательности
управления процессом дозирования сырьевых материалов (dosing
process).

Каждый шаг (step), для которого параметры и действия (action)
определены, отображается темно-серым цветом. Это значит, что Вы
можете с одного взгляда на схему определить, назначены параметры для
шага (step) или нет.

Готовы начать?

• SFC-схема "SFC_RMT1" открыта в SFC-редакторе (SFC Editor)

• Вы выполнили переименование шагов (steps) и переходов (transitions)

Выполните следующие действия ...

1. Дважды щелкните кнопкой манипулятора "мышь" на шаге (step)
"START".
При этом откроется диалоговое окно "Object Properties" ("Свойства
объекта"), в котором вкладка "General" ("Общие") будет активна.

2. Выберите вкладку "Initialization" ("Инициализация").
Эта вкладка отображает пустой список с рядами инструкций и
указателем манипулятора "мышь", установленным в первой строке
левого столбца.

3. Щелкните кнопкой манипулятора "мышь" на кнопке "Browse" ("Поиск").
После этого откроется диалоговое окно "Browse" ("Поиск"), и при этом
вкладка "CFC-схемы" ("CFC charts") будет активна. 
В данном диалоговом окне Вы можете видеть CFC-схемы (CFC charts)
проекта "color_gs" с соответствующими назначениями в
иерархической системе установки (PH), именем схемы (chart) и
комментариями в первых трех столбцах. В следующих трех столбцах
Вы можете видеть все блоки, принадлежащие схеме (chart),
выделенной в первом столбце. Как только  Вы выберете блок, в
последнем столбце отобразятся все соответствующие ему I/O-
параметры (I/Os).
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4. Выберите CFC-схему "CFC_FC111".
В смежных столбцах Вы можете теперь видеть все блоки (blocks)
схемы "CFC_FC111".

5. Выберите блок "CTRL_PID".
В столбцах справа Вы можете теперь видеть все I/O-параметры
блока.

6. Дважды щелкните кнопкой манипулятора "мышь" на входе (input)
"AUT_L".
Диалоговое окно "Browse" ("Поиск") уходит при этом на задний план и
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выбранный параметр блока (I/O) вместе с его полным
идентификатором вносится как первый операнд в строку 1.
Указатель манипулятора "мышь" автоматически устанавливается в
правый столбец строки 1.

Примечание
Если Вы не можете прочитать имена параметров блока (I/Os), то поместите
указатель манипулятора "мышь" над соответствующим полем – при этом
отобразится полное имя параметра.

7. Введите значение "0" в этом поле.
8. Щелкните кнопкой манипулятора "мышь" на кнопке "Apply"

("Применить").
Значение "0" автоматически заменится значением "FALSE" ("ЛОЖЬ").
Первое назначение для шага "Start" выполнено.

Теперь появится диалоговое окно, показанное ниже:

9. Щелкните кнопкой манипулятора "мышь" на кнопке со следующим
номером "2". Эта кнопка расположена непосредственно перед строкой
инструкции. При этом указатель манипулятора "мышь" окажется во
второй строке левого столбца.

10. Повторите выполнение пунктов с 3 по 9 для определения оставшихся
операндов для шага (step) "START". Информацию для этого Вы
найдете ниже в таблице.
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Примечание

Операнды в таблице имеют следующий формат:

[chartname\block\I/O], т.е. [имя_схемы\блок\I/O-параметр].

Иерархия установки опущена, чтобы сделать таблицу более понятной. Если
же Вы вставите следующую установку (plant) или модуль (unit) в проект
"color_gs", то Вы должны будете, конечно, указывать назначение схемы
(chart) в составе иерархии установки.

 №
п/п  Операнд 1  Операнд 2  Значение

 1 уже задано:

CFC_FC111\ CTRL_PID\ AUT_L

FALSE Ручной режим (manual mode)
контроллера

 2 CFC_FC111\CTRL_PID.SP_EXT CFC_SETP\PARA_
DOS_RM1_QTY.V

Уставка (Setpoint) для управления
потоком материала

 3 CFC_FC111\CTRL_PID.LMN_SEL FALSE Нет корректировки уставки
(No setpoint correction)

 4 CFC_FC111\DOSE.L_START FALSE Режим остановки дозирования
материала (Dosing stopped)

 5 CFC_FC111\INT_P.TRACK TRUE Интегратор (Track integrator)

 6 CFC_LI111\INT_P.TRACK TRUE Интегратор (Track integrator)

 7 CFC_NK111\VALVE.AUT_ON_OP Auto Вентиль в автоматическом режиме
(automatic mode)

 8 CFC_NK112\VALVE.AUT_ON_OP Auto Вентиль в автоматическом режиме
(automatic mode)

 9 CFC_NK113\VALVE.AUT_ON_OP Auto Вентиль в автоматическом режиме
(automatic mode)

 10 CFC_NK114\VALVE.AUT_ON_OP Auto Вентиль в автоматическом режиме
(automatic mode)

 11 CFC_NP111\MOTOR.AUT_ON_OP Auto Мотор в автоматическом режиме
(automatic mode)

 12 CFC_LI111\INT_P.HOLD FALSE Удержать выходное значение
(Hold output value)

11. Щелкните кнопкой манипулятора "мышь" на кнопке "Apply"
("Применить").

12. Щелкните кнопкой манипулятора "мышь" на кнопке со стрелкой для
перехода к другому шагу (step) и ввода операндов, в соответствии с
таблицей.

Примечание
При вводе операндов проверяйте соответствие их выбранному шагу (step)
по строке заголовка диалогового окна "Properties" ("Свойства").
Если Вы случайно закрыли диалоговое окно "Properties" ("Свойства"), то
дважды щелкните кнопкой манипулятора "мышь" на шаге (step), с которым
Вы только что работали, и диалоговое окно откроется.
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- INIT_LINE1

- INIT_LINE2

- INIT_DOSE

- SLOW_DOWN

- CLOSE_LINE

- END

5.3.1.1 Параметры для шага  'INIT_LINE1'

В следующей таблице представлены параметры для шага  "INIT_LINE1":

 № п/п  Операнд 1  Операнд 2  Значение
 1 CFC_NK111\VALVE.AUTO_OC TRUE Открыть вентиль
 2 CFC_NK112\ VALVE.AUTO_OC TRUE Открыть вентиль
 3 CFC_NK113\ VALVE.AUTO_OC TRUE Открыть вентиль
 4 CFC_NP111\MOTOR.AUTO_ON TRUE Включить мотор

5.3.1.2 Параметры для шага  'INIT_LINE2'

В следующей таблице представлены параметры для шага  "INIT_LINE2":

 № п/п  Операнд 1  Операнд 2  Значение
 1 CFC_NK111\VALVE.AUTO_OC TRUE Открыть вентиль
 2 CFC_NK112\VALVE.AUTO_OC TRUE Открыть вентиль
 3 CFC_NK114\VALVE.AUTO_OC TRUE Открыть вентиль
 4 CFC_NP111\MOTOR.AUTO_ON TRUE Включить мотор

5.3.1.3 Параметры для шага  'INIT_DOSE'

В следующей таблице представлены параметры для шага  "INIT_DOSE":

 № п/п  Операнд 1  Операнд 2  Значение
 1 CFC_FC111\CTRL_PID.SP_EXT CFC_SETP\PARA

_DOS_RM1_QTY.V
Использовать заданное
значение (setpoint) для
управления потоком сырья

 2 CFC_FC111\CTRL_PID.AUT_L TRUE Автоматический режим
контроллера

 3 CFC_FC111\DOSE.SP_EXT CFC_SETP\PARA
_DOS_RM1_VOL.V

Использовать заданное
значение (setpoint) для
объема сырья

 4 CFC_FC111\DOSE.L_START TRUE Начать дозирование
 5 CFC_FC111\INT_P.TRACK FALSE Интегратор после

корректировки уставки
(setpoint)

 6 CFC_FC111\INPUT_U.SIM_V 50.0 Моделирование:
поток 50 л/м !
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 № п/п  Операнд 1  Операнд 2  Значение
 7 CFC_FC111\INPUT_U.SUBS_V 50.0 Значение подстановки

смоделированного
значения SIM_V

 8 CFC_LI111\INT_P.TRACK FALSE Нет корректировки
интегратора

Установка времени выполнения (Run Time)
1. Перейдите на вкладку "General" ("Общие").
2. Введите значение "8s" в окно "Minimum" ("Минимальное") панели "Run

times" (Время выполнения).
3. Щелкните кнопкой манипулятора "мышь" на кнопке "Apply"

("Применить"),
PCS 7 автоматически заменит значение на "T#8s".

5.3.1.4 Параметры для шага  'SLOW_DOWN'

В следующей таблице представлены параметры для шага
"SLOW_DOWN":

 № п/п  Операнд 1  Операнд 2  Значение
 1 CFC_FC111\CTRL_PID.SP_EXT 10.0 Уменьшение значения

уставки для потока сырья
 2 CFC_FC111\INPUT_U.SIM_V 10.0 Моделирование:

поток 10 л/м !
 3 CFC_FC111\INPUT_U.SUBS_V 10.0 Значение подстановки

смоделированного
значения SIM_V

5.3.1.5 Параметры для шага  'CLOSE_LINE'

В следующей таблице представлены параметры для шага
"CLOSE_LINE":

 № п/п  Операнд 1  Операнд 2  Значение
 1 CFC_NK111\VALVE.AUTO_OC FALSE Закрыть вентиль
 2 CFC_NK112\VALVE.AUTO_OC FALSE Закрыть вентиль
 3 CFC_NK113\VALVE.AUTO_OC FALSE Закрыть вентиль
 4 CFC_NK114\VALVE.AUTO_OC FALSE Закрыть вентиль

 № п/п  Операнд 1  Операнд 2  Значение
 5 CFC_NP111\MOTOR.AUTO_ON FALSE Выключить мотор
 6 CFC_FC111\CTRL_PID.LMN_SEL TRUE Корректировка

управляющей переменной:
0   (Закрыть вентиль)

 7 CFC_FC111\CTRL_PID.SP_EXT 0.0 Использовать заданное
значение (setpoint) для
управления потоком сырья

 8 CFC_FC111\CTRL_PID.AUT_L FALSE Ручной режим контроллера
 9 CFC_FC111\DOSE.L_START FALSE Дозирование прекращено
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 № п/п  Операнд 1  Операнд 2  Значение
 10 CFC_FC111\ INPUT_U.SIM_V 0.0 Моделирование:

поток 0 л/м
 11 CFC_FC111\INPUT_U.SUBS_V 0.0 Значение подстановки

смоделированного
значения SIM_V

 12 CFC_LI111\INT_P.HOLD TRUE Интегратор

5.3.1.6 Параметры для шага  'END'

В следующей таблице представлены параметры для шага  "END":

 № п/п  Операнд 1  Операнд 2  Значение
 1 CFC_FC111\CTRL_PID.AUT_L FALSE Сброс входа (input)
 2 CFC_FC111\CTRL_PID.LMN_SEL FALSE Нет корректировки

управляющей переменной
 3 CFC_NK111\VALVE.AUTO_OC FALSE Закрыть вентиль
 4 CFC_NK112\VALVE.AUTO_OC FALSE Закрыть вентиль
 5 CFC_NK113\VALVE.AUTO_OC FALSE Закрыть вентиль
 6 CFC_NK114\VALVE.AUTO_OC FALSE Закрыть вентиль
 7 CFC_NP111\MOTOR.AUTO_ON FALSE Выключить мотор
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5.3.2 Задание значений параметров для переходов (transitions)
SFC-схемы (SFC chart)

Переход (transition) содержит условия, в соответствии с которыми система
последовательного управления (sequential control system) передает
управление от одного шага (step) к другому. В принципе, Вы назначаете
значения параметров для переходов (transitions) тем же способом, что и
для шагов (steps).

Готовы начать?

• SFC-схема "SFC_RMT1" открыта в SFC-редакторе (SFC Editor)

• Вы уже выполнили переименование шагов (steps) и переходов
(transitions)

Выполните следующие действия ...

1. Дважды щелкните кнопкой манипулятора "мышь" на переходе
(transition) "DOSE_REA1".
При этом откроется диалоговое окно "Properties" ("Свойства"), в
котором вкладка "General" ("Общие") будет активна.

2. Выберите вкладку "Condition" ("Условия").
Эта вкладка отображает пустой список с рядами инструкций и
указателем манипулятора "мышь", установленным в первой строке
левого столбца. Структура диалогового окна такая же, какую Вы
видели, когда назначали значения параметров для шагов (steps).

3. Установите все значения параметров для перехода (transition)
"DOSE_REA1". Вы найдете информацию, которая Вам потребуется
для этого, в нижеследующей таблице. Далее Вы можете видеть
общий обзор последовательности действий в качестве напоминания:

- Для ввода операнда 1 откройте диалоговое окно "Browse"
("Поиск") щелчком кнопки манипулятора "мышь" на кнопке
"Browse" ("Поиск") с последующим выбором соответствующего I/O-
параметра.

- Введите операнд 2

- Щелкните кнопкой манипулятора "мышь" на кнопке "Apply"
("Применить") для ввода сделанных Вами установок.

- Выберите новую строку

- и т.д.

4. Выберите новый переход (transition) и введите для него операнды.
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Примечания
При вводе операндов проверяйте соответствие их выбранному переходу
(transition) по строке заголовка диалогового окна "Properties" ("Свойства").

Так же как и при задании параметров для шагов (steps), операнды в таблице
имеют следующий формат:

[chartname\block\I/O], т.е. [имя_схемы\блок\I/O-параметр].
Иерархия установки опущена.

 Параметры для перехода "DOSE_REA1"

 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 1 CFC_SETP\PARA_DOS_RM1_SEL.Q0 = FALSE Сырье для реактора 1?
 2 CFC_SETP\PARA_DOS_RM1_VOL.V > 0.0 Объем порции сырья > 0 ?

Параметры для перехода "INIT_1_OK"

 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 1 CFC_NP111\MOTOR.QRUN = TRUE Мотор включен ?
 2 CFC_FC111\CTRL_PID.QSPEXTON = TRUE Контроллер установлен на

внешнюю уставку ?

Параметры для перехода "INIT_OK"

 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 1 CFC_FC111\DOSE.QSTRTDOS = TRUE Процесс дозирования

сырья начат ?
 2 CFC_FC111\DOSE.ER < 500.0 Объем порции:

Уставка – фактич. знач. <
500 л ?

Параметры для перехода "END_DOSE"

 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 1 CFC_FC111\DOSE.QEND_DOS = TRUE Процесс дозирования

сырья закончен ?

Параметры для перехода "CLOSE_OK"

 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 1 CFC_NP111\MOTOR.QRUN = FALSE Мотор выключен ?

Параметры для перехода "INIT_2_OK"

 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 1 CFC_NP111\MOTOR.QRUN = TRUE Мотор включен ?
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 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 2 CFC_FC111\CTRL_PID.QSPEXTON = TRUE Контроллер установлен на

внешнюю уставку ?

Параметры для перехода "DOSE_REA2"

 № п/п  Операнд 1  Оператор  Операнд 2  Значение
 1 CFC_SETP\PARA_DOS_RM1_SEL.Q0 = TRUE Сырье для реактора 2?
 2 CFC_SETP\PARA_DOS_RM1_VOL.V > 0.0 Объем порции сырья > 0

?

5.4 Текущее состояние Вашего проекта...

Что Вы узнали в процессе конфигурирования SFC-схем ?

• Вы работали со стандартными функциями, такими как функции
переименования и открытия объектов.

• Вы создали систему последовательного управления (sequential control
system) с помощью графических средств.

• Вы переименовали шаги (steps) и переходы (transitions) системы
последовательного управления (sequential control system) и назначили
для них параметры.
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6 Компиляция, загрузка и тестирование
схем (Charts)

6.1 Общий обзор операций компиляции, загрузки и
тестирования

В данном разделе рассказывается, как выполняется компиляция
программы, которую Вы создали с помощью CFC- и SFC-редакторов, а
также о том, как она загружается в CPU и выполняется в режиме
тестирования. Это дает возможность проверки правильности
функционирования схем (charts). Вы уже познакомились с функцией
загрузки ("Download") при загрузке конфигурации оборудования.

Теперь Вам предстоят следующие два этапа обработки схем (charts):

• сначала Вы должны скомпилировать (compile) и загрузить (download)
блоки и схемы (charts): для этого используйте функцию "Compile and
Download Objects" ("Компилировать и загрузить объекты");

• затем Вы должны протестировать (test) программу: Вы можете
выполнить тестирование как в SFC-редакторе, так и в CFC-редакторе.

6.1.1 Компиляция и загрузка CFC- и SFC-схем

Вы уже создали CFC- и SFC-схемы для Вашего проекта "color_gs". Эти
схемы (charts) должны быть скомпилированы, чтобы они могли быть
выполнены в CPU. После этого они, очевидно, должны быть загружены в
CPU. Процессы компиляции и загрузки инициируются в общем
диалоговом окне и выполняются последовательно.

Готовы начать?
• Зеленый индикатор "RUN" ("Выполнение") на панели CP светится.

• CPU находится в режиме STOP.

• Проект "color_gs" открыт в SIMATIC Manager.

• Активирован режим "представление компонентов" (component view).
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Выполните следующие действия ...
1. Выберите следующую папку в структуре "дерево каталогов":

"color_gs_MP/ color_gs_Prj/ SIMATIC 400".

2. Выберите опции меню: PLC -> Compile and Download Objects
(PLC -> Компиляция и загрузка объектов).
Откроется диалоговое окно "Compile and Download Objects"
("Компиляция и загрузка объектов").

3. Щелкните кнопкой манипулятора "мышь" на значке "+", чтобы увидеть
содержимое пункта.
Теперь проект "color_gs" отображается в виде структуры, в основном
схожей со структурой проекта в "представлении компонентов"
(component view) в SIMATIC Manager.
Теперь Вы видите объекты и соответствующую информацию о их
статусе (status) или о рабочем состоянии (operating state):

 Объект  Статус (Status)  Рабочее состояние
CPU 417-4 – STOP (режим "Стоп")
Ресурсы (Sources) – –
Блоки (Blocks) – –
Схемы (Charts) изменены (modified) –

4. Установите опции для "Charts" ("Схемы"): щелкните кнопкой
манипулятора "мышь" на элементах управления "check box" "Compile"
("Компилировать") и "Download" ("Загрузить").

5. Выберите "Charts" ("Схемы") и щелкните кнопкой манипулятора "мышь"
на кнопке "Edit..." ("Правка...") в панели "Settings for
Compilation/Download" ("Установки для компиляции/загрузки").
Откроется диалоговое окно "Compile program / download to target
system"  ("Компиляция программы / загрузка в целевую систему") с
активной вкладкой "Compile Charts as Program" ("Компилировать схемы
как программу"). Элемент управления "check box" "Entire program"
("Программа в целом") активизируется автоматически при первом
запуске процесса компиляции и загрузки.

Примечание
Если при тестировании Вы нашли ошибки в Вашей программе, то Вы будете
вносить исправления в Ваши CFC или SFC-схемы для устранения проблемы.
Когда после этого Вы повторно будете выполнять компиляцию и загрузку,
убедитесь, что Вы активизировали элемент управления "check box" "Changes
only" ("Только изменения"). Это позволит Вам сэкономить значительное
количество времени. Выбор этой опции, кроме того, дает Вам возможность
выполнить эти операции без перевода CPU в режим STOP ("СТОП").
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6. Убедитесь, что Вы активизировали следующие элементы управления
"check box":
- "Update sampling time" ("Обновлять время дискретизации") – если

данная опция установлена до компиляции, то система будет
проверять OB, в которых установлены блоки с соответствующим
входным параметром (input) "SAMPLE_T". Значение в "SAMPLE_T"
соответствует времени дискретизации для блока в секундах.

- "Delete empty run-time groups" ("Удалять пустые группы
выполнения") – если данная опция установлена, то пустые группы
выполнения, которые могут существовать в S7-программе будут
удаляться.
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7. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
Ваших установок. При этом диалоговое окно закроется и откроется
окно сообщения "Remember that if you download later (...), the blocks in
CPU will be deleted" ("Если Вы загрузите в дальнейшем (...), блоки в
CPU будут удалены").

8. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".

9. Проверьте установки в следующих элементах управления "check box":

 Элемент управления "check box"  Значение
"Compile only" ("Только компилировать") Выключен
"Do not load if compilation error is detected"
(Не загружать при обнаружении ошибки)

Включен

10. Щелкните кнопкой манипулятора "мышь" на кнопке "Start" ("Пуск") для
запуска процессов компиляции и загрузки. При этом откроется окно
сообщения "Please make sure the settings for downloading changes are
correctly selected for all the objects to be downloaded ... Do you want to
continue?" ("Пожалуйста, убедитесь, что установки для загрузки
изменены корректно для всех загружаемых объектов...
Продолжать?").

11. Щелкните кнопкой манипулятора "мышь" на кнопке "Yes" ("Да").
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Примечание
Индикатор выполнения задания точно покажет, что именно выполняет в
данный момент PCS 7, например: 
• "Compiling and downloading object" ("Компилирование и загрузка объекта")
• "Compiling charts as program" ("Компилирование схем (charts) как

программ")

После окончания процесса компиляции открывается файл протокола,
чтобы Вы могли оценить результаты компиляции, наличие ошибок и проч.

Текущее состояние или статус (status) в строке "Charts" теперь имеет
значение "downloaded" ("загружено").

12. Щелкните кнопкой манипулятора "мышь" на кнопке "Cancel"
("Отмена").
Диалоговое окно закроется.

13. Запустите CPU.
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6.2 Тестирование программы

Тестировать программу Вы можете как с помощью SFC-редактора, так и с
помощью CFC-редактора. В режиме тестирования Вы можете видеть, как
меняются значения переменных при выполнении процесса. Используя
режим тестирования, Вы можете проверить, безошибочно ли работает
сконфигурированная Вами система последовательного управления
(sequential control system).

Режим тестирования в SFC-редакторе
Тестирование может проводиться в SFC-редакторе (SFC Editor), с
которым Вы познакомились, когда Вы создавали SFC-схему (SFC chart):
при этом диалоговое окно "Properties" ("Свойства"), которое Вы уже
видели раньше, также здесь будет играть центральную роль.

Если Вы дважды щелкните кнопкой манипулятора "мышь" на шаге (step)
или на переходе (transition) в SFC-схеме (SFC chart), то откроется
знакомое Вам диалоговое окно "Properties" ("Свойства"). Точно также, как
во время создания SFC-схемы, Вы можете использовать "кнопки
навигации" (кнопки со стрелками) для перехода от одного шага (step) или
перехода (transition) к другому. В режиме тестирования диалоговые окна
выдают также дополнительную информацию:

• В диалоговом окне "Properties" ("Свойства") для шага (step) Вы можете
видеть фактические значения слева от операнда 1 (address  1) и
заданные значения (setpoints) справа от операнда 2 (address 2).

• В диалоговом окне "Properties" ("Свойства") для перехода (transition)
текущие значения отображаются слева от операнда 1 (address  1) и
справа от операнда 2 (address 2).

Внимание
Вы можете изменять любые значения в полях для ввода. Помните, однако,
что эти значения записываются непосредственно в Ваши конфигурационные
данные и, следовательно, изменяют параметры Вашей SFC-схемы (SFC
chart).
Работая с данным начальным курсом, Вы не будете изменять никаких
значений и будете использовать диалоговое окно "Properties" ("Свойства")
просто для мониторинга значений переменных.

Режим тестирования в CFC-редакторе
Режим тестирования CFC-схем производится в CFC-редакторе. Вы будете
использовать отображение переменных процесса (process values) в
параметрах отдельных блоков для мониторинга их изменений.
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6.2.1 Как тестировать программу в SFC-редакторе

После того, как Вы скомпилировали и загрузили программу, Вы можете
выполнять программу в режиме тестирования (test mode) для проверки
корректности работы системы последовательного управления (sequential
control system) и отсутствия ошибок в программе.

Готовы начать?

• Проект "color_gs" открыт в SIMATIC Manager

• SFC-схема "SFC_RMT1" открыта в SFC-редакторе (SFC Editor)

Работа в режиме тестирования

1. Выберите опции меню: 
Debug -> Test Mode  (Отладка -> Режим тестирования).
Режим тестирования активирован.

- В строке заголовка SFC-редактора указано имя 
"SFC_RMT1 – color_gs_Prj\Plant1\RMT1 ONLINE", выделенное
цветом фона.

- В нижней части окна SFC-редактора указан статус (текущее
состояние) программы, режим (mode) и режим управления шагом
(step control mode). По умолчанию установлен ручной режим
("MANUAL"). Текущий режим управления шагом отображается в
окне с открывающимся списком и, по умолчанию, устанавливается
как "T".

- В нижней части окна SFC-редактора также расположены кнопки
для управления SFC-схемой, например, Start (Пуск), Hold (Пауза),
Resume (Продолжить).

2. Выберите опции меню: 
Debug -> Шаг (step) Control Mode -> T or C  (Отладка -> Режим
управления шагом  -> T or C).
Когда активен этот режим управления шагом дополнительная кнопка
"C" отображается рядом с переходом (transition), пока выполняется
SFC-схема:



6  Компиляция, загрузка и тестирование схем (Charts)

Process Control System PCS 7
Getting Started - Part 1

6-8 A5E00164244-01

 Если схема
(chart) …

 … то система последовательного управления
(sequential control system)
будет работать следующим образом:

не имеет
ошибок

Система последовательного управления (sequential
control system) будет выполняться в соответствии со
сконфигурированными параметрами, и Вам не нужно
использовать упомянутую выше кнопку.

содержит
ошибки

Система последовательного управления (sequential
control system) будет остановлена, если условие
перехода (transition) не выполняется. Вы можете
щелкнуть кнопкой манипулятора "мышь" на кнопке "C"
для того, чтобы передать управление следующему шагу
(step), вне зависимости от того, выполнено условие
перехода (transition) или нет.

3. Щелкните кнопкой манипулятора "мышь" на кнопке "Start" ("Пуск") для
запуска программы.
SFC-схема запускается на выполнение.

- Каждый шаг (step), который в настоящий момент выполняется,
высвечивается зеленым цветом и снабжается маленькой
стрелкой, указывающей вниз на следующий шаг (step).

- Шаги (steps), которые уже были выполнены, отображаются темно-
зеленым цветом и сопровождаются маленьким значком,
сообщающим о выполненной проверке шага.

- Переходы (transitions), которые являются активными, но условия
для которых пока еще не были выполнены, отображаются на
коричневом фоне.

Если Вы создали конфигурацию корректно, то SFC-схема будет целиком
выполнена до конца, и все шаги (steps), в конце концов, будут окрашены в
темно-зеленый цвет и будут сопровождаться маленьким значком,
сообщающим о выполненной проверке шага. В противном случае, Вам
придется щелкнуть кнопкой манипулятора "мышь" на кнопке "C" для того,
чтобы передать управление следующему шагу (step) вручную, не смотря
на то, что условие для перехода (transition) не выполнено.

4. Выберите опции меню: 
Debug -> Test Mode  (Отладка -> Режим тестирования).
При этом режим тестирования будет выключен.
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6.2.2 Как тестировать программу в CFC-редакторе

Вы можете тестировать CFC-схемы (CFC charts) в CFC-редакторе так же,
как и SFC-схемы.

Готовы начать?

• Проект "color_gs" открыт в SIMATIC Manager

• SFC-схема "SFC_RMT1" открыта в SFC-редакторе (SFC Editor), и
режим тестирования (Test mode) активизирован

• CFC-схема  "CFC_FC111" открыта в CFC-редакторе (CFC Editor)

Выполните следующие действия ...
1. Выберите опции меню: 

Debug -> Test Mode (Отладка -> Режим тестирования).
Режим тестирования (Test mode) активизирован.

2. Нажмите кнопку "CTRL" и выберите следующие блоки:

CTRL_PID

INPUT_U

DOSE

3. Выберите опции меню: Debug -> Watch On (Отладка -> Наблюдение
включить).
Все I/O-параметры указанных блоков будут отслеживаться в окне
свойств (properties) блока и будут показаны на желтом фоне.

4. Перейдите на SFC-схему "SFC_RMT1".

5. Щелкните кнопкой манипулятора "мышь" на кнопке "Start" ("Пуск") в
панели инструментов.
При этом программа будет запущена.

6. Перейдите на CFC-схему "CFC_FC111".
Вы можете наблюдать за изменением значений: например, за текущим
значением объема сырья (dosed volume) отображается на выходе
"PV_OUT" блока "DOSE".

Примечание
Поместите окна рядом, для того, чтобы в процессе тестирования наблюдать
за CFC-схемой и SFC-схемой одновременно.

7. Выберите опции меню: 
Debug -> Test Mode  (Отладка -> Режим тестирования).
При этом режим тестирования будет выключен.
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6.3 Текущее состояние проекта ...

Между тем, Вы почти закончили все работы по конфигурированию проекта
с использованием утилиты SIMATIC Manager, CFC-редактора (CFC Editor)
и SFC-редактора (SFC Editor). После компилирования и загрузки этой
конфигурации Вы можете наблюдать за выполнением программы проекта
с помощью CFC-редактора (CFC Editor) и SFC-редактора (SFC Editor).

Это позволяет Вам проверить, безошибочно ли работает
сконфигурированная Вами система последовательного управления
(sequential control system). Если Вы найдете ошибки в проекте в процессе
тестирования, то их легче исправить на данном этапе, чем после того, как
будет завершен весь проект.



Process Control System PCS 7
Getting Started - Part 1
A5E00164244-01 7-1

7 Конфигурирование операторской станции

7.1 Операторская станция в "режиме процесса"
(Process Mode)

Оператор установки имеет возможность управления и мониторинга
процесса, используя операторскую станцию в "режиме процесса" (process
mode). На дисплей операторской станции (OS) выводятся графические
изображения процесса ("process pictures" - "картинки процесса"). PLC
управляет ходом процесса, и OS считывает переменные процесса
(process values) из PLC, после чего представляет их значения графически
в виде изображения процесса (process pictures). Сигналы предупреждения
(warnings) и тревоги (alarms) также выводятся с графическими
изображениями, как только достигаются или превышаются определенные
граничные значения контролируемых параметров. Это позволяет
оператору установки определить место, в которой возникает проблема.

Вы создадите одно графическое изображение (process picture) для
Вашего проекта "color_gs", что позволит Вам визуализировать уровень
сырья в контейнере, состояние вентилей и т.д.

7.2 Конфигурирование операторской станции

Операторская станция в проекте
Когда Вы с помощью программы-помощника (wizard) "Create New Project"
создаете проект, PCS 7 автоматически создает объект - операторскую
станцию (operator station). Вы уже сконфигурировали в своем проекте
операторскую станцию, используя утилиту конфигурирования
оборудования HW Config. Однако, Вы не создавали подключение к сети
(network connection) для этой станции (OS), аналогичное коммуникациям
между программируемым контроллером и системой проектирования ES
(engineering system), которые позволяют теперь загружать данные ES в
PLC. В этом нет необходимости для проекта "color_gs", так как система
проектирования и операторская станция находятся на одном и том же
компьютере, благодаря чему операторская станция использует то же
подключение к PLC, что и ES.

Графическое изображение процесса (Process Pictures) в проекте
Программа-помощник (wizard) также автоматически создает объект -
графические изображения (process pictures) для проекта в иерархической
системе установки (plant hierarchy), и теперь Вам предстоит
сконфигурировать их в PCS 7 OS. Большие проекты обычно требуют
несколько графических изображений - для отдельных частей. Для проекта
"color_gs" Вам нужно сконфигурировать только одно графическое
изображение. Тем не менее, Вы познакомитесь со всеми базовыми
функциями, нужными для конфигурирования в PCS 7 OS. Графические
изображения имеют значок:
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7.3 Работа в SIMATIC Manager

7.3.1 Подготовка конфигурирования в SIMATIC Manager

Перед конфигурированием OS в PCS 7 Вам необходимо в SIMATIC
Manager выполнить следующее:

• Задать имена графических изображений и активировать функцию для
создания значков блоков.

• Удалить неиспользуемые графические изображения

• Создать значки блоков

• Компилировать OS

Редактирование свойств графических изображений (Picture Properties)
Программа-помощник (wizard) "Create New Project" автоматически создал
графические изображения, при этом они, так же как при создании CFC-
схем (chart), получили имена, принятые по умолчанию. Вы должны
сначала заменить эти имена, принятые по умолчанию, на подходящие
короткие и понятные имена, логически связанные с Вашим проектом.

Вы должны также активировать функцию для создания значков блоков.

Удаление неиспользуемых графических изображений
При создании проекта с помощью программы-помощника (wizard),
созданные автоматически графические изображения были помещаются в
каждую папку иерархической системы (hierarchy folder). Так как Вам
потребуется только одно графическое изображение в Вашем проекте
"color_gs", то Вы должны удалить неиспользуемые графические
изображения из иерархической системы установки PH.

Создание значков блоков
В PCS 7 Вы можете использовать замечательную функцию: "Create block
icons" ("Создание значков блоков"). Значки блоков вставляются в
графическое изображение процесса и обеспечивают оператора наиболее
важной информацией о компонентах (тэгах) процесса. Например, в значке
контроллера оператор видит значение переменной процесса (process
value - PV), значение уставки, т.е. заданного значения (setpoint - SP), а
также значение управляющей переменной (manipulated value - OUT).
Значок блока для контроллера изображается следующим образом:
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Компиляция OS
Сразу после того, как Вы завершили конфигурирование всех данных в
SIMATIC Manager, и перед запуском процесса конфигурирования данных
OS PCS 7 Вы должны запустить функцию "Compile OS" ("Компиляция
OS"). Все данные из SIMATIC Manager, такие, как переменные,
сообщения, тексты, данные конфигурации оборудования и данные
конфигурации соединений должны стать известными для станции OS.

Запуск OS
Для продолжения конфигурирования PCS 7 OS Вы должны запустить OS,
так что Вы сможете работать в WinCC Explorer.

7.3.1.1 Как редактировать свойства изображения (Picture
Properties)

При редактировании свойств изображения (picture properties), Вы должны
сделать следующие установки:

• изменить имя изображения

• включить опцию для создания значков блоков

Готовы начать?
• Мультипроект "color_gs" открыт в SIMATIC Manager

• Активирован вид "представление установки" (plant view)

Изменение имени изображения

1. Выберите следующую папку в структуре "дерево каталогов":
"color_gs_MP/ color_gs_Prj/ Plant1/ RMT1".

2. Выберите изображение "Picture(3)" в правом окне.

3. Выберите опции меню: 
Edit -> Object Properties  (Правка -> Свойства объекта).
При этом открывается диалоговое окно "Properties – WinCC Picture(3)"
("Свойства - WinCC Picture(3)") с активной вкладкой "General"
("Общие").

4. Замените имя, принятое по умолчанию, "Picture(3)" в окне "Name"
("Имя") на "RMT1"  (см. рисунок ниже).
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5. Щелкните кнопкой манипулятора "мышь" на кнопке "Apply"
("Применить") для ввода Ваших установок.

Активация опций для создания значков блока

1. Перейдите на вкладку "Block Symbols" ("Символы блоков").

2. Выделите элемент управления "check box" "Base block icons on the plant
hierarchy" ("Значки основных блоков установки").

3. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
Ваших установок.
При этом диалоговое окно закроется и новое имя изображения будет
теперь изображаться в иерархической системе установки (plant
hierarchy).
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7.3.1.2 Как удалять неиспользуемые графические изображения

Программа-помощник (wizard) PCS 7 "Create New Project" автоматически
создает графические изображения и помещает их в каждую папку
иерархической системы (hierarchy folder). В Вашем проекте "color_gs" Вам
потребуется только одно графическое изображение, так как все
требуемые данные могут быть достаточно ясно представлены в одном
изображении процесса.

Готовы начать?

• Мультипроект "color_gs" открыт в SIMATIC Manager

• Активирован вид "представление установки" (plant view)

Выполните следующие действия ...

1. Выберите папку "Plant1" в структуре "дерево каталогов".

2. Выберите графическое изображение "Picture(2)" в правом окне.

3. Нажмите клавишу "Del".
Открывается диалоговое окно "Delete" (Удалить).

4. Щелкните кнопкой манипулятора "мышь" на кнопке "Yes" (Да).
Теперь графическое изображение удалено.

5. Повторите пункты с 1 по 4 для следующих папок в иерархической
системе установки:

 Имя папки  Имя графического изображения

FC111 Picture(4)

ADDIT Picture(5)

7.3.1.3 Как создавать значки блоков

Готовы начать?
• Мультипроект "color_gs" открыт в SIMATIC Manager

• Активирован вид "представление установки" (plant view)

• Активирована опция для создания значков блоков

Более подробную информацию по данному вопросу Вы можете получить
по адресу "Конфигурирование операторской станции" – "Работа в
SIMATIC Manager" – "Как редактировать свойства изображения (Picture
Properties)" в разделе "Активация опций для создания значков блока".
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Выполните следующие действия ...

1. Выберите следующую папку в структуре "дерево каталогов":
"color_gs_MP/ color_gs_Prj/ Plant1/ RMT1".

2. Выберите опции меню: 
Options -> Plant Hierarchy -> Create/Update Block Icons… 
(Опции -> Иерархическая система установки -> Создать/Обновить
значки блоков…)
При этом откроется диалоговое окно "Create/Update Block Icons"
("Создание/Обновление значков блоков"). Изображение (picture), для
которого должен создаваться значок, "Plant1\RMT1\RMT1" можно
видеть в списке.
Значение "1" вводится в окно с открывающимся списком "Lower
hierarchy levels included" ("Включая нижние уровни иерархии").

3. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
Это инициирует создание значка блока.
При этом откроется окно сообщения, информируя Вас о том, что Вам
нужно выполнить процедуру компиляции операторской станции. "Do
you want to see the log of the function?" ("Желаете ли Вы посмотреть
протокол работы функции?")
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4. Щелкните кнопкой манипулятора "мышь" на кнопке "No" ("Нет").
При этом окно сообщения закрывается и завершается создание
значков блоков.

Фактически, Вы не увидите видимых проявлений работы рассмотренной
функции. Однако, когда Вы откроете изображение процесса проекта
"color_gs", Вы увидите созданные значки блоков.

7.3.1.4 Как компилировать OS

До того, как Вы начнете конфигурировать данные PCS 7 OS, Вы должны
сначала скомпилировать OS. При этом все данные из SIMATIC Manager,
такие, как переменные, сообщения, тексты, данные конфигурации
оборудования и данные конфигурации соединений становятся
известными для станции OS. Не путайте между собой процесс
компиляции (compiling) и процесс загрузки (downloading): при компиляции,
данные остаются в компьютере в системе проектирования ES – они
становятся просто известными PCS 7 OS, так, что Вы будете иметь к ним
доступ при конфигурировании.

Готовы начать?

• Мультипроект "color_gs" открыт в SIMATIC Manager

• Активирован вид "представление компонентов" (component view)
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Выполните следующие действия ...

1. Выберите следующий объект в структуре "дерево каталогов":
"color_gs_MP/ color_gs_Prj/ SIMATIC PC Station(1)".

2. Выберите опции меню: 
Options -> OS -> Compile… (Опции -> OS -> Компилировать…)
Первый этап в работе программы-помощника (wizard) "Compile OS"
("Компиляция OS") открыт. Ниже Вы найдете краткий общий обзор всех
этапов компиляции.

3. При выполнении первого шага щелкните кнопкой манипулятора "мышь"
на кнопке "Next" ("Далее").
Откроется окно "Which operator stations do you want to compile and with
which S7 programs?" ("Какую операторскую станцию и с какой S7-
программой Вы хотите компилировать?").
В окне "Operator stations and S7 programs" ("Операторская станция и
S7-программа") Вы увидите все операторской станции и все
программы, принадлежащие Вашему проекту. Объекты "OS(1)" и "S7
Program(1)", принадлежащие Вашему проекту, по умолчанию уже
являются активными. В окне "Network connection for OS(1)" ("Сетевое
соединение для OS(1)") Вы найдете в качестве S7-программы "S7
Program(1)" и в качестве подсети "Ethernet(1)": это соединение,
посредством которого связаны программируемый контроллер и
операторская станция, и которое Вы ранее создали для Вашего
коммуникационного процессора CP с помощью утилиты
конфигурирования оборудования HW Config.
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4. Если в данном окне изображаются несколько различных соединений,
то щелкните кнопкой манипулятора "мышь" на кнопке "Connection..."
("Соединение ..."), в появившемся диалоговом окне "Select Network
Connection" ("Выберите сетевое соединение") выберите подсеть
Ethernet, которую Вы создавали для Вашего коммуникационного
процессора CP с помощью утилиты конфигурирования оборудования
HW Config, и подтвердите свой выбор щелчком на кнопке "OK".
При этом закроется диалоговое окно и Вы вернетесь в программу-
помощник (wizard). Теперь выбранное Вами соединение изображается
в окне "Network connection for OS(1)" ("Сетевое соединение для OS(1)")
программы-помощника (wizard).

5. Щелкните кнопкой манипулятора "мышь" на кнопке "Next" ("Далее").
Теперь открывается диалоговое окно следующего шага процесса
компиляции - "Select data you want to compile and the scope of the
compilation" ("Выберите данные, которые Вы хотите скомпилировать и
область компиляции"). Указанные ниже элементы управления "check
box" активны по умолчанию, если компиляция производится в первый
раз:

 Область (панель)  Элемент управления "check box"

"Data" (Данные) • "Tags and Messages" ("Тэги и сообщения)
• "Picture Tree" ("Дерево графических изображений")

"Scope" (Диапазон) • "Entire OS" (Станция OS в целом)
• "With memory reset" ("Со сбросом памяти")

6. В области "Data" (Данные) включите опцию "SFC Visualization" (SFC
визуализация).
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7. Щелкните кнопкой манипулятора "мышь" на кнопке "Next" ("Далее").
После этого открывается диалоговое окно следующего, последнего
шага в процессе компиляции с использованием программы-помощника
(wizard) с названием "Check the selected options" ("Проверка выбранных
опций"). Данное окно представляет Вам набор сделанных Вами
установок для контроля:

8. Щелкните кнопкой манипулятора "мышь" на кнопке "Compile"
("Компиляция").
После этого начинается собственно процесс компиляции,
сопровождаемый изображением хода работы с помощью индикатора
выполнения.
После выполнения компиляции изображается окно сообщения: "The
compilation was completed without errors and warnings" ("Процесс
компиляции завершен без обнаружения ошибок и предупреждений").

9. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
Таким образом, компиляция OS выполнена.
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7.3.1.5 Как запустить PCS 7 OS

В настоящий момент Вы выполнили все необходимые приготовления
перед конфигурированием PCS 7 OS в SIMATIC Manager и теперь можете
начать процесс конфигурирования PCS 7 OS. Откройте PCS 7 OS.

Готовы начать?

• Проект "color_gs" открыт в SIMATIC Manager

• Активирован вид "представление компонентов" (component view)

Выполните указанные ниже действия:

1. Выберите следующий объект в структуре "дерево каталогов":
"color_gs_MP/ color_gs_Prj/ SIMATIC PC-Station/ WinCC Application/
OS(1)".

2. Выберите опции меню: 
Edit -> Open Object   (Правка -> Открыть объект).
При этом откроется диалоговое окно утилиты PCS 7 OS – WinCC
Explorer.
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7.4 Работа с операторской станцией PCS 7 OS

7.4.1 Структура PCS 7 OS - WinCC Explorer

Утилита WinCC Explorer обеспечивает пользователя целым рядом
редакторов, которые Вы можете использовать для конфигурирования
PCS 7 OS. Но не беспокойтесь! – для конфигурирования PCS 7 OS, нам
потребуются только некоторые из них.

Какова структура WinCC Explorer?
В принципе, структура утилиты WinCC Explorer очень похожа на структуру
Проводника из OS Windows (Explorer):

• В левой панели утилиты расположено "окно навигации" (navigation
window): здесь Вы найдете все редакторы, которые Вы можете
использовать для конфигурирования PCS 7 OS..

• В правой панели утилиты расположено окно, раскрывающее
содержимое объекта, выбранного в окне навигации.

В проекте "color_gs" мы будем работать только с графическим редактором
Graphics Designer. С помощью этой утилиты разрабатываются
графические изображения процесса (process pictures). Вам не
потребуются никакие другие редакторы при конфигурировании PCS 7 OS.

7.4.2 Функция графических изображений процесса 
(Process Pictures)

Общий обзор
Графические изображения процесса (process pictures) для оператора
представляют собой оборудование установки. Используя изображения,
оператор может вводить команды и наблюдать за состоянием объектов
установки.

Графическое изображение процесса (process picture), которое Вы будете
конфигурировать для проекта "color_gs", уже существует в SIMATIC
Manager в иерархической системе установки (plant hierarchy).

Вы будете редактировать это графическое изображение процесса
(process picture), используя редактор "Graphics Designer"; другими
словами, Вы будете вставлять требуемые статические (static) и
динамические (dynamic) объекты и соединять их.
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7.5 Общие аспекты работы с редактором Graphics
Designer

7.5.1 Введение в Graphics Designer

Пользовательский интерфейс
Редактор Graphics Designer - это редактор для PCS 7 OS.
Пользовательский интерфейс редактора Graphics Designer имеет
следующую структуру:

• В левой части окна Вы можете видеть "палитру цветов" (Color Palette),
с помощью которой Вы будете назначать цвета объектам.

• В средней части окна перед Вами располагается "поле рисунка" ("окно
файла" - "file window"), в которое Вы будете вставлять объекты для
графического изображения процесса (process picture).

• В правой части окна Вы можете видеть "палитру объектов" (Object
Palette). Это библиотека с различными стандартными объектами,
которые может предоставить Вам редактор Graphics Designer. Вы
также увидите "палитру стилей" (Style Palette) в правой части окна, с
помощью которой Вы сможете задавать формат объектов.

Библиотеки
Библиотеки редактора Graphics Designer содержат обширный  набор
готовых к использованию графических элементов, таких как трубопроводы
(piping) и вентили (valves). Вы можете изменять эти элементы или
добавлять к ним новые и затем сохранять в библиотеках Вашего
собственного проекта; при этом все элементы библиотек всегда остаются
доступными Вам.

Объекты
В редакторе Graphics Designer различают два разных типов объектов:

• Static objects – статические объекты - это в чистом виде рисованные
объекты, которые Вы можете найти в любых графических программах,
например,  линии, круги, многоугольники, статические тексты и проч.

• Dynamic objects – динамические объекты - это объекты, которые
поддерживают изменение форм благодаря связи с I/O-параметрами
блоков или переменных; другими словами, эти объекты показывают
текущие значения тэгов (tag) в установке в "режиме процесса"
("process mode"). В проекте "color_gs" Вы познакомитесь с различными
динамическими  объектами.
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7.5.1.1 Как открыть графическое изображение процесса (process
picture)

Графическое изображение процесса (process picture) редактируется в
PCS 7 OS. Для этого используется графический редактор "Graphics
Designer".

Готовы начать?
Проект "color_gs" открыт в WinCC Explorer

Выполните следующие действия ...

1. В левом окне (в окне навигации), выберите объект "Graphics Designer".
В правом окне при этом будут показаны все изображения (pictures),
принадлежащие проекту. Все заданные по умолчанию изображения
(default pictures) и изображения-шаблоны (template pictures), которые
может предоставить пользователю система PCS 7, конечно, здесь
также изображены. Эти изображения могут быть идентифицированы по
стоящему впереди значку "@".

2. Выберите в правом окне графическое изображение "RMT1.pdl".

3. Дважды щелкните кнопкой манипулятора "мышь" на кнопке "RMT1".
При этом в редакторе в Graphics Designer откроется графическое
изображение процесса (process picture).
Вы можете видеть, что данное графическое изображение процесса
(process picture) уже содержит объекты, хотя Вы сами не вводили туда
данные объекты. Это не что иное, как значки блоков (block icons),
которые Вы создали в графическом изображении процесса (process
picture) с помощью функции "Create block icons" ("Создание значков
блоков"), работая с утилитой SIMATIC Manager. Вы можете также
видеть, что среди этих значков есть значки блоков для вентилей
(valve), вставленные как горизонтально, так и вертикально. Эти
варианты вентилей определяются установкой для вида объекта
процесса на вкладке "Picture Objects" ("Объекты графического
изображения"), которую Вы выполнили при назначении параметров
для CFC-схемы (CFC charts) .
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7.5.1.2 Как открывать разные панели инструментов

По умолчанию большинство важнейших панелей инструментов, а также
палитр уже открыты, и Вам нет необходимости менять эти установки. В
случае если Вы по неосторожности закрыли панели инструментов или
палитры, Вам, все-таки, необходимо знать, что надо сделать, чтобы они
вновь стали видимыми.

Готовы начать?
Изображение открыто в редакторе Graphics Designer.

Выполните следующие действия ...
1. Выберите опции меню: 

View -> Toolbars   (Вид -> Панель инструментов).
При этом откроется диалоговое окно "Toolbars" ("Панели
инструментов"). В этом окне Вы можете видеть все панели
инструментов, которые предоставляет редактор Graphics Designer.

2. Сделайте такие же установки, как в показанном ниже снимке
диалогового окна:

3. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
Ваших установок.
При этом вновь отобразятся на экране выбранные Вами панели
инструментов и палитры объектов.

Элемент управления "check box" с заголовком "Objects" ("Объекты")
является одним из важнейших – Вы используете его, для того, чтобы
открыть палитру объектов, из которой Вы берете все статические и
динамические объекты, которые Вам требуются для создания
графического изображения процесса (process picture). Палитра объектов
содержит вкладки: "Standard" ("Стандартные") и "Controls" ("Элементы
управления"). В начальном курсе мы будем использовать только вкладку
"Standard" ("Стандартные").
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7.5.2 Объекты в редакторе Graphics Designer

Однако, перед тем, как Вы начнете фактическое конфигурирование
установки и работу в редакторе Graphics Designer, необходимо
небольшое теоретическое вступление, посвященное различным
объектам, которые Вы будете использовать при создании графического
изображения процесса (process picture) "RMT1.pdl". Среди таких объектов
есть следующие типы:

• Статические объекты  (Static objects)

• Текстовые поля  (Text fields)

• Поля I/O-параметров  (I/O fields)

Вам также необходимо определенное количество базовой информации по
соединению тэгов (interconnecting tags), т.е., по той технологии, благодаря
которой Вы создаете связи между графическим изображением процесса
(process picture) и тэгами

7.5.3 Что такое статические объекты (static objects) ?

Для визуализации установки Вам необходимо множество статических
объектов, например, для представления трубопроводов или резервуаров.
Эти объекты не изменяются во время "режима процесса" (process mode);
другими словами, они не зависят от состояний или от значений тэгов.

7.5.4 Что такое текстовые поля (text fields)?

В текстовые поля (text fields) Вы можете вводить любую информацию,
которую должен видеть оператор в графическом изображении процесса
(process picture). Вы можете, например, вставить текст для того, чтобы
пометить объекты и тем самым облегчить восприятие объектов
изображения процесса для оператора. Вы можете вводить любой текст в
эти текстовые поля (text fields) и можете располагать текстовые поля (text
fields) в любом месте.

В проекте "color_gs" Вы должны вставить текстовые поля (text fields) для
всех тэгов и пометить их.

7.5.5 Что такое поля I/O-параметров (I/O fields)?

Поля ввода/вывода (Input/output fields) используются для ввода и вывода
значений. Существуют различные типы полей I/O-параметров (I/O fields):

• Поля вывода (Pure output field)

• Поля ввода (Pure input field)

• Комбинированные поля ввода / вывода  (Combined  input  and  output
field)
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Поля I/O-параметров (I/O fields) могут иметь различные форматы данных,
такие как двоичный, десятичный, строка символов, шестнадцатеричный.

Также как для всех других объектов Вы можете также выбирать
различные форматы и выполнять различные установки для полей I/O-
параметров  (I/O fields).

В проекте "color_gs" Вы будете использовать поля I/O-параметров (I/O
fields) для управления подачей сырья для заполнения как реактора 1, так
и реактора 2.

7.5.6 Функция связи тэгов

Связь с тэгами - это главная функция в работе по созданию графических
изображений процесса (process pictures): Объекты вводятся в
графическое изображение процесса (process picture), в котором
выводится информация о переменных процесса (process values) в точках
измерения - тэгах (measuring point [tag]) во время "режима процесса"
(process mode).

Устанавливая связь с переменными, Вы создаете соединение между
объектом и реальной точкой измерения (actual measuring point). Это
позволяет операторской станции (OS) принимать или считывать данные
из PLC, чтобы затем изображать их, периодически обновляя, в
графическом изображении процесса (process picture).
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7.6 Создание графического изображения процесса
(process picture)

7.6.1 Вставка трубопроводов (Pipes) и резервуара (Tank) в
графическое изображение процесса (process picture)

Готовы начать?

• Графическое изображение процесса (process picture) "RMT1" открыто
в редакторе Graphics Designer.

• Значки блоков (Block icons) присутствуют

Сначала Вы не будете делать никаких изменений в значках блоков.
Вы должны сначала создать графическое изображение установки
(picture of the plant), используя статические объекты (static objects),
перед тем, как Вы сможете передвинуть значки в требуемые
положения.

Выполните следующие действия ...

1. Выберите опции меню: 
View -> Library  (Вид -> библиотека ).
При этом откроются библиотеки  PCS 7 OS.

2. Выберите объект:
"Global Library/PlantElements/Tanks/Tank4" 
и перетащите его в окно редактирования на поле рисунка.

Примечание
Щелкните кнопкой манипулятора "мышь" на кнопке "очки" в панели
инструментов для получения возможности предварительного просмотра
графических объектов.
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3. Теперь перетащите в окно редактирования в поле рисунка, следующие
объекты:

 Имя объекта Число  Размещение в библиотеке

Pipe horizontal
(горизонтальная труба)  2 x Global Library/PlantElements/Pipes - Smart

Objects/3D Pipe Horizontal

Pipe vertical
(вертикальная труба)  5 x Global Library/PlantElements/Pipes - Smart

Objects/3D Pipe Vertical

Angle
(колено трубы)  1 x Global Library/PlantElements/Pipes - Smart

Objects/3D Pipe Elbow 1

Angle
(колено трубы)  1 x Global Library/PlantElements/Pipes - Smart

Objects/3D Pipe Elbow 2

Angle
(колено трубы)  1 x Global Library/PlantElements/Pipes - Smart

Objects/3D Pipe Elbow 3

Angle
(колено трубы)  1 x Global Library/PlantElements/Pipes - Smart

Objects/3D Pipe Elbow 4

Control valve
(регулирующий вентиль)  1 x Global Library/Symbols/Valves/30

Tanks representing the
reactors
(резервуары, в качестве
реакторов)

 2 x Global Library/Siemens HMI Symbol
Library/Tanks/Tank1

4. Закройте библиотеку.

5. Выберите объект и настройте его размеры и положение для получения
схемы, показанной на следующем ниже рисунке:

- Вы можете перемещать объект следующим образом: поместите
указатель манипулятора "мышь" на выбранный объект, затем,
нажав и удерживая нажатой левую кнопку манипулятора "мышь",
перетащите объект в требуемую позицию.

- Вы можете уменьшить или увеличить размеры объекта
следующим образом: поместите указатель манипулятора "мышь"
на узел управления выбранного объекта, затем, нажав и
удерживая нажатой левую кнопку манипулятора "мышь",
перемещайте узел управления, тем самым делая объект больше
или меньше.
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7.6.2 Маркировка различных объектов оборудования

Маркировка оборудования выполняется в три этапа:

Шаг Содержание

Шаг 1 Вставка и форматирование текстового поля (text field)

Шаг 2 Выполнение последующих установок

Шаг 3 Дублирование текстового поля (text field)
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7.6.2.1 Шаг 1:  Вставка текстовых полей (text field)

Готовы начать?

• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics
Designer.

• Статические объекты (static objects) вставлены

Выполните следующие действия ...

1. Выберите пункт "Standard Objects/Static Text" ("Стандартные
объекты/Статический текст") в палитре объектов Object Palette.

2. Поместите указатель манипулятора "мышь" на поле рисунка.
Указатель манипулятора "мышь" изменяется на маленький значок
текстового окна.

3. Откройте текстовое поле (text box) под левым реактором.
В этом месте появляется прямоугольник с выделенным текстом
внутри.

4. Измените выделенный в прямоугольнике текст на новый текст:
"Reactor 1" ("Реактор 1").

5. Нажмите клавишу Enter для подтверждения вновь введенного Вами
текста.

6. Теперь отформатируйте текст с помощью "палитры стилей" Style
Palette; для этого выполните следующие действия:

- Щелкните кнопкой манипулятора "мышь" на пункте "Line
Weight/Invisible" ("Плотность линий/Невидимые").
При этом рамка текстового поля станет невидимой.

- Щелкните кнопкой манипулятора "мышь" на пункте "Fill
Pattern/Transparent" ("Цвета заливки/Прозрачный").
При этом цвет заливки текстового поля станет прозрачным, т.е.
невидимым.
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7.6.2.2 Шаг 2: Установки текстового поля (Text Field)

Готовы начать?

• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics
Designer.

• Текстовое поле (text field) вставлено

Выполните следующие действия ...

1. Выберите опции меню: 
View -> Properties  (Вид -> Свойства).
При этом открывается диалоговое окно "Object Properties" ("Свойства
объекта"), и вкладка "Properties" ("Свойства") находится в
активированном состоянии.

2. Выберите пункт "Static Text" в иерархической структуре, в котором
содержатся свойства полей ввода (input field).
В правом окне Вы увидите имя текстового поля (text field) и уровень
(level).

3. Перейдите на правое окно и дважды щелкните кнопкой манипулятора
"мышь" на поле "Static Text 1" ("Статический текст 1") в столбце "Static"
("Статические").
Вы можете теперь отредактировать содержимое поля.

4. Введите имя "Reactor 1" ("Реактор 1") и нажмите клавишу Enter. При
этом новое имя будет введено  в данные проекта и будет изображаться
в верхней части поля.
Когда Вы работаете в поле рисунка, это имя будет изображаться как
заголовочное имя, когда Вы помещаете указатель манипулятора
"мышь" на объект.

5. Выберите пункт "Static Text/Font" ("Статический текст/Шрифт") в
иерархической структуре.

6. Перейдите на правое окно и дважды щелкните кнопкой манипулятора
"мышь" в окне "No" ("Нет") атрибута "Bold" ("Полужирный").
Значение изменится с "No" ("Нет") на "Yes" ("Да") и шрифт текста
изменится соответствующим образом - станет жирным.

7. Закройте диалоговое окно "Object Properties" ("Свойства объекта").
Теперь Вы видите в графическом изображении все изменения, которые
Вы сделали при выполнении своих установок.
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7.6.2.3 Шаг 3: Дублирование текстового поля (Text Field)

Готовы начать?

• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics
Designer.

• Текстовое поле (text field) вставлено

• Установки для текстовых полей (text fields) сделаны

Выполните следующие действия ...

Для того, чтобы избежать необходимости снова выполнять все установки,
которые Вы сделали для первого текстового поля (text field), Вы можете
просто скопировать существующее текстовое поле, поместить в
требуемую позицию и просто заменить существующий текст поля новым
текстом.

1. Если текстовое поле (text field) не выбрано, то выберите его. После
этого выберите следующие опции меню: 
Edit -> Duplicate  (Правка -> Дублировать).
Теперь текстовое поле (text field) скопировано.

2. Дважды щелкните кнопкой манипулятора "мышь" на копии текстового
поля (text field) и измените существующий текст на новый текст:
"Reactor 2" ("Реактор 2"). Так как новое текстовое поле является
копией, то оно автоматически наследует все атрибуты формата поля-
прототипа.

3. Выберите опции меню: 
View -> Properties  (Вид -> Свойства).

4. Измените имя объекта в окне свойств на имя "reactor2" в правом окне.

5. Установите модифицированное текстовое поле (text field) под
объектом.

6. Повторите шаги с 1 по 6 для создания текстовых полей (text fields) для
следующих тэгов и замените имена объектов, чтобы каждое имя
отражало имя соответствующего тэга:

- LI111

- NK111

- NK112

- NK113

- NK114

- NP111

- FC111

7. Выберите опции меню: 
File -> Save  (Файл -> Сохранить).
При этом графическое изображение процесса (process picture) будет
сохранено.
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7.6.3 Текущее состояние графического изображения процесса
(process picture) ...

Теперь, после того, как Вы ввели в изображение резервуар, трубы и
метки, Ваше графическое изображение процесса (process picture) должно
выглядеть так, как изображено на рисунке ниже:
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7.6.3.1 Как связать резервуар для сырьевых материалов и
переменную процесса (Process Value)

Резервуар, вставленный Вами в графическое изображение процесса,
является резервуаром для сырьевых материалов. Теперь Вы должны
соединить изображение резервуара с соответствующим блоком, для того,
чтобы  отражать на рисунке текущий уровень заполнения сырьевого
резервуара в "режиме процесса" (process mode).

Готовы начать?
• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics

Designer.

• Статические объекты (static objects) вставлены

Выполните следующие действия ...
1. Выберите объект "Tank4".

2. Выберите опции меню: View -> Properties  (Вид -> Свойства).
При этом откроется диалоговое окно "Object Properties" ("Свойства
объекта") с активной вкладкой "Properties" ("Свойства").

3. Выберите пункт "Tank4" в иерархической структуре.
В правом окне Вы увидите имя текстового поля и значение уровня.

4. Перейдите в правое окно и дважды щелкните кнопкой манипулятора
"мышь" в текстовом поле "Tank4" в столбце "Static" ("Статические"). Вы
можете теперь отредактировать поле.

5. Введите имя "Raw material tank1" ("Резервуар сырьевых материалов") и
нажмите клавишу Enter.
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6. Выберите пункт "Tank4/ Tag Assignment" ("Tank4/ Назначение тэгов") в
иерархической структуре.

7. Перейдите на правое окно, установите указатель манипулятора
"мышь" на значке лампы атрибута "Fill Level" ("Уровень заполнения) и
откройте контекстное меню.

8. Выберите опции меню: Tag...
При этом откроется диалоговое окно "Tag selection" ("Выбор тэгов").

9. Активируйте опцию (check box) "ES Variables" ("ES-переменные") в окне
"Data source" ("Источники данных").
При этом ES-переменные будут отражены в иерархической структуре.

10. Выберите следующий пункт в иерархической структуре:
"ES Variables/ Plant1/ RMT1/ LI111/CFC_LI111/ LIA".
Все соответствующие переменные будут отражены теперь в правом
окне.

11. Выберите переменную "U" в правом окне:

12. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
В результате, указанная переменная и ее полный путь доступа
вводятся в столбец "Dynamic" ("Динамические") (см. следующий
рисунок).



7  Конфигурирование операторской станции

Process Control System PCS 7
Getting Started - Part 1
A5E00164244-01 7-27

13. Поместите указатель мыши на значок лампы атрибута "Maximum
Value" ("Максимальное значение"), откройте контекстное меню и
выберите опцию меню: Delete.
Переменная по умолчанию удаляется и становится активным
значение по умолчанию "100".

14. Выполните такие же действия в отношении атрибута "Minimum Value"
("Минимальное значение").

15. Закройте диалоговое окно "Object Properties" ("Свойства объекта").

16. Выберите опции меню: File -> Save (Файл -> Сохранить).
При этом сохранится графическое изображение процесса.

7.6.3.2 Как настроить значки блоков (Block Icons)

Значки блоков уже присутствуют в графическом изображении процесса
(process picture); они были вставлены с помощью SIMATIC Manager при
использовании функции "Create/Update Block Icons" ("Создать/Изменить
значки блоков"). Если Вы посмотрите на эти значки, то Вы увидите, что
система PCS 7 автоматически создала значки блоков для горизонтального
и вертикального их размещения в соответствии с установками для блоков
в CFC-схемах (CFC chart).

Эти значки блоков должны быть теперь установлены, и для них должны
быть заданы специальные установки в соответствии с требованиями
проекта "color_gs".
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Готовы начать?
• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics

Designer.

• Значки блоков присутствуют в поле рисунка

Установка значков блоков в графическое изображение установки
1. Выберите значок блока "..._NK111/VALVE" и перетащите его с

помощью манипулятора "мышь" в требуемую позицию, так, чтобы
вентиль в значке блока был точно между трубами.

2. Выберите опции меню: 
View -> Properties  (Вид -> Свойства).
При этом откроется диалоговое окно "Object Properties" ("Свойства
объекта").

3. Выберите пункт "Styles" ("Стили") в иерархической структуре, в котором
располагаются свойства значка блока.
При этом в правом окне отобразятся различные атрибуты.

4. Перейдите на правое окно и дважды щелкните кнопкой манипулятора
"мышь" на поле "Yes" ("Да") атрибута "View_Tag".
Значение изменится на "No" ("Нет").

5. Закройте диалоговое окно "Object Properties" ("Свойства объекта").
Установки, которые Вы выполнили здесь, станут видимыми, только
когда вы активизируете "режим процесса" (process mode).
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6. Повторите шаги с 1 по 5 для всех значков блока, в соответствии со
списком, следующим ниже:

- "..._NK111/VALVE"

- "..._NP111/MOTOR"

- "..._NK112/VALVE"

- "..._NK113/VALVE"

- "..._NK114/VALVE"

Теперь графическое изображение процесса (process picture) должно
принять вид, показанный на представленном ниже рисунке:
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7.6.4 Вставка полей ввода/вывода (Input/Output Fields) для
операторского управления

В проекте предусматривается две области влияния на процесс со
стороны оператора с точки зрения использования графического
изображения процесса (process picture):

• Выбор реактора  (Reactor selection)

• Внешняя/внутренняя уставка  (External/internal setpoint)

Алгоритм реализации возможности выбора реактора состоит из трех
шагов. В дальнейшем Вы будете выполнять практически такие же
процедуры для реализации возможности задания внешней/внутренней
уставок:

 Шаг  Содержание

Шаг 1 Вставка полей I/O-параметров (I/O field)

Шаг 2 Форматирование полей I/O-параметров (I/O field)

Шаг 3 Ввод поясняющих текстов

Шаг 4 Конфигурирование назначения уставок

7.6.4.1 Шаг 1:  Вставка полей I/O-параметров (I/O field)

Готовы начать?

• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics
Designer.

• Палитра объектов Object Palette на экране

• Палитра стилей Style Palette на экране

Выполните следующие действия ...

1. Выберите в палитре объектов объект "Smart Objects/I/O Field"
("Интеллектуальные объекты/Поля I/O-параметров").

2. Поместите указатель манипулятора "мышь" на поле рисунка.
Указатель манипулятора "мышь" изменяется на маленький символ
поля I/O-параметров.

3. Открывайте прямоугольник между реакторами, держа нажатой кнопку
манипулятора "мышь". Размер прямоугольника должен
соответствовать Вашему полю I/O-параметров.
При этом откроется диалоговое окно "I/O-Field Configuration"
("Конфигурирование поля I/O-параметров").
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4. Щелкните кнопкой манипулятора "мышь" на диалоговом окне "Tag
selection dialog" ("Окно выбора тэгов") рядом с окном "Tag" ("Тэг").
При этом откроется диалоговое окно "Tags – Project" ("Тэги - Проект").

5. Активируйте опцию (check box) "ES Variables" ("ES-переменные") в окне
"Data source" ("Источники данных").
При этом ES-переменные будут отражены в иерархической структуре.

6. Выберите следующий пункт в иерархической структуре:
"ES Variables/Plant1/RMT1/FC111/ADDIT/CFC_SETP/PARA_DOS_RM1_
SEL". 
Все соответствующие переменные будут отражены теперь в правом
окне.

7. Выберите переменную "I0" в правом окне.

8. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
Ваших установок. Это подтвердит ввод тэга в поле ввода "Tag" ("Тэг").

9. Проверьте, чтобы была активизирована опция (check box) "Both"
("Оба").
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10. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" для ввода
Ваших установок.

7.6.4.2 Шаг 2: Форматирование полей I/O-параметров (I/O field)

Готовы начать?
• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics

Designer.

• В изображение вставлено поле I/O-параметров (I/O field)

Выполните следующие действия ...

Точно также, как выполнялось форматирование текстовых полей (text
fields), Вы можете отформатировать поля I/O-параметров (I/O fields):

1. Выберите поле I/O-параметров "I/O field 1".

2. Отформатируйте поле I/O-параметров, используя палитру стилей:

- Щелкните кнопкой манипулятора "мышь" на пункте "Line
Weight/Invisible" ("Плотность линий/Невидимые").
При этом рамка текстового поля станет невидимой.

- Щелкните кнопкой манипулятора "мышь" на пункте "Fill
Pattern/Transparent" ("Цвета заливки/Прозрачный").
При этом цвет заливки текстового поля станет прозрачным, т.е.
невидимым.
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3. Выберите опции меню: View -> Properties  (Вид -> Свойства).
При этом откроется диалоговое окно "Object Properties" ("Свойства
объекта") с активной вкладкой "Properties" ("Свойства).

4. Выберите в иерархической структуре пункт "I/O Field" ("поле I/O-
параметров") в котором хранятся свойства поля ввода (input field).
В правом окне Вы увидите имя текстового поля и значение уровня.

5. Перейдите в правое окно и дважды щелкните кнопкой манипулятора
"мышь" на поле "I/OField1" в столбце "Static" ("Статические"). 
Теперь Вы можете отредактировать поле.

6. Введите имя "SEL_REAC" и нажмите клавишу Enter.
При этом окно будет введено, и в дальнейшем оно будет изображаться
вверху окна.

7. Выберите пункт "I/O Field/Font" в иерархической структуре и измените
значение атрибута "Bold" ("Полужирный") на значение "Yes" ("Да") в
правом окне.

8. Выберите пункт "I/O Field/Output/Input" в иерархической структуре и
измените значение атрибута "Data Format" на значение "Binary"
("Двоичный") в правом окне.

9. Закройте диалоговое окно "Object Properties" ("Свойства объекта").
Все изменения, которые Вы только что сделали, будут теперь
изображаться на экране.

7.6.4.3 Шаг 3:  Ввод поясняющих текстов

Готовы начать?
• Графическое изображение "RMT1.pdl" открыто в редакторе Graphics

Designer.

• Вы вставили и сформатировали поле I/O-параметров (I/O field)

Выполните следующие действия ...
Оператор должен знать, какой параметр устанавливается с помощью
данного поля. В целях сделать изображение процесса более наглядным
Вы можете использовать текстовое поле (text field) (Вы уже раньше
использовали текстовые поля (text fields) при маркировании
оборудования).

1. Вставьте текстовое поле (text field): используйте объект "Standard
Objects/Static Text" ("Стандартные объекты"/"Статический текст").

2. Введите следующий текст: "Select reactor: 0 = Reactor 1, 1 = Reactor 2"
("Выберите реактор: 0 = реактор 1,  1 = реактор 2).
Для получения функции "перевода строки" используйте комбинацию
клавиш: "Shift + Enter".
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3. Отформатируйте текстовое поле, используя палитру стилей:

- Щелкните кнопкой манипулятора "мышь" на пункте "Line
Weight/Invisible" ("Плотность линий/Невидимые").
При этом рамка текстового поля станет невидимой.

- Щелкните кнопкой манипулятора "мышь" на пункте "Fill
Pattern/Transparent" ("Цвета заливки/Прозрачный").
При этом цвет заливки текстового поля станет прозрачным, т.е.
невидимым.

4. Создайте рамку вокруг поля I/O-параметров и пояснительного текста –
для этого используйте объект "Standard Objects/Rectangle"
("Стандартные объекты/Прямоугольник").

5. Отформатируйте рамку, используя палитру стилей:

- Щелкните кнопкой манипулятора "мышь" на пункте "Line
Weight/3 Pixel" ("Плотность линий/3 пиксела").
При этом возникнет рамка толщиной 3 пиксела вокруг текста.

- Щелкните кнопкой манипулятора "мышь" на пункте "Fill
Pattern/Transparent" ("Цвета заливки/Прозрачный").
При этом цвет заливки текстового поля останется прозрачным.

6. Установите объект согласно рисунку:

7. Обведите рамкой все объекты.

8. Выберите опции меню: 
Edit -> Group -> Group  (Правка -> Группа -> Сгруппировать).
Все объекты теперь сгруппированы и могут перемещаться вместе.

9. Установите полученный объект между реакторами.

7.6.4.4 Шаг 4: Конфигурирование назначения уставок

Выполните такую же процедуру, как для объекта между реакторами 1 и 2.
Ниже Вы найдете общий обзор отдельных шагов процедуры:

1. Вставьте поле I/O-параметров (I/O field) и установите связь с тэгом
"Plant1/RMT1/FC111/CFC_FC111/DOSE/SPEXT_ON".

2. Определите свойства поля I/O-параметров, используя палитру стилей:

- Рамка невидима - опции "Line Weight/Invisible" ("Плотность
линий/Невидимые")

- Заливка прозрачная - опции "Fill Pattern/Transparent" ("Цвета
заливки/Прозрачный")

3. Определите свойства поля I/O-параметров в диалоговом окне
"Properties" ("Свойства"):

- "I/O Field" – атрибут "Object Name" (имя объекта): "SEL_SP"
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- "Font" ("Шрифт") – "Bold" ("Полужирный"): "Yes" ("Да")

- "Output/Input" ("Выход/вход") – "Data Format" (Формат данных):
"Binary" ("Двоичный")

4. Вставьте текстовое поле (text field) пояснения: 
"Input setpoint: 0 = internal (operator), 1 = external (CFC chart)" 
("Уставка на входе: 0 = внутренняя (оператор), 1 = внешняя (CFC-
схема)")

5. Отформатируйте текстовое поле, используя палитру стилей:

- Рамка невидима - опции "Line Weight/Invisible" ("Плотность
линий/Невидимые")

- Заливка прозрачная - опции "Fill Pattern/Transparent" ("Цвета
заливки/Прозрачный")

6. Создайте рамку вокруг поля I/O-параметров и пояснительного текста –
для этого используйте объект "Standard Objects/Rectangle"
("Стандартные объекты/Прямоугольник").

7. Отформатируйте рамку, используя палитру стилей:

- Толщина рамки - опции "Line Weight / 3 Pixel" ("Плотность линий / 3
пиксела")

- Заливка прозрачная - опции "Fill Pattern/Transparent" ("Цвета
заливки/Прозрачный")

8. Выберите опции меню: 
Edit -> Group -> Group  (Правка -> Группа -> Сгруппировать).
Все объекты теперь сгруппированы и могут перемещаться вместе.

9. Установите полученный объект слева внизу.
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7.6.4.5 Последние штрихи

1. Установите значок блока "..._FC111/CTRL_PID" справа рядом с
управляющим вентилем "FC111".

2. Вставте стрелку между приводом и значком блока, чтобы обозначить
связь между точкой измерения и значком блока.

3. Установите значок блока "/CFC_LI111/LIA" справа рядом с резервуаром
сырьевых материалов.

4. Вставьте стрелку между резервуаром сырьевых материалов и значком
блока, чтобы обозначить связь между точкой измерения и значком
блока

5. Установите значок блока ".../CFC_FC111/DOSE" слева рядом с
реактором reactor 1.

6. Установите окно выбора уставки над значком блока
".../CFC_FC111/DOSE".

7. Установите значок блока "...RMT1/SFC_RMT1" в левый верхний угол.
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Теперь графическое изображение процесса (process picture) должно
принять вид, показанный на представленном ниже рисунке:

8. Выберите опции меню: 
File -> Save (Файл -> Сохранить)  (Файл -> Сохранить).
Теперь графическое изображение процесса (process picture) сохранено
со всеми изменениями и дополнениями.
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7.7 Текущее состояние Вашего проекта...

Итак, конфигурирование Вашего проекта завершено, так что Вы можете
активировать "режим процесса" (process mode).

В процессе конфигурирования операторской станции OS Вы
познакомились со следующими функциями?

• Установка свойств изображения (picture) с использованием утилиты
SIMATIC Manager

• Создание значков блоков

• Компилирование операторской станции

• Создание графического изображения процесса (process picture) в
редакторе Graphics Designer с использованием различных объектов, в
частности, статических и динамических объектов.
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8 Работа в "режиме процесса" (Process
Mode)

8.1 Введение в пользовательский интерфейс

8.1.1 Операторская станция в "режиме процесса" (Process Mode)

В "режиме процесса" (Process Mode) в проекте "color_gs" обеспечиваются
различные опции для управления и мониторинга процесса.

Значки блоков предоставляют Вам следующие возможности:

• мониторинг состояния вентилей: вентиль закрыт или открыт;

• мониторинг состояния насоса: насос включен или выключен;

• переключение со значка блока на соответствующую "лицевую
панель".

Поля I/O-параметров (I/O fields) предоставляют Вам следующие
возможности:

• выбор реактора;

• выбор источника сигнала уставки (setpoint): или считывание с CFC-
схемы (CFC chart), или оператор будет задавать ее величину вручную;

• задание величины заданного значения для объема порции сырьевых
материалов (dosing volume) с помощью "лицевой панели".

Пользователю, конечно, предоставляется возможность мониторинга CFC-
схем и SFC-схем (charts) в то же самое время. Вы уже познакомились с
этой функцией, когда проходили тему тестирования схем.

8.1.2 Пользовательский интерфейс в "режиме процесса" (Process
Mode)

Чтобы Вы сами могли осуществлять мониторинг и управление процессом,
мы предлагаем Вам краткое введение в пользовательский интерфейс
PCS 7 в "режиме процесса" (Process Mode).

Итак, пользовательский интерфейс в "режиме процесса" (Process Mode)
разделяется на четыре области:

• Строка сообщения (Message line) – в этой строке отображается самое
последнее сообщение с наивысшим приоритетом;

• Область обзора установки (Overview area) – область с различными
кнопками, с помощью которых Вы можете выбрать ту или иную часть
установки для отображения ее состояния на экране. В Вашем проекте
"color_gs" у Вас здесь будет только одна кнопка, а именно "RMT1", в
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Вашем учебном проекте рассматривается только одна часть
установки. Рядом с каждой кнопкой в данной области расположены
другие четыре маленькие кнопки, с помощью которых можно
отобразить уровни для сигналов тревоги (alarm) и предупреждения
(warning) для соответствующих уровней иерархии установки. Если Вы
щелкните кнопкой манипулятора "мышь" на этой области, то Вы
автоматически переключитесь на графическое отображение процесса
(process picture), для которого эти уровни для сигналов тревоги (alarm)
и предупреждения (warning) сформированы. С помощью кнопок
навигации (крайние справа кнопки со стрелками) Вы можете открыть
иерархическую структуру, в которой Вы можете выбирать пункты для
рассмотрения.

• Графическое отображение процесса (Process picture) – в зависимости
от выбора, сделанного в области обзора установки (Overview area),
здесь Вы получите то или иное графическое отображение процесса
(process picture). В Вашем проекте "color_gs" в данной части
интерфейса Вы получите то графическое отображение процесса,
которое Вы создали с помощью редактора Graphics Designer.

• Клавиатура (Keyset) – используя кнопки этого ряда, Вы можете
вызывать различные функции, которые Вам доступны в "режиме
процесса" (process mode). В проекте "color_gs" Вы только
познакомитесь с кнопками, которые важны для Вашего проекта.

Message line

Process picture

Overview area

Keyset

Строка сообщений
Область обзора

установки

Графическое отображение
процесса

Клавиатура
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8.2 Как осуществлять мониторинг и управление в
"режиме процесса" (Process Mode)

8.2.1 Как активировать "режим процесса" (Process Mode)

Готовы начать?
• Утилита WinCC Explorer открыта

• Проект "color_gs" открыт

Активация "режима процесса" (Process Mode)
1. Выберите опции меню: File -> Activate (Файл -> Активировать).

Включается индикатор загрузки и стандартная картинка запуска.

2. Щелкните кнопкой манипулятора "мышь" на кнопке "RMT1" в области
обзора установки (Overview area).
Это вызовет появление графического отображения процесса (process
picture), которое Вы создали в редакторе Graphics Designer.

8.2.2 Как активировать процесс (Process)

Конечно, необходимо сначала организовать подачу сырья в установке,
прежде чем Вы сможете использовать все функции, которые Вы
сконфигурировали.

Процесс подачи сырья организован с помощью SFC-схемы (SFC chart).
Вам не нужно возвращаться в SIMATIC Manager для этого: Вы запустите
SFC-схему непосредственно в "режиме процесса" (Process Mode).

1. Щелкните кнопкой манипулятора "мышь" на кнопке "Change Keyset"
("Переключить клавиатуру"): Появится альтернативный
набор кнопок.
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2. Щелкните кнопкой манипулятора "мышь" на "SFC Visualization" ("SFC
визуализации"):

При этом откроется диалоговое окно "Open SFC"
("Открыть SFC"). Так как в Вашем проекте только одна станция OS и
одна SFC-схема (SFC chart), то объект (одна станция OS) будет
показана в иерархической структуре, и одна SFC-схема будет показана
в правом окне.

3. Выберите схему (chart) "RMT1/FC111/SFC_RMT1" в правом окне и
щелкните кнопкой манипулятора "мышь" на кнопке "OK".
При этом открывается сильно уменьшенный общий вид SFC-схемы
(SFC chart) (см. рисунок).

4. Щелкните кнопкой манипулятора "мышь" на этом общем виде SFC-
схемы. При этом появится подробное изображение SFC-схемы.
Это подробное изображение SFC-схемы совместимо с видом, с
которым Вы работали, когда тестировали SFC-схему (SFC chart) в SFC-
редакторе (SFC Editor).
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5. Установите это подробное изображение SFC-схемы так, чтобы видеть
отображение процесса целиком.

6. Щелкните кнопкой манипулятора "мышь" на кнопке "Start" ("Пуск").
При этом откроется диалоговое окно "SFC Control" ("Управление SFC").

7. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
При этом запустится система последовательного управления
(sequential control system): Вы можете наблюдать за процессом и с
помощью отображения процесса (process picture), и с помощью
подробного изображения SFC-схемы (SFC chart). Представление в
SFC-схеме (SFC chart) не отличается от представления, с которым Вы
работали в режиме тестирования (test mode).

8.2.3 Как остановить процесс (Process)

Если Вам не нужно выполнить процесс от начала до конца, Вы можете
остановить его вручную:

1. Щелкните кнопкой манипулятора "мышь" на кнопке "Stop" ("Стоп") в
подробном изображении SFC-схемы (SFC chart).
При этом откроется диалоговое окно "SFC Control" ("Управление SFC").

2. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
После этого процесс будет остановлен.

3. Далее щелкните кнопкой манипулятора "мышь" на кнопках "Reset"
("Сброс") и "OK" в диалоговом окне "SFC Control" ("Управление SFC").
Все переменные при этом получат исходные значения.
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8.2.4 Как управлять процессом, используя графическое
отображение процесса (process picture)

Существует несколько способов воздействия на процесс в "режиме
процесса" (process mode) при использовании графического отображения
процесса (process picture), а именно:

• выбором реактора;

• открытием лицевых панелей (faceplates);

• переключением сигналов уставки (setpoint).

8.2.5 Как выбирать реактор

1. Поместите указатель мыши в поле I/O-параметров (I/O field) в области
выбора реактора "Select reactor".
Указатель манипулятора "мышь" изменяется на символ для работы с
текстом.

2. Щелкните кнопкой манипулятора "мышь" в поле I/O-параметров (I/O
field).
При этом поле I/O-параметров (I/O field) будет отображено на сером
фоне.

3. Введите требуемый номер, соответствующий выбираемому реактору.
Выберите реактор, пользуясь таблицей:

 Если Вы …  … то вводите следующий номер:

хотите заполнять сырьем реактор 1,  1

хотите заполнять сырьем реактор 2,  0

4. Нажмите клавишу Enter.
Введенный Вами номер, соответствующий выбираемому реактору,
будет отображен в поле после короткой паузы.

5. Перезапустите процесс и смотрите, что получается.
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8.2.6 Как открывать "лицевые панели" (Faceplates)

1. Запустите процесс

2. Щелкните кнопкой манипулятора "мышь" на значке блока
"..._FC111/CTRL_PID".
При этом откроется соответствующая лицевая панель с активной
вкладкой "Standard" ("Стандартные").

3. Вы можете выбрать другие вкладки, используя окно с открывающимся
списком. В случае Вашего проекта "color_gs" представляют интерес
следующие виды:

- Standard (Стандартные) – здесь Вы можете видеть, например,
значение уставки (setpoint) и фактическое значение (actual value)
регулятора как в виде конкретной численной величины, так и в
графической форме.

- Parameters (Параметры) – здесь Вы можете изменять значения.
Используя поля ввода "Bar HL" и "Bar LL", Вы можете изменять
графическое изображение для вкладки "Standard"
("Стандартные").

- Limits (Пределы) – здесь Вы можете видеть, например, значения
предельных значений для генерации сигнала тревоги (alarm limits),
которые Вы определяете в CFC-схеме (CFC chart) для данного
блока.

4. Закройте "лицевую панель" (faceplate).

8.2.7 Как переключать сигнал уставки (setpoint)

Чтобы изменить назначения для сигнала уставки (setpoint), требуется
выполнить два действия:

• Сначала необходимо определить источник сигнала уставки - внешний
(external) или внутренний (internal).

• После этого необходимо задать конкретное значение уставки.

Шаг 1 – Определение источника сигнала уставки

1. Поместите указатель мыши в поле I/O-параметров (I/O field) в области
"Input setpoint" ("Ввод уставки"). Указатель манипулятора "мышь"
изменится на символ для работы с текстом.

2. Щелкните кнопкой манипулятора "мышь" и введите номер:

 Если Вы …  … то вводите следующий номер:

хотите считывать сигнал из CFC-схемы, 1

хотите вводить уставку вручную, 0

 3. Нажмите клавишу Enter.
Введенный Вами номер будет отображен в поле после короткой паузы.
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Шаг 2 – Ввод значения уставки

1. Щелкните кнопкой манипулятора "мышь" на значке блока
".../CFC_FC111/DOSE".
При этом откроется соответствующая лицевая панель с активной
вкладкой "Standard" ("Стандартные").

2. Откройте окно с открывающимся списком "Setpoint" ("Уставка").
При этом откроется диалоговое окно "SP".

3. Активируйте опцию "Internal" ("Внутренняя").

4. Щелкните кнопкой манипулятора "мышь" на кнопке "Run" ("Работа").
При этом откроется диалоговое окно "Setpoint" ("Уставка") с активным
полем ввода.

5. Щелкните кнопкой манипулятора "мышь" на поле ввода.
При этом откроется диалоговое окно "Setpoint" ("Уставка").

6. Щелкните кнопкой манипулятора "мышь" на поле ввода и введите
значение.
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7. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
При этом значение принимается.

8. Закройте лицевую панель (faceplate).
Теперь новое значение уставки отображается в значке блока.

9. Перезапустите процесс и смотрите, что получается.

8.2.8 Как работать с сообщениями (Messages)

Сообщения отображаются и в строке сообщения (Message line), и в
отдельном списке сообщений (message list).

Строка сообщения (Message line)
Пока процесс активен, предупреждения (warnings) и тревожные
сообщения (alarms) отображаются в строке сообщения (Message line) на
Вашем экране. Строка сообщения (Message line) содержит самое
последнее сообщение с высшим приоритетом.

Щелкните кнопкой манипулятора "мышь" на кнопке справа от строки
сообщения (Message line) для квитирования сообщения.

Список сообщений (Message list)
Вы можете также просмотреть все сообщения и предупреждения в
отдельном списке.

1. Щелкните кнопкой манипулятора "мышь" на кнопке "Change Keyset"
("Переключить клавиатуру"):

2. Щелкните кнопкой манипулятора "мышь" на кнопке "Message System"
("Система сообщений").

При этом отобразится список сообщений.

3. Подтвердите прием сообщения 
(см. таблицу на следующей странице):
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  Если Вы …  … тогда

хотите квитировать одиночное
сообщение

Щелкните кнопкой манипулятора
"мышь" на номере строки требуемого
сообщения и затем щелкните на
кнопке "Acknowledge single messages"
("Квитировать одиночное сообщение").

хотите квитировать все сообщения Щелкните кнопкой манипулятора
"мышь" на кнопке "Acknowledge all
visible messages" ("Квитировать все
видимые сообщения").

4. Щелкните кнопкой манипулятора "мышь" на соответствующих кнопках
для переключения между списками и отдельными сообщениями.

5. Щелкните кнопкой манипулятора "мышь" на кнопке "Previous Graphic"
("Предыдущее графическое изображение") в области кнопок:

Это вернет Вас к графическому отображению процесса "RMT1".

8.2.9 Как выйти из "режима процесса" (Process Mode)

1. Щелкните кнопкой манипулятора "мышь" на кнопке "Change Keyset"
("Переключить клавиатуру"):

2. Щелкните кнопкой манипулятора "мышь" на кнопке "Exit Runtime"
("Выход из выполнения программы"):

При этом откроется диалоговое окно "Exit Runtime" ("Выход из
выполнения программы"):

3. Щелкните кнопкой манипулятора "мышь" на кнопке "Deactivate"
("Деактивировать"). При этом выключится "режим процесса".
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9 Дополнительная задача

9.1 Введение в дополнительную задачу

В проекте "color_gs" предусмотрены два одинаковых резервуара для
сырьевых материалов. Дополнительная задача заключается в
конфигурировании второго резервуара для сырьевых материалов "RMT2".
Но при этом Вам нет необходимости проходить все ранее выполненные
этапы работы снова - Вы просто используете специальные
автоматические функции системы PCS 7. Вы обнаружите, что функция
копирования системы PCS 7 автоматически в фоновом режиме запомнила
многие Ваши действия.

Когда Вы будете конфигурировать второй резервуар для сырьевых
материалов, Вы будете работать в основном самостоятельно. Вам уже
знакомы многие из диалоговых окон, с которыми Вы имели дело при
конфигурировании первого резервуара для сырьевых материалов. В этом
разделе мы не будем  давать Вам подробных инструкций на каждом этапе
Вашей работы, а вне связи с этими этапами, будем рассказывать об
общих принципах процедуры.

9.1.1 Как скопировать существующий раздел установки 'RMT1'

Готовы начать?
• Проект "color_gs" открыт в SIMATIC Manager

• Активирован вид "представление установки" (plant view)

• У Вас есть полностью и без ошибок сконфигурированный реактор
RMT1

Выполните следующие действия ...
1. Используя функции Windows "Copy/Paste" ("Копировать/Вставить"),

скопируйте папку иерархической системы (hierarchy folder) "RMT1" в
папку иерархической системы "Plant1".

2. С помощью утилиты SIMATIC Manager создается копия папки
иерархической системы (hierarchy folder) "RMT1" в папке иерархической
системы "Plant1" с именем "RMT1(1)". Имена различных объектов,
например, CFC-схем и SFC-схем (charts) также получают
последовательные номера, добавляемые к их уже существующим
именам. В то время, как Вы копируете папки иерархической системы
(hierarchy folder) с CFC-схемами (CFC charts) и графическими
отображениями процесса (process pictures), ссылки на динамические
объекты для станции OS в CFC блоках автоматически добавляются в
папку назначения в иерархической системе папок (hierarchy folder).
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Внимание
Если Вы копируете или перемещаете схемы (charts) и графические
отображения (pictures) отдельно; другими словами, копируете или
перемещаете их не вместе с папкой иерархической системы (hierarchy
folder), то ссылки на динамические объекты теряются, в результате чего
схемы (charts) и графические отображения (pictures) вновь должны быть
подключены к блокам.

3. Замените имена папок иерархической системы (hierarchy folder) и
объектов в отдельных папках иерархической системы (hierarchy folders)
в соответствии с таблицей, представленной ниже:

 Папка
иерархической
системы

 Новое  имя  Прежнее имя
содержащегося объекта  Новое  имя

RMT1(1) RMT2 Графическое отображение
процесса (process picture)
"RMT1(1)"

RMT2

SFC_RMT1(1) SFC_RMT2

FC111 FC112 CFC_FC111(1) CFC_FC112

ADDIT ADDIT2 CFC_SETP(1) CFC_SETP2

LI111 LI112 CFC_LI111(1) CFC_LI112

NK111 NK115 CFC_NK111(1) CFC_NK115

NK112 NK116 CFC_NK112(1) CFC_NK116

NK113 NK117 CFC_NK113(1) CFC_NK117

NK114 NK118 CFC_NK114(1) CFC_NK118

NP111 NP112 CFC_NP111(1) CFC_NP112

Иерархическая система Вашей установки (plant hierarchy) теперь должна
иметь следующий вид:
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9.2 Подготовка к работе в "режиме процесса" (Process
Mode)

Для того, чтобы  выполнять контроль и мониторинг такой части Вашей
установки, как реактор "RMT2", который Вы вставили с помощью утилиты
SIMATIC Manager, Вы должны, конечно, сначала информировать
программируемый контроллер и станцию OS о появлении новых объектов
и об их свойствах. В этой ситуации система PCS 7 предоставляет Вам
опциями компилирования и загрузки только той части информации, в
которой были произведены изменения. Такая возможность уменьшает
затраты времени на процессы компиляции и загрузки. В Вашем проекте
"color_gs", в принципе, нет такой проблемы, так как сам проект маленький.
Однако, при создании больших проектов указанные выше возможности
системы являются чрезвычайно важными.

• Загрузка схем (Downloading charts) – так как в операциях копирования
фактически создаются новые схемы (charts), эти схемы должны быть
также загружены в программируемый контроллер.

• Создание значков блоков и компилирование OS (Creating icon blocks
and compiling the OS) – эта функция необходима, так как Вы должны
переименовать папки иерархической системы (hierarchy folders) и
схемы (charts). Так как имя папки иерархической системы (hierarchy
folder) включается в имя тэга (tag name), то это новое имя должно
стать известным станции OS, так как имя тэга может быть изменено.



9  Дополнительная задача

Process Control System PCS 7
Getting Started - Part 1
A5E00164244-01 9-4

9.2.1 Как загрузить (download) новые схемы (charts)

Готовы начать?
• Проект "color_gs" открыт в SIMATIC Manager

• Активирован вид "представление установки" (plant view)

Выполните следующие действия ...
1. Выберите объект "color_gs_Prj" в иерархической структуре.

2. Выберите опции меню: PLC -> Compile and Download Objects
(PLC -> Компилировать и загрузить объекты).
При этом состояние объекта "Charts" (в столбце "Status") будет
"modified" ("изменено").

3. Выберите объект "Charts" ("Схемы").

4. Щелкните кнопкой манипулятора "мышь" на кнопке "Edit" ("Правка").
При этом откроется диалоговое окно "Compile/Download Program to
PLC" ("Компиляция/загрузка программы в PLC").
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5. Сделайте следующие установки:

- Активируйте опцию (элемент управления "check box") "Changes
only" ("Только изменения") – Вам нужно загрузить только
добавочные схемы из части установки "RMT2", у Вас уже
загружены другие схемы, принадлежащие части "RMT1".

Внимание
CPU остается в рабочем режиме RUN (Работа), только если Вы
выбираете эту опцию.

- Активируйте опцию (элемент управления "check box") "Update
sampling time" ("Обновление времени дискретизации").

- Активируйте опцию (элемент управления "check box") "Delete
empty run-time groups" ("Удалять пустые группы выполнения").

6. Щелкните кнопкой манипулятора "мышь" на кнопке "OK" и затем на
кнопке "OK" в окне сообщения "Download" ("Загрузка").

7. Щелкните кнопкой манипулятора "мышь" на кнопке "Start" ("Пуск").
При этом откроется диалоговое окно "Download" ("Загрузка").

8. Щелкните кнопкой манипулятора "мышь" на кнопке "yes" ("да").
После этого запустится процесс загрузки, при этом CPU останется в
рабочем режиме RUN (Работа). После завершения загрузки в
дополнительном окне появится файл протокола (log file).

9. Закройте файл протокола.
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10. Щелкните кнопкой манипулятора "мышь" на кнопке "Cancel"
("Отмена") в "Compile and Download" диалоговое окно.

11. Протестируйте систему последовательного управления (sequential
control system). Используйте туже самую процедуру, которую Вы
применяли для проверки реактора "RMT1". Если Вы не помните, как
это делается, Вы можете найти подробную информацию в разделах:

- "Компиляция, загрузка и тестирование схем (Charts) – Как
тестировать программу в SFC-редакторе"

- "Компиляция, загрузка и тестирование схем (Charts) – Как
тестировать программу в CFC-редакторе"

9.2.2 Как компилировать OS после изменений

Готовы начать?
Проект "color_gs" открыт в SIMATIC Manager.

Выполните следующие действия ...
1. Выберите папку "RMT2" в "представлении установки" (plant view).

2. Выберите опции меню: 
Options -> Plant Hierarchy -> Create/Update Icon Blocks  
(Опции -> Иерархия установки -> Создать/Обновить значки блоков).

Внимание
Убедитесь, что Вы не выбрали папку иерархической системы (hierarchy
folder) высокого уровня. Иначе, Вы можете заменить значки блоков в
отображении RMT1, так же как и установки, которые Вы выполнили
раньше.

Более подробную информацию по данному вопросу Вы можете
получить в разделах: "Конфигурирование операторской станции –
Работа в SIMATIC Manager – Как компилировать OS".

3. Выберите следующий пункт в иерархической структуре в режиме
"отображения компонентов" (component view):
"color_gs_MP/ color_gs_Prj/ SIMATIC PC Station(1)".

4. Выберите опции меню: 
Options -> OS -> Compile… (Опции -> OS -> Компилировать…)

Внимание
Активируйте опцию (элемент управления "check box") "Changes only"
("Только изменения"). Это предотвратит загрузку всей информации, что
позволит свести к минимуму время, требуемое для компиляции.
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Если Вы не помните, как работать с программой-помощником (wizard),
Вы можете найти подробную информацию в разделах:
"Конфигурирование операторской станции – Работа в SIMATIC
Manager – Как компилировать OS".

5. Откройте PCS 7 OS, далее откройте "RMT2" в графическом
отображении процесса (process picture) в редакторе Graphics Designer.

6. Сделайте следующие изменения:

- Измените статические тексты (static texts) для обеспечения
соответствия имен в иерархической системе установки (plant
hierarchy), например,  текст "NK111" должен быть заменен на
новый текст:  "NK115"

- Установите значки блоков.

- Установите атрибут "View Tag" ("Вид тэгов") в значение "no" ("нет)
для значков блоков.

Более подробную информацию по данным процедурам Вы можете
получить в разделах: "Конфигурирование операторской станции –
Создание отображения процесса (Process Picture)".

9.2.3 Как запустить "режим процесса" (Process Mode)

Готовы начать?
• Вы скомпилировали станцию OS

• Объект PCS 7 OS "color_gs" открыт

• Вы скомпилировали изменения в "RMT2" в графическом отображении
процесса (process picture)

Выполните следующие действия ...
1. Выберите в WinCC Explorer опции меню: 

File -> Activate  (Файл -> Активировать).
После этого переключитесь в "режим процесса" (process mode).
Теперь Вы можете видеть добавочную кнопку в "области обзора
установки" (overview) с надписью "RMT2". Щелчком по кнопкам "RMT1"
и "RMT2" Вы можете переключать части установки для мониторинга.
При этом активная кнопка выделяется цветом.

2. Щелкните кнопкой манипулятора "мышь" на кнопке "RMT2" в области
обзора установки.

3. Переключите набор клавиш клавиатуры (keyset) и щелкните кнопкой
манипулятора "мышь" на кнопке "SFC Visualization" ("SFC-
визуализация").
При этом откроется диалоговое окно "Open SFC" ("Открыть SFC").
В правом окне Вы увидите следующие SFC-схемы (SFC charts): SFC-
схема "RMT1" и SFC-схема "RMT2".
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4. Выберите SFC-схему "../RMT2" и запустите систему последовательного
управления (sequential control system).

Примечание
Более подробную информацию по данному вопросу Вы можете получить
в разделе: "Работа в "режиме процесса" (Process Mode) – Как
осуществлять мониторинг и управление в "режиме процесса" (Process
Mode)".

5. Работа в "режиме процесса" (Process Mode):

- Переключайтесь с одной части установки на другую

- Изменяйте значения сигнала уставки (setpoint)

- Выбирайте для загрузки сырья тот или иной реактор

- …

Более подробную информацию по данному вопросу Вы можете получить
в разделе: "Работа в "режиме процесса" (Process Mode)".
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10 Запуск и настройка образца проекта

10.1 Входящий в поставку образец проекта "color_gs"

Вместе с начальным курсом Вы получили образец проекта PCS 7
"color_gs", который уже полностью сконфигурирован. Вы можете открыть
этот проект и запустить его на выполнение на Вашем компьютере. Так как
мы допускаем наличие особенностей в конфигурации Вашего
оборудования при создании Вашего проекта, Вам необходимо выполнить
настройку конфигурации оборудования, если Вы использовали
компоненты оборудования, отличающиеся от предполагавшихся в
проекте.

В следующих разделах Вам представлен общий обзор по вопросам
открытия образца проекта и по работе с ним, включая настройку проекта.

• Открытие образца проекта

• Настройка конфигурации оборудования образца проекта

• Компиляция и загрузка образца проекта

10.1.1 Как открывать образец проекта

Готовы начать?

• Утилита SIMATIC Manager открыта

Примечание

Вы получили образец проекта в форме ZIP-файла (zip-архив), который Вы
можете разархивировать, используя функции PCS 7. Если Вы хотите
сохранить проект в отдельной папке, то сначала создайте папку в
Windows с помощью Проводника (Explorer) и назовите ее, например,
"sampleproj_gs".
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Выполните следующие действия ...

1. Откройте утилиту SIMATIC Manager и выберите опции меню: 
File -> Retrieve...  (Файл -> Восстановить...)
При этом откроется диалоговое окно "Retrieving – Select an archive"
("Восстановление - выбрать архив").

2. Откройте папку "SIEMENS/ STEP7/ Examples_MP"

3. Выберите файл "color_gs.zip" и щелкните кнопкой манипулятора
"мышь" на кнопке "Open" ("Открыть").
При этом откроется диалоговое окно "Select destination directory"
("Выберите каталог назначения") и будет выбрана папка "S7proj" – эта
папка выбирается по умолчанию, как место хранения всех проектов
PCS 7.

 Если Вы …  … тогда

согласны выбрать папку,
назначаемую по умолчанию,

щелкните кнопкой манипулятора
"мышь" на кнопке "OK".

имеете заранее созданную
специальную папку для хранения
проектов,

укажите путь к этой папке и затем
щелкните кнопкой манипулятора
"мышь" на кнопке "OK".

При этом начнется процесс восстановления файла из архива. По
завершении процесса разархивирования, откроется окно сообщения
"Retrieving" ("Восстановление").

4. Щелкните кнопкой манипулятора "мышь" на кнопке "OK".
При этом откроется следующее окно сообщения: "The multiproject
'color_gs' has been removed from the archive. Do you want to open it now?"
("Мультипроект 'color_gs'  был восстановлен из архива. Вы желаете
открыть его сейчас?").

5. Щелкните кнопкой манипулятора "мышь" на кнопке "yes" ("да").
После этого образец проекта будет открыт.
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10.1.2 Как настраивать оборудование для образца проекта

Готовы начать?

• Образец проекта открыт в SIMATIC Manager

• Активирован вид "представление компонентов" (component view)

Выполните следующие действия ...

1. Проверьте установки, заданные для оборудования, – этот шаг в
основном точно такой же, как при подготовке Вашего собственного
проекта.

Более подробную информацию по данному вопросу Вы можете получить
в разделе:  "Первые шаги в работе с проектом – Установки оборудования
– Как проверить установки оборудования (Hardware Settings)".

2. Установите PG/PC-интерфейс – Вы познакомились с этим этапом
работы темой при подготовке Вашего собственного проекта.

Более подробную информацию по данному вопросу Вы можете получить
в разделе:  "Первые шаги в работе с проектом – Установки оборудования
– Как установить PG/PC-интерфейс".

3. Выберите "SIMATIC 400(1)" в структуре "дерево каталогов".

4. Выберите объект "Hardware" ("Оборудование") в правом окне и затем
выберите опции меню: 
Edit -> Open Object   (Правка -> Открыть объект).
При этом откроется утилита конфигурирования оборудования HW
Config.

5. Выберите необходимые в Вашем проекте компоненты из каталога
оборудования (hardware catalog) и перетащите их в слоты, в которые
эти компоненты должны быть установлены.
При этом выбранные Вами компоненты заменят компоненты, которые
были предусмотрены проектом.

6. Сохраните и скомпилируйте Вашу собственную конфигурацию
оборудования и после этого загрузите ее в CPU.

Более подробную информацию по данному вопросу Вы можете получить
в разделе:  "Первые шаги в работе с проектом – Установки оборудования
– Как загрузить конфигурацию оборудования (Hardware Configuration)".

7. Закройте утилиту конфигурирования оборудования HW Config.
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10.1.3  Как компилировать и загружать образец проекта

Готовы начать?

• Образец проекта открыт в SIMATIC Manager

• Активирован вид "представление компонентов" (component view)

Выполните следующие действия ...

1. Выберите объект "color_gs_MP/ color_gs_Prj/ SIMATIC 400" в структуре
"дерево каталогов" и затем выберите опции меню: 
PLC -> Compile and Download Objects  (PLC -> Компилировать и
загрузить объекты).
При этом откроется диалоговое окно "Compile and Download Objects"
("Компиляция и загрузка объектов").

Внимание

Убедитесь, что Вы активировали опцию (элемент управления "check box")
"Entire program" ("Программа в целом") в диалоговом окне "Compile
Program/Download" ("Компиляция программы / Загрузка").

Более подробную информацию по данному вопросу Вы можете получить
в разделе:  "Компиляция, загрузка и тестирование схем (Charts) –
Компиляция и загрузка CFC- и SFC-схем".

2. Переключитесь в режим "представление установки" (plant view),
выберите объект "color_gs_MP/ color_gs_Prj/ Plant1/ RMT1" в структуре
"дерево каталогов" и после этого выберите опции меню: 
Options -> Plant Hierarchy -> Create/Update Icon Blocks…  
(Опции -> Иерархия установки -> Создать/Обновить значки
блоков…)

Более подробную информацию по данному вопросу Вы можете получить
в разделе:  "Конфигурирование операторской станции – Работа в SIMATIC
Manager – Как создавать значки блоков".

3. Вновь переключитесь в режим "представление компонентов"
(component view), выберите в иерархической структуре объект
"color_gs_MP/ color_gs_Prj/ SIMATIC PC-Station(1)" и после этого
выберите опции меню:  
Options -> OS -> Compile… (Опции -> OS -> Компилировать…)

Внимание
Активируйте опции (элементы управления "check box"):
"Entire OS" (Станция OS в целом)  и  "With memory reset" ("Со сбросом
памяти").
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Более подробную информацию по данному вопросу Вы можете получить
в разделе:  "Конфигурирование операторской станции – Работа в SIMATIC
Manager – Как компилировать OS".

4. Откройте PCS 7 OS и измените имя компьютера:

- Выберите в окне навигации пункт "OS(1)/Computer"
("OS(1)/Компьютер").

- Выберите компьютер в правом окне и затем выберите опции
меню: 
View -> Properties  (Вид -> Свойства).

- Введите имя компьютера, на котором Вы будете открывать проект,
в поле ввода "Computer name" ("Имя компьютера"). Это имя
соответствует имени компьютера в сети. Вы можете найти это
имя, используя меню панели задач: 
Start -> Settings -> Control Panel -> System -> "Network
Identification" -> "Computer name"  (Пуск -> Установки -> Панель
управления -> Система -> "Идентификация сети" -> "Имя
компьютера".)

5. Активируйте "режим процесса" (Process mode).

Более подробную информацию по данному вопросу Вы можете получить
в разделе "Работа в 'режиме процесса' (Process Mode) – Как осуществлять
мониторинг и управление в 'режиме процесса' (Process Mode)".
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